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PREFACE
Thank you for purchasing the LT integrated development software, "LT Editor
Ver. 2.0”, hereafter referred to as the “LT Editor".

Please read this manual carefully in order to use this software properly, and be
sure to keep this manual handy for future reference.

NOTES
(1) The copyrights to all programs and manuals included in the LT Editor Ver.

2.0 Operation Manual - Screen Creation Guide (hereinafter referred to as
"this product") are reserved by the Digital Electronics Corporation. Digital
grants the use of this product to its users as described in the "Software
Operating License Conditions" documentation, included with this product's
CD-ROM. Any actions violating the above-mentioned conditions are
prohibited by both Japanese and foreign regulations.

(2) The contents of this manual have been thoroughly inspected. However, if
you should find any errors or omissions in this manual, please inform your
local LT Editor representative of your findings.

(3) Regardless of article (2), the Digital Electronics Corporation shall not be
held responsible for any damages or third party claims resulting from the
use of this product.

(4) Differences may occur between the descriptions found in this manual and
the actual functioning of this product. Therefore, the latest information on
this product is provided in data files (i.e. Readme.txt files, etc. ) and in
separate documents. Please consult these sources as well as this manual
prior to using the product.

(5) Even though the information contained in and displayed by this product may
be related to intangible or intellectual properties of the Digital Electronics
Corporation or third parties, the Digital Electronics Corporation shall not
warrant or grant the use of said properties to any users and/or other third
parties. Digital Electronics Corporation accepts no liability for issues related
to the intellectual property rights of third parties or any issues related to the
use of the information contained in or displayed by this product.

(6) The specifications set out in this manual are for overseas products only. As
a result, some differences may exist between the specifications given here
and for those of the identical Japanese product.

© Copyright 2002 Digital Electronics Corporation. All rights reserved.
Digital Electronics Corporation, November 2002

The LogiTouch is referred to as "LT" in this manual.

For the rights to trademarks and trade names, see “TRADEMARK RIGHTS”.
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The company names and product names used in this manual are the trade names,
trademarks (including registered trademarks), and service marks of their respective
companies.
This product omits individual descriptions of each of these rights.

The following terms used in this manual differ from the above mentioned formal trade
names and trademarks.

TRADEMARK RIGHTS

Trademark / Trade Name Right Holder
Microsoft, MS, MS-DOS, Windows, Windows 
95, Windows 98, Windows Me, Windows NT, 
Windows 2000, Windows XP, Windows 
Explorer, Microsoft Excel 95

Microsoft Corporation, USA

Intel, Pentium Intel Corporation, USA
Pro-face, Flex Network Digital Electronics Corporation 

(in Japan and other countries)
Ethernet Western Digital Electric Corporation, USA
IBM, VGA, PC/AT International Business Machines Corporation 

(IBM), USA

Terms Used in this Manual Formal Tradename or Trademark

 Windows 95 Microsoft® Windows95® Operating System
 Windows 98 Microsoft® Windows98® Operating System
 Windows Me Microsoft® WindowsMe® Operating System
 Windows NT Microsoft® WindowsNT ® Operating System
 Windows 2000 Microsoft® Windows2000® Operating System
Windows XP Microsoft® WindowsXP® Operating System
 MS-DOS Microsoft® MS-DOS® Operating System
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Symbol Description
Indicates a potentially hazardous situation that could result in serious injury or 
death.

Indicates a potentially hazardous situation that could result in minor injury or 
equipment damage.

Indicates a potentially damaging action or dangerous situation that could result in 
abnormal equipment operation or data loss.

Indicates instructions or procedures that must be performed to ensure correct 
product use.

Indicates instructions or procedures that must not be performed.

Sym bol De scription
Provides hints on c orrec t produc t use, or supplem entary inform ation.

Indic ates an item 's related inform ation (m anual nam e, c hapter,
sec tion, sub-sec tion).
Refers to keys on the c om puter keyboard.
                                 Keyb oard  Co m patib il ity L ist

Devic e Indic ates peripheral devic es suc h as tem perature c ontrollers,
inverters, etc . c onnec ted via serial I/O  It does not inc lude devic es
c onnec ted via the F lex Network or DIO .

LT G eneric  nam e for the "LT  Series" G raphic  Logic  Controller m ade by
Digita l Elec tronic s Corporation.

LT  Editor Indic ates  D igital Elec tronic s Corporation's LT  integrated
developm ent software "LT  Editor" Version 2.0 (this produc t).

MANUAL SYMBOLS AND TERMINOLOGY
This manual uses the following symbols and terminology.

Safety Symbols and Terms
This manual uses the following symbols and terms to identify important information
related to the correct and safe operation of this product.

General Information Symbols and Terms
This manual uses the following symbols and terms for general information.

Esc Ctrl
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Symbol
Type PS/2 Compatible

101 Keyboard

Esc

Tab

Ctrl

      Shift

Alt

Delete

Backspace

Keyboard Compatibility List
This manual uses the following symbols to indicate computer keyboard keys.
The key names used by your computer keyboard may differ. Please use the chart below
for reference.

LT SERIES

Esc

Tab

Ctrl

Shift

Alt

Delete

Back
space

The LT Editor supports the following LT models.

For the types of Device/PLCs supported by the LT Editor, please refer to
the "Device Connection Manual".

HOW TO USE THIS MANUAL

Series Type Product Model
Type A1 GLC150B-XY32SK GLC150-BG41-XY32SK-24V
Type A1 GLC150B-XY32SC GLC150-BG41-XY32SC-24V
Type B GLC150B-RSFL GLC150-BG41-FLEX-24V
Type B+ GLC150B-XY32KF GLC150-BG41-XY32KF-24V
Type C GLC150B-XY32SK GLC150-BG41-RSFL-24V

GLC150B-ADK GLC150-BG41-ADK-24V
GLC150B-ADPK GLC150-BG41-ADPK-24V
GLC150B-ADTK GLC150-BG41-ADTK-24V
GLC150B-ADC GLC150-BG41-ADC-24V
GLC150B-ADPC GLC150-BG41-ADPC-24V
GLC150B-ADTC GLC150-BG41-ADTC-24V

Type H1

Type H2

LT Series
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Structure of the Manual
The LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide is the first in
a series of manuals for this product and explains how to use the LT Editor. There are
three other manuals in the series as well as online help.

Refer to the Operation Manual – Screen Creation Guide, Chapter
1 – “LT Editor Fundamentals” and 1.6 – “LT Editor Manuals and
Help” for an overview of this product.

In addition to these manuals, data files containing supplemental information on updated
functions are also provided. To read these additional data files, click on the [Start]
button in your Windows OS main screen and select the [Programs] –> [Proface] ->
[LT] menu. Then, click on the [Read Me] selection.
For detailed information on LT series products, please refer to "LT Series User
Manual". (Optionally available)

HOW TO USE THIS MANUAL

Operation Manual
Screen Creation
Guide

Describes the operating procedures for the LT Editor
and all functions except for Logic Program
development (provided as a PDF file).
Describes logic program development. The manual
consists of three sections: "Installation,"
"Programming," and "Features." In the Installation
Section, you can learn the basic procedures to create a
logic program. The Programming Section explains
how to
operate the LT Editor through a tutorial lesson while the
Features Section explains the software settings
required for the combination of the LT  main unit and
the LT Editor. This manual is provided as a PDF file.

Parts List
Describes the LT  Editor's pre-made Parts and symbols
(provided as PDF data).

Device
Connection
Manual

Describes the methods for connecting the LT to
devices of various manufaturers (provided as a PDF
file).

Available in the
LT Editor screen Online Help

Describes the methods for setting the LT Editor's
windows and dialog boxes, instructions, and functions
of logic programs as well as how to set each driver.

Operation Manual
Logic
Programming
Guide (this
manual)

Included in CD-
ROM

• Address settings described in these manuals are for explanatory
purposes only. Appropriate addresses must be set according to
your requirements.

Refer to the Device Connection Manual.
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Chapter Breakdown
This manual consists of three sections: “Installation”, “Programming” and “Features”.
The following is a general description of each chapter.

[Setup Section]
The Setup Section uses an example application program to describe the basic steps
involved in creating a logic program with the LT Editor software. For detailed informa-
tion about LT Editor operating procedures, or variables/instructions, please refer to the
Programming or Features sections.

[Programming Section]
The Programming Section uses a tutorial to explain how to operate the Logic Program
Editor software. In this section you will create a complete ladder logic program.

CHAPTER 1: CREATING A PROGRAM
This chapter’s tutorial explains how to create a ladder logic program.

CHAPTER 2: RUNNING THE LADDER LOGIC PROGRAM
This chapter explains how to transfer a completed ladder logic program to the LT and
then run the program.

CHAPTER 3: ON-LINE EDITING
This chapter describes how to use On-Line mode to confirm the execution of the ladder
logic program.

CHAPTER 4: ERRORS AND WARNINGS
This chapter describes error messages that may be displayed when checking errors with
the Logic Program Editor.

CHAPTER 5: GLOSSARY OF TERMS
This chapter explains many of the terms used in the Logic Program Editor.

[Features Section]
The Features section describes how the LT unit operates, and provides a list of instruc-
tions and variables used in the ladder logic program.

CHAPTER 6: CONTROLLER FEATURES
This chapter describes the operation of the LT unit’s controller.

• If you have any questions about the contents of this manual,
please contact your local LT distributor. LT distributors will an-
swer to your technical inquiries and provide you with technical
consultation.

Refer to the Screen Creation Guide, Appendix 4 –
“Software Trouble Report.”

• If you have any question about your personal computer or
Microsoft® Windows®, please contact your PC distributor or manu-
facturer.
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CHAPTER 7: VARIABLES
This chapter provides definitions of the variables used in the ladder logic program and
how to use them.

CHAPTER 8: SYSTEM VARIABLES
This chapter lists variables that are predefined by the controller.

CHAPTER 9: INSTRUCTIONS
This chapter lists instructions that the Logic Program Editor supports.

CHAPTER 10: LS AREA REFRESH
This chapter describes how to use the LS area, which is used for control, as well as for
sharing data with display features and external devices.

CHAPTER 11: I/O DRIVERS
This chapter describes each I/O driver available. It also explains self-diagnostic and
troubleshooting procedures.

CHAPTER 12: ERROR MESSAGES
This chapter describes the error messages that may appear during LT Editor operation.

Online Help also provides detailed Logic Program Editor informa-
tion.

PRECAUTIONS
CD-ROM Usage Precautions
To prevent CD-ROM damage, please observe the following instructions:

• Do not turn your PC ON and OFF with the CD-ROM in the drive.

• Do not remove the CD-ROM from the CD-ROM drive while the drive’s operation lamp is
lit.

• Do not touch the CD-ROM recording surface.
• Do not place CD-ROMs in a place where they may be exposed to extremely high or low

temperatures, high humidity, or dust.

Product Usage Precautions
To prevent a program malfunction or accident, be sure to observe the following instructions:

Touch panel switches should NOT be used as a device’s
emergency stop switch. Generally speaking, all industrial
machinery/systems including robots must be equipped with
an emergency stop switch that only operates manually.
Also, for other machinery/systems, similar manual switches
must be provided to ensure safe operation.

STOP

!!!!!
Warning



14 LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Preface

• Do not turn off your personal computer’s power switch during the execution of a pro-
gram.

• Do not change the contents of this product’s project files using a text editor software.

Restrictions
The LT Editor has the following restrictions.

Drawing
• The LT Editor’s display screen uses your PC’s character fonts and graphic functions.

As a result, there may cause some differences in the  appearance between the LT
and PC after the screen is transferred to the LT.

• When an LT unit is vertically installed, the panel’s coordinates will differ from those
used on the screen editor software. Therefore, when you enter screen coordinates
using Parts or D-Script, be sure to consider the LT’s orientation.

Functions and Settings
• Certain  functions and settings supported by the LT unit are not supported by the LT

Editor, and vice versa.

[Settings and functions supported by the LT unit (Not by LT Editor) ]
• Language Font selection
• LT Date/Time settings
• LT Self-Diagnostics Function

[Functions and settings supported by the LT Editor (Not by LT unit)]
The following settings are included in the “LT System Settings” area:
• "Checksum Verification" settings
• Screen Change Order in hierarchical display mode
• Screen Change according to standby mode time
• Shift to OFFLINE mode settings
• Setting the frequency of Keypad Display processing performed per scan
• LT unit's internal memory (LS area) backup function settings
• "Error Display Reset" settings
• "Watch Dog Timer" settings
• Communication Monitoring Period settings (Designate transmission wait time)

(0, 0) on the screen editor software

(0. 0) on the LT series’ panel

STOP
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Logic Program Restrictions
• LT variables are handled in 32-bit device Low/High order.
• Parts used for display function cannot handle real numbers.
• Values different from the input values may appear during monitoring due to the

difference in the real number accuracy between a personal computer and the LT.
• If the LT's logic time (scan time) becomes too long, the sampling time designated for

the trend graph may not be accurately maintained.
• When using the Memory Link Method, a change in the value of a variables may not

be completely displayed by a trend graph.
• All LT Retentive Variable data is saved using a lithium battery in SRAM backup

memory. The battery can back up data for approximately 60 days in its initial condi-
tion (fully charged), and for approximately 6 days when the battery’s life is almost
finished. If you need to back up data for a longer period, you will need to either
back up data to your host computer, or configure your system so that data is backed
up by LT Editor.

• When a logic program and screen data use the same LS area, be sure to designate
all logic symbol LS variables (LS<*>).

For users of previous versions
Version 1.04 and previous version users are required to note the following:
• Do not download or monitor Version 1.04 or earlier version logic programs on an LT

that has been set up using LT Editor Version 2.0..



Setup
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This chapter provides step-by-step instructions for using the LT Editor software to
create LT application programs. For a detailed description of how to use the Logic
Program Editor and the Drawing Board, please refer to either “Programming” in this
manual, the Operation Manual’s “Screen Creation Guide” section, or Online Help.

Before Starting the Tutorial
The lessons in this chapter describe the procedures for developing application programs
with the LT Editor, and explains the basic functions and operations through this step-by-
step tutorial. Pro-face recommends that first-time LT Editor users go through all of the
tutorial prior to developing application programs.
This section describes the procedures for creating a sample application using the follow-
ing devices.
Also, the LT Editor software must be installed before starting logic programming.

Equipment List
M ain Unit LT  T ype A
I/O Unit Built-in T ype-A (Com bining 16-point input/16-point output)
Cable Sc reen transfer cable
Fan 24 VDC fan

Sensor 24 VDC proxim ity switch

SETUP GUIDE (Tutorial)

System Diagram

LT Type A

Output from terminal No. 3

Input to terminal No. 3

Fan

Sensor
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Explanation
• The fan rotates for five seconds after the LT screen’s switch is touched.
• The fan’s stop time can be changed using the keypad displayed on the LT screen.
• The fan will stop rotating if a signal is received from the sensor.

Developing an Application Program
The following steps are the usual “flow” for developing application programs with the LT
Editor software. This lesson will follow those steps. (It is assumed that LT Editor is
already installed.)

1. Start the LT Editor
Start up the LT Editor software.
Select the type of LT and external devices you will use.

2. Assign Variables to External I/O and Enable I/O
Use the Logic Program Editor’s I/O Configuration feature to assign variable names
(device addresses) to I/O terminal numbers.

3. Create Internal Variables
Create the variables used for internal relays, registers, timers, and counters.

4. Create the Logic Program
Use the Logic Program Editor software to create a logic program

5. Create LT Screens
Use the LT Editor software’s Screen Editor to create LT screens.

6. Transfer Screens and Logic Programs to LT Unit/Check Operation
Transfer the screens and logic programs to the LT unit. Check that the LT operates
correctly.

7. Start “RUN” Mode Operation

Example Application
This example will create the following screen and logic program.
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1. Start the LT Editor
1. Click the Windows® desktop’s [Start] button, and point to [Programs] –> [LT] –>

[Project Manager].

2. Click the [New] icon. When  the [New] dialog box appears, enter the following
settings.
• [Description] : New LT Program
• [Display Type] : LT Type A
• [PLC/Device Type] : None (Select only when using a Type-C unit.)

3. After all settings have been entered in the [New] dialog box, a second dialog box
will appear. In this tutorial, click the [Edit LogicProgram] button to start up the Logic
Program Editor and begin to create a logic program.
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2. Assign Variables to External I/O and Enable I/O
With conventional PLCs, each PLC vendor uses their own naming system to handle
External I/O addresses as I/O Device addresses. LT Editor, however, allocates arbitrary
names to I/O Device addresses. These are referred to as variables.
These variables can be used for internal relays and timers, depending on the parameters
that apply to the variable types and other settings used. The number of variables that can
be created will depend on the memory variable area’s size, and there are no special
usage restrictions for individual variables.

7.2 Variable Types
Use the Logic Program Editor’s I/O configuration feature to assign variable names to
external I/O.
1. Setting up External I/O.

In the Logic Program Editor’s [Controller] menu, select [Setup] and the [Setup]
dialog box will appear.
Click the [Tuning] tab, select the [Enable I/O] check box, then click [OK].

If  the [Enable I/O] check box is not selected, external input/output
will not be enabled, and only the LT’s internal logic program will
operate. (Can be used only for debugging.)

2. To assign variable names [Sensor] and [Fan] to external I/O, click the [Data] menu’s
[Configure I/O] button and the [Configure I/O] window will appear.
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3. I0 to I15 and Q0 to Q15 will appear below Module 0, which is under the DIO
driver. "I" represents input, and "Q" represents the output signal’s external I/O.
Double-click on "I3", type "Sensor" in the text entry box and press [ENTER].

4. When the following dialog box appears, click the [OK] button.
This will create a variable name for I3 and allocates that variable to the input terminal.

“Discrete” indicates a variable type that uses bit units for processing.
7.2 Variable Types

5. Next, use the same procedure to assign the name "Fan" to "Q3". Variable names
allocated here are used by the logic program and/or screen creation software to
access external devices.
Here, we will assign “sensor” to a Normally-Open contact or a Normally-Closed
contact instruction to receive input from the external input terminal. Similarly, output
to the external output terminal can be performed by assigning “fan” to an OUT
instruction.
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3. Create Internal Variables
Here, we will create named variables to be used for internal relays, registers, timers, and
counters.
1. Let’s create the variable “Run”, which will represent an internal relay.

First, in the Logic Program Editor’s [Data] menu, click [Variable Type] to call up the
[Variable Type] dialog box.

2. Enter “Run” in the “Name” field, and select “Discrete” from the left-side Variable
type menu, which processes data in bit units.
Select "Internal" to specify an internal variable, and click [OK].
This creates the “Run” variable.

When “%IX1.0.3” or similar characters appear in the I/O Configu-
ration window, they indicate an I/O address. Each letter or symbol
represents the following information:

I/O type

Module No.
Terminal No.

%IX1.0.3

Driver ID.
Data type
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4. Create the Logic Program
A logic program can be created by simply inserting instructions in a rung.
1. Click on [START] (Rung 1), and then click on the Tool Bar’s  icon. Be sure to

select [START] when creating the first rung.

2. Click the Tool Bar’s  icon to insert a Normally-Open contact in Rung 2. Next, on
the same rung, click  twice to create two (2) Normally-Closed contacts. Last,
click  to create a Coil.

3. From the Menu Bar’s [Data] menu, click [Variable List]. Select "Run" from the list of
variables that appear and, without releasing your mouse button, drag and drop "Run"
to the far left-side Normally-Open contact.

4. To create an automatic hold circuit, drag the "Run" circuit’s left-side connection line
to the right to create an OR circuit.



24 LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Setup Guide (Tutorial)

7. To insert a new rung below Rung 2, click on the left side to select Rung 2 and then
click on the  icon.

8. Next, click on the  icon to create a Normally-Open contact on Rung 3 (see
diagram).

5. Click on the lower branch of the OR circuit to select it, and click the  icon to insert
a Normally-open contact.

6. Next, we’ll assign previously configured I/O variables to the logic program.
First, click on "Sensor" and drag it to the left-most Normally-Closed contact. Repeat
the process with "Fan", and drag it to both the OP circuit’s Normally-Open contact,
and to the Coil.
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9. Click on the  icon and create an On-Delay timer (TON) instruction. Enter the
name "Run_Time_Timer" and press [Enter].

10. When the variable confirmation dialog box appears, click [OK] to create the
variable name “Run_Time_Timer”. The name (variable) assigned to the On-Delay
timer will be set to the “Timer” variable type. Use the same process to assign
variables to contacts and coils.

11. Double-click the "0" field that appears in the lower left corner of the On-Delay
timer to call up the [Data Value] dialog box.
Enter "5000" (milliseconds) in the "Change to" field to set the operating time to five
seconds, and click [OK].

12. Drag the variable name "Fan" from Rung 2 and drop it on Rung 3’s Normally-open
contact.
Next, drag Rung 3’s "Run_Time_Timer” to the second Normally-closed contact in
Rung 2 (as shown).
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14. Your logic program is now completed. Click on the Tool Bar’s  icon to save this
program.

This program’s variable information is imported to the Drawing Board
when the program is saved. Be sure to save your logic program be-
fore trying to create an LT screen.

13. After you drop "Run_Time_Timer" on Rung 2, a pop-up variable window will
appear. Double-click on the window’s  [Run_Time_Timer. Q] variable, which
designates the output bit used for "Run_Time_Timer”.

The variable "Run_Time_Timer. Q" is a dedicated variable, and is
created automatically when the Run Time Timer is created in step
10. This bit information (contact information) indicates that the time
set in the Run Time Timer is elapsed.

7.2 Variable Types   Timer and Counter
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5. Create LT Screens
In this step we will create an LT display screen. Do not quit the Logic Program Editor
when creating LT screens.
1. After saving your logic program, click on the Project Manager’s [Screen] icon to call

up the Drawing Board. Next, click on the Tool Bar’s  (New) icon to create a new
screen.

2. Select “Base Screen” as the screen type and click the [OK] button.

3. Click on the Logic Program Editor screen to activate it and drag "Run" (Rung 2
Normally-open contact) to the Drawing Board’s base screen.
Be sure to drag/select the entire command, not just the variable.

You must save your logic program before dragging and dropping an in-
struction.
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4. In the [Bit Switch Settings] dialog box’s [General Settings] tab, select "Momentary"
in the "Function" area. This function turns a bit (switch) ON only while the touch
panel switch is touched.
Next, click [Place] and position the bit switch on the base screen.
The switch’s label (text displayed on the switch) and shape can also be set.

5. Use the same procedure to drag the On-delay Timer (Rung 2) to the base screen.
The On-delay timer is treated as a Keypad Input Display when it is placed on a base
screen.
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6. When the [Keypad Input Display Settings] dialog box appears, click the [Place]
button to place it on the screen. The Keypad Input Display, when touched, displays
a keypad on the LT screen, allowing you to input numerical values.

7. Next, click the Tool Bar’s  icon to call up  the [Save As] dialog box. Enter "1" in the
“Screen” field and click the [OK] button.
Setting the screen number to "1" designates that the screen will be used as the initial
screen when the LT is started.
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6. Transfer Screens and Logic Programs to LT Unit/Check Operation
In this step, we will transfer the logic program and project screens we created to the LT
to confirm that they operate correctly.
Prior to transferring the data, be sure to save your project (.lte) file.
1. Quit the Logic Program Editor and close the Drawing Board.

Next, click on the Project Manager’s [Project] menu and select [Save As].
Enter a file name and click [Save].

2. Click the Project Manager’s [Transfer] icon and the following screen will appear.
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3. Click the Tool Bar’s   icon to call up the [Transfer Settings] dialog box. In the
"Send Information" field, select "Control Data” and click [OK].
Next, select the desired PC port in the [Communications Port] field, and click [OK].

4. Connect the data transfer cable to the LT, and click on the Tool Bar’s   icon (to
send both the screen and control data to the LT).

5. After all data reaches the LT the unit is reset, and the screen you created is dis-
played.
Check that the screen and the logic program operate correctly.
The logic program created in this exercise should operate as follows.
• The fan rotates when "Run" is touched, and stops after five seconds.
• Touching the LT’s Keypad Input Display displays a pop-up keypad on the

screen, which allows you to change the stop time setting.
• If the sensor is activated while the fan is rotating, the fan stops.

This completes the sample program creation.
For detailed information on Logic Program Editor and Drawing Board operation, please
refer to their corresponding manuals and Help data.
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1 Creating a Program
This chapter provides step-by-step instructions on using the Logic Program Editor
to create a logic program in Programming mode.
For details on starting the Logic Program Editor, please refer to “1.2 Start to
Finish” in the Operation Manual - Screen Creation Guide. For a detailed explana-
tion of each part of the Logic Program Editor, please refer to the Features section
and Online Help.

Before starting the tutorial
Each lesson in this chapter describes the operating procedures of the Logic Pro-
gram Editor using tutorial examples. These practice examples are called “tutorials.”
This section describes how to use the Logic Program Editor to create a logic
program that controls the operation of soft drink machines used in fast food
restaurants. The machine features the following functions:
• Pressing the button once will automatically load a large/medium/small cup and

dispense the required amount of soft drink.
• The ability to dispense ice or soda only if a cup is present under the dispenser.
• The ability to count the number of cups filled by the machine since it was

powered on.

Examples of Completed Logic Program and Screen
The logic program and project file used in this lesson can be found in the
“Soda.lte” file, in the “C:\Program Files\Pro-face\LT\SAMPLE” folder.
Refer to this file if you have problems with the procedure or wish to search for data
items, or simply want to study.

Logic Program Editor Online Help.

<Logic Program> <Screen>
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Soft Drink Machine

Allocating I/O Points
The “Ice_pushbutton,” “Large_pushbutton,” “Medium_pushbutton,” and
“Small_pushbutton” are placed on the LT screen for touch-panel input and are
therefore not allocated to a terminal.

Hardware Design

Light

Power ON button

Power OFF button

LT Type A unit

Cup Available For Ice
(sensor)

Power ON button, Lamp, etc.

LT Type A

Variable Name Terminal Type Terminal No.
Power_ON_pushbutton Input I0
Cup_Present_for_Ice Input I2
Power_OFF_pushbutton Input I6
Light Output Q0
Ice Output Q1
Soda_valve Output Q2
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Preference Area Settings (Prior to Creating a Logic Program)
Prior to creating a logic program using the Logic Program Editor, you can designate
the general settings used in order to customize your program creation/operation.

Designating Settings
1. Select [Preferences] from the [File] menu and the [Preferences] dialog box

will appear.

2. Click on each check box to select or deselect a setting. The followings page’s
data explains each tab setting.

Editor Tab
•  If selected, the [Instruction Pa-

rameter] box is automatically
opened for any new instructions
inserted in your program.

   (Default: selected)
 • If selected, the Logic Program Editor

opens all windows that were open at
the end of the last session. Settings
(such as window size and position)
for any windows open during your
editing session are retained. This also
applies to the [Data Watch] window
which retains its contents when the
current program runs online.

   (Default: selected)
•   If selected, new instructions are

appended to the right of the [focus].
Objects (including rungs, labels,
and subroutines) are appended
below the [focus]. If cleared, new
instructions are inserted to the left
of the [focus]. Objects are inserted
above the [focus]. If the [focus] is
on a [shunt], new instructions are
inserted on the [shunt].

   (Default: selected)

•  If selected, the ladder logic screen will
be cleared when going to Program-
ming Mode from Monitoring Mode.

   (Default: not selected)
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• If selected, the Logic Program Editor
accepts changes you make only when
you click [Apply]. If cleared, the Logic
Program Editor accepts changes im-
mediately but asks for confirmation.
(Default: not selected)

• If selected, the Logic Program Editor
asks for confirmation for all deletions
when you are creating your program.
(Default: selected)

• If selected, the Logic Program Editor
asks you to confirm the creation of ev-
ery new variable in your program. This
applies only to the Programming Mode
environment.
(Default: selected)

• If selected, the Logic Program Editor
asks you to confirm any change in the
Controller operation (i.e., Start/Stop,
Read/Write.)
(Default: selected)

•  If selected, the Logic Program Editor
asks you to confirm any undo action.
(Default: selected)

• [power flow] is displayed while the
Controller is in RUN mode.
The [power flow] highlights the display
of the live (energized) rung (a vertical
line used to describe instructions in
logic programs) while the Controller is
in RUN mode.
(Default: clear)

• The [state flow] is displayed while the
Controller is in the RUN mode.
The [state flow] highlights the display
of the live (energized) instruction while
the Controller is in the RUN mode. The
Power flow and State flow can be dis-
played at one time.
(Default: not selected)

• Specifies how often the Logic Program
Editor requests new data from the Con-
troller to update [power flow], [state
flow], data values, and the [status bar].
(Default: 500 ms.)

Monitoring Tab

Confirmation Tab
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FunctionTab
• If selected, retentive variable

values will be retained when
writing to the controller.

• When the #Screen feature has
been used to change a screen, after
the change is completed, the
#Screen value will be cleared to
“0”.
In the logic program or the PLC,
when a screen change is per-
formed via the number entered in
“#Screen” and “LS[8]” “LS0008”,
“PLC’s Allocated Screen Change
Number Device”, this feature
allows you to check if the screen
change has been completed or not.

Retain all retentive variables and download
(default: disabled)
When writing data to the controller, retentive variable values can be retained.
Checked (enabled)
All retentive variable values are retained. If the Confirmation tab’s [Confirm control-
ler operations] is not selected, no confirmation message dialog box will be displayed.
Not checked (disabled)
All retentive variable values are initialized (set to “0”) when data is written tothe controller.

Change Screen Check
(default: enabled)
This feature allows you to set whether the completion of a screen change is con-
firmed, when using the logic program or the PLC’s “#Screen” and “LS[8]”
“LS0008”, [PLC’s Allocated Screen Change Number Device] to change screens via a
set screen change number.
Checked (Enabled)
• When using Direct Access-

Zeroes (“0”) are written to “#Screen” and “LS[8]” “LS0008”, [PLC’s Allocated
Screen Change Number Device] after the screen change has been confirmed (via
comparing if the System Data Area’s currently displayed screen number is the
same as the designated screen change number.).

• When using Memory Link
A “0” is written after the screen change has been confirmed (via comparing if the
System Data Area’s currently displayed screen number is the same as the designated
screen change number.).

Not Checked (Disabled)
• When using Direct Access-

After the screen change has been confirmed, current screen change values are
retained in the “#Screen” and “LS[8]” “LS0008”, “PLC’s Allocated Screen
Change Number Device”.

• When using Memory Link
After the screen change has been confirmed, current screen change value is re-
tained in “#Screen”.
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•  If selected, the fields copied from
the variable list of the Logic Program
Editor to the clipboard are separated
by commas.
Ex .  My_var iab le ,  Disc re te ,
adescription
(Default: not selected)

• If selected, the fields copied from the
variable list of the Logic Program Edi-
tor to the clipboard are separated by
tabs.
Ex. My_variable[TAB]Discrete
[TAB] adescription
(Default: selected)

• If selected, the fields copied from the vari-
able list of the Logic Program Editor to
the clipboard are separated by a delim-
iter and enclosed in double quotes.
Ex. "My_variable", "Discrete",
"adescription"
(Default: selected)

In this tutorial, be sure to use the default settings. Click on [Cancel] to close the
[Preferences] dialog box and preserve the default settings.

Exercise Overview
1. Start the LT Editor.

 1.1  How to Start the LT Editor
2. Select the LT and external device you use in the [New] dialog box.

 1.1   How to Start the LT Editor
3. Develop a logic program.

1. Determine variables.
This section describes how to designate the functions of the logic program
to that is created by the Logic Program Editor as well as how to create and
delete variables and set the initial values.

 1.2  Creating and Variables
2. Create a logic program.

This section describes how to create rungs, insert instructions and branches, and
how to delete rungs, instructions and branches associated with the rungs.

 1.3  Inserting Rungs, Instructions and Branches
3. Assign variables to the logic program.

This section describes how to assign variables to the instructions in the logic program.
1.4  Assigning Variables to Instructions

Clipboard Tab



1–7LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 1 – Creating a Program

4. Insert descriptions.
This section describes how to label the logic program with descriptions. The
description instructions include procedures for documenting the entire program,
specific rungs, and individual instructions.

1.5  Documenting a Ladder Logic Program
5. Edit.

This section describes how to copy, cut and paste rungs.
1.6  Copying, Cutting and Pasting Rungs

6. Subroutine
This section describes how to insert subroutines and labels in the logic program.

1.7  Subroutines and Labels
7. Search.

This section describes how to search and go to the desired circuit quickly in the
logic program.

1.8  Navigating a Ladder Logic Program
8. Assign I/O.

This section describes how to assign the logical variables in the logic program to
the actual I/O terminals.

1.9  I/O Configuration
9. Error check.

This section describes how to check for errors in the logic program.
1.10   Checking the Validity of a Program

10. Print.
This section describes how to print out the logic program.

1.11  Printing Your Ladder Logic Program
11. Import and export.

This section describes how to "read" and "write" the logic program.
1.12  Importing/Exporting a Logic Program

4. Develop a screen program.
Use the Drawing Board and create a screen linked to the logic program.

1.13  Developing a Screen Program
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1.1 How to Start the LT Editor
Activate the Project Manager prior to creating a logic program with the Logic
Program Editor.
1. Click the [Start] button on the Window’s screen, and point to [Programs] —>

[LT] and then click [Project Manager].
2. The Project Manager starts up.

3. In the Project Manager screen, select [New] from the [Project] menu, or click
the  icon. Input the settings as follows, and press the [OK] button.
Description: Soft Drink Server
Display Type: TypeA
PLC/Device Type: None

4. A window appears asking whether you will create a Logic Program or Screen.
Click [Edit LogicProgram] to activate the Logic Program Editor.
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2. From the [Edit] menu, select [Add Variable], and the [Variable Type] dialog box
will appear.

3. Type “Cup_Present_for_Ice” in the Name field.
For details on variable name restrictions: Chapter 7 Variables

1.2 Creating Variables
This section describes how to designate the functions of the Logic Program Editor as
well as how to create and delete variables and set the initial values used on the Logic
Program Editor.
The completed sample of the tutorial program created in this lesson is located in the
"Soda.lte" file in the "C:\Program Files\Pro-face\LT\SAMPLE" folder.

Chapter 7  Variables

1.2.1 Creating a Variable List

You can add variables at any point while creating a ladder logic program. For conve-
nience, create a list of the variables you will use in the tutorial now.

Creating a List
Please refer to the online help for detailed descriptions of the menu items.
1. From the [Data] menu, select [Variable List]. The Variable List window is dis-

played.
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1.2.2 Selecting Variable Types

The variable “Cup_Present_for_Ice” is now displayed in the [Variable Type]
dialog box. The words “Not Assigned” are highlighted in the list below it. There
is no variable type assigned to “Cup_Present_for_Ice”. Therefore, it needs to be
assigned as a discrete input.

For the variable types: 7.2 Variable Types

 Assigning Variable Types
1. Select [Discrete] from the [Variable Type] list.
2. Select [Input].
3. Click on the [Retentive] box to deselect it. Data will not be retained if the

power supply is cut, or the LT unit is reset.
4. Click on [Create]. “Cup_Present_for_Ice” has now been assigned as a dis-

crete input.
Note that the variable type change that you made to “Cup_Present_for_Ice” in
the [Variable Type] dialog box has now taken effect in the [Variable List]
window and that the Variable Type dialog box is still open. If you had clicked on
[OK], the changes would still have occurred in the [Variable List] window, but
the [Variable Type] dialog box would have closed. The advantages of leaving
these dialog boxes open becomes apparent as you begin inserting rungs and
instructions as well as using LT Editor’s drag & drop, click, and insert features.

You can select the variable types you want to view in the [Variable
List] window by selecting [View], then selecting the variable types you
want displayed. A check mark appears beside the selected variable
types.

Now you have learned how to create a variable and assign a variable type to it,
create the list of variables shown in the following table. Variables can be created
directly in the [Variable Type] dialog box.

Variable Name Variable Type I/O Type Hold/Release Global
Power_On_pushbutton Discrete Input Release Local
Cup_Present_for_Ice Discrete Input Release Local
Ice_pushbutton Discrete Internal Release Global
Large_pushbutton Discrete Internal Release Global
Medium_pushbutton Discrete Internal Release Global
Small_pushbutton Discrete Internal Release Global
Power_Off_pushbutton Discrete Input Release Local
Ice Discrete Output Release Local
Soda_valve Discrete Output Release Local
Light Discrete Output Release Local
Fill_T imer T imer Internal Hold Local
Number_of_Larges Counter Internal Release Local
Number_of_Mediums Counter Internal Release Local
Number_of_Smalls Counter Internal Release Local
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Close the [Variable Type] dialog box when you have finished.

If you typed a variable name incorrectly, simply rename it using the
[Rename] option in the [Edit] menu’s [Variable List] window. To cre-
ate variables faster in the [Variable List] window, press the INSERT
key.

1.2.3 Saving Your Program

To ensure the safety of created data, it is recommended that you save your logic
program periodically. When a logic program is saved, global variables created with the
Logic Program Editor are automatically registered to the Symbol Editor as Logic
symbols, and can be used in common with the display function of the Drawing Board.

To Save the Program
Select [Save] from the [File] menu on the Logic Program Editor screen.

You can also save your program by clicking   on the toolbar or
by pressing the CTRL+S keys.
 Operation Manual, Screen Creation Guide 4.2.5 – “Symbol Edi-
tor.”

Summary
In this section you have learned how to:
• create variables and use dialog boxes associated with the variables
• determine variable types
• save a program
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1.3.1 Inserting a Rung

Create a new logic program.
Down the left side of each new program are three rungs labelled START, END and
PEND:
• The START rung indicates the start of the main program area.
• The END rung indicates the end of the main program area.
• The PEND rung indicates the end of the total program area. No rungs can be

inserted after the PEND rung.
The rungs between START and END are executed every scan. Any rungs inserted in
the area above START are for program initialization. This area is executed only during
the first scan after power-up.
The area between the END and PEND rung is reserved for subroutines.

Refer to the Programmer’s Reference in the Online Help for a de-
tailed explanation of the START, END, and PEND rungs.

To Insert a Rung
1. Click on the rung number 1 left of the word START. Rung 1 is selected.
2. Right click once. A shortcut menu appears.
3. Select [Insert Rung]. (Or select [Rung] from the [Insert] menu.) A new rung

appears at number 2, below the START rung.
4. Using the above method, insert four more rungs below the START rung. The screen

will be like the picture shown below.

1.3 Inserting Rungs, Instructions, and Branches
The first step in creating a ladder logic program is to insert a rung. The screen initially
shows a blank program as illustrated below. The completed sample of the tutorial
program used in this lesson is located in the "Soda.lte" file in the "C:\Program Files\Pro-
face\LT\SAMPLE" folder.
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3. Click on [OK].

As with other Windows applications, the LT Editor has an “Undo”
command. From the [Edit] menu, select [Undo Changes to XX], or
click on  in the toolbar.

You can also insert a rung by selecting [Rung] from the [Insert] menu,
or by clicking on    in the toolbar.

1.3.2 Deleting a Rung

 To delete a rung
1. Select the rung you want to delete. In this example click on the number “2” (the rung

number) on the left side of rung 2.
2. Press the DELETE key, or right-click on the rung and click on the [Delete Rung]

selection. The [Delete] dialog box will appear.
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Normally Open Contact (NO)

Normally Closed Contact (NC)

Coil (OUT)

Timer On Delay (TON)

Timer Off Delay (TOF)

Up Counter (CTU)

Down Counter (CTD)

1.3.3 Inserting Instructions

There are many ways to insert instructions into a ladder logic program and assign
variables to them. As you create the ladder logic program in the tutorial, these methods
are described and used.

For detailed information about instructions, see Chapter 7  Variables
or refer to the Online Help.

Selecting a rung to insert instructions
1. Here, you are inserting instructions on rung 2. Click on anywhere on the rung 2 line

to select it, but not on the number “2” itself. The selected rung will then be high-
lighted, as shown below.

2. Once you have selected this rung, you can insert instructions. One way to do that is
from the toolbar.
The Logic Program Editor toolbar contains the following buttons.

Click on these buttons to insert instructions into a selected rung. The meaning of
these buttons is as follows.
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Method 1:  Insert instructions from the toolbar
1. Click on the  button. The following box will appear.

The instruction now appears on the selected rung. Also, there is a box above it with a
flashing cursor inside. This is the “Instruction Parameter Box” and is where you enter
a variable to associate with the instruction. This will be explained in more detail later
in this chapter.

2. Click on the  button. This places an output coil on the right side of rung 2.
Though the “Instruction Parameter Box” is still flashing, please ignore it for now.

For Variable entry information, refer to 1.4 Assigning Variables
to Instructions.

3. Click on rung 2, between the NO and OUT instructions.
4. Click on the “Normally Closed” (NC) button , and that symbol will appear.

For a description of each toolbar button’s feature, place the cursor
over the button and read information that appears in the status bar.
Though the toolbar offers an easy way to insert frequently used in-
structions, it does not include all Logic Program Editor instructions
available within Logic Program Editor. You can also insert instruc-
tions from the [Insert Instruction] dialog box using the following
two methods.
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Method 2:  Insert instructions from the [Insert Instruction] dialog box
1. Right click anywhere on rung 3 and a shortcut menu will appear.
2. Select [Insert Instruction]. The [Insert Instruction] dialog box appears.

This dialog box contains all instructions available to create a ladder logic program
with the Logic Program Editor. As you type or click each instruction, a descriptor of
the instruction appears at the bottom of the dialog box.

You can also bring up the [Insert Instruction] dialog box by select-
ing [Instruction] from the [Insert] menu or by pressing INSERT
key after you have selected a rung.  To view detailed information on
each instruction, click the [Help] button while selecting the desired
instruction.

3. Select the on-delay timer here. Scroll through the instruction list in the [Insert Instruc-
tion] dialog box until you locate the Timer On Delay (TON).

4. Select “TON”.
As with the [Variable Type] dialog box, you have a choice of clicking on either
[OK] or [Apply] to register your selection. Since you are entering other instructions
in your ladder logic program in this tutorial, the [Insert Instruction] dialog box
needs to remain open. To do this, click on [Apply].

5. Click the left rung of the TON instruction.
6. Scroll through the instruction list in the [Insert Instruction] dialog box until you locate

the Normally-Open contact (NO).
7. Double-click on “NO” and that symbol will appear.

The instruction’s explanation
appears here
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 Method 3: Insert instructions by typing in the [Insert
Instruction]dialog box
1. Type “out” in the field above the instruction list.

The instruction list automatically scrolls until the “OUT” instruc-
tion appears at the top of the list. Also, its name appears in the
bottom left hand corner of the dialog box.

2. Click on the rung section to the right of the TON instruction.
3. Click on [Apply] and the TON box will appear.

3. Click on [OK].

You can also delete an instruction by selecting it and pressing the
DELETE key, or clicking on   in the toolbar.

1.3.4 Deleting Instructions

Here, you will delete the OUT instruction you just inserted into rung 3.

To delete an instruction
1. Right click on the rung 3’s OUT instruction and a shortcut menu will appear.
2. Select [Delete]. A dialog box will appear to confirm that the instruction is to be

deleted.
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1.3.5 Copying and Pasting Instructions

Here, you will copy the instruction inserted into a rung and paste this instruction into
another rung.
To copy an instruction
1. Click on the instruction you wish to copy.
2. Right-click and select [Copy Instruction], or select the [Editor] menu’s [Copy].

3. Now the copied instruction is pasted (inserted) into the desired rung.

To paste an instruction
1. Click on the place you wish to insert the copied instruction.
2. Right-click on the [Paste Instruction] or click on the [Edit] menu’s [Paste].
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To add an instruction to a branch
1. Select the branch by clicking on the bottom of it.

1.3.6 Inserting Branches

This section explains how you can insert a branch on rung 2 between the NO and the
NC instructions. This branch is designed for the self-holding feature of the light on the
soft drink server machine.

To insert a branch
1. Place the cursor at the point on the rung where you want the branch to begin. In this

case, directly to the left of the NO instruction.
2. Click and drag the mouse to the right. The cursor has turned into a   with a dotted

line attached to it.

Whenever the end point of the branch is in an incorrect location, the Editor changes
your cursor to a  . Also, whenever the end point of the branch is in a valid loca-
tion, the cursor returns to normal. If you release the cursor while it is normal, a
branch is inserted between the starting point and where you released the mouse. If
you release the mouse when the cursor is a , the branch will not be created.

3. Click and drag the mouse to the right until the cursor is between the NO and NC
instructions and is not a .

4. Release the mouse and a branch appears between the NO and NC instructions.
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2. The [Insert Instruction] dialog box should still be open. If it is not, open it using any
of the previously described methods

3. Select the NO instruction from the [Insert Instruction] dialog box and insert it using
any of the previously described methods. Rung 2 will appear like this:

To delete a branch containing instructions you must first select and
delete each instruction.

1.3.7 Initialization Logic

Logic inserted above the START rung is called Initialization Logic. The logic program
referred to in this section is executed only for the first scan when the Controller is
started.

To insert initialization logic
1. Right click on “ Program Description” field located above the START rung. If it is

not visible, select [Descriptions] from the [View] menu, and then select [Program].
2. Select [Insert Rung] from the shortcut menu, and a rung is inserted above the

START rung.

In the following examples the rungs have been moved down one
position (the rung which was previously number 2 is now rung 3).

3. Right click on the initialization rung (rung1).
4. Select [Insert Instruction] from the shortcut menu.
5. Select the SET instruction from the [Insert Instruction] window and click on [OK].

This rung is used to turn the soda machine’s ice maker ON. It remains ON while the
soda machine is started up and only needs to be set once.

If you do not have [Append New Rungs and Instructions] selected
in the [Preferences] dialog box, you must select the START rung to
insert any initialization rungs. These rungs will appear below the
program description.

You have now completed rungs 3 and 4 of the ladder logic program as well as one rung
of initialization logic. Please complete rungs 5-7, as shown on the following page.
Remember that the |P| instruction is a Positive Transition (PT) instruction.
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To insert multiple branches into rung 7:
1. Insert the first branch as previously described.
2. Insert the next branch by starting to click and drag from the same point as the previ-

ous branch.
3. Drag the cursor around the previous branch to the point on the rung where you want

the branch to be inserted.

Summary
In this section, you have learned how to:
• insert and delete rungs
• insert and delete instructions
• insert and delete branches

When the mouse is released, a new branch will be inserted over the previous branch,
when is then pushed down.
In the example below, instructions have been inserted on rungs 5-7.
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1.4 Assigning Variables to Instructions
This exercise shows how to assign variables to instructions.
In 1.2 Creating Variables you created a variable list which includes some of the variables
used in the tutorial ladder logic program. Please reopen the [Variable List] dialog box
now.

To open the Variable List dialog box
1. From the [Data] menu, select [Variable List].
2. Move this dialog box to the lower left corner of your screen. If the [Insert Instruc-

tion] dialog box is still open, close it by clicking on [Cancel].

1.4.1 Instruction Parameter Box

In the previous section, a field appeared with a flashing cursor inside it when you first
inserted an instruction on a rung. This is the Instruction Parameter Box and is where
you enter the variables you want associated with the instruction.

To access the Instruction Parameter Box of a basic level instruction:
1. Double-click on rung 3’s OUT instruction. A text field will open above the instruction

with a flashing cursor inside of it. This is the “Instruction Parameter Box”.

The “Instruction Parameter Box” can also be accessed by clicking
on the instruction and pressing the ENTER key or by right clicking
on the instruction and selecting [Edit Instruction] from the shortcut
menu.

General instructions (non-basic level instruction) have more than one “Instruction
Parameter Box”. For example, a TIMER ON DELAY (TON) instruction has two (2).
One is where you assign a variable, and the other is where you enter the preset time in
milliseconds.

To access the Instruction Parameter Boxes of general in-
structions
1. Click on rung 4’s TON instruction. The TON instruction then changes as follows:

Above the TON instruction a black highlighted area will appear. This is where you
enter the variable to be assigned to the TON instruction. Next to the Preset (PT)
element is another black highlighted area. This is where you enter the preset time in
milliseconds.

Enter the setting time

Enter the variable name
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4. Click on [OK]. In the [Variable List] dialog box the variable “Light” appears in the
list. The Logic Program Editor has automatically assigned it a variable type. In this
case it has assigned it as an internal discrete variable.

• The Logic Program Editor automatically assigns variable types
to any new instruction variables created. You can also type a vari-
able that already exists in your variable list directly into an In-
struction Parameter Box. The variable is assigned automatically
when you finished entering it.

• If you change the variables assigned to “Coil” instructions (i.e.
OUT, SET, RST, NEG) to “Retentive”,  the “Coil” instructions
also automatically change to “Retentive” type (i.e. M, SM, RM,
NM).

3. Next, double-click on the area immediately to the left of the PT element in the TON
instruction. The [Data Value] dialog box opens. Here, enter the preset time in
milliseconds that will elapse before output (Q) is turned ON. (Assigning variables
and other operands to instructions will be discussed in the next section.)

4. Close the [Data Value] dialog box.

1.4.2 Entering Variables

One method of entering a variable into an Instruction Parameter Box is to type directly
into the box.

To enter text in the Instruction Parameter Box
1. Double-click on the OUT instruction’s Instruction Parameter Box on rung 3.
2. Type “Light” in the box.
3. Press the ENTER key. The following dialog box appears asking you to confirm the

creation of the variable.

Enter a variable name here
(Instruction Parameter Box)
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Rung 3 should look like this:

Assign the variable “Ice_Maker” to the SET coil on the first initialization rung. This
variable can be created by typing it directly into the “Instruction Parameter Box”. After
it is typed, the initialization rung appears as follows:

Another method of assigning variables to instructions is to simply drag the variable from
the [Variable List] dialog box to the instruction itself. This method is very convenient if
there are many instructions which need to have the same variables assigned to them. The
advantages of using this method will be explained in Chapter 1.9 Assigning I/O.

To assign a variable using the Variable List dialog box
1. Call up the [Variable List] dialog box.
2. Click on “Light” in the [Variable List] dialog box but do not release the mouse

button.
3. With the mouse button still pressed, drag “Light” to the NO instruction located on the

branch on rung 3. As when inserting branches, note that your cursor initially becomes
a . When the cursor is in this state you cannot assign the variable to any instruc-
tion.
When you research the No instruction, your cursor will change to a  mark.

The variable is then assigned when the cursor is released. As long as the cursor
appears as a , you can assign the variable to an instruction.
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4. Click on and then drag the “Power_On_pushbutton” variable to the other NO
instruction on rung 3. Rung 3 should now appear as follows:

In general, variables which are expressions, constants are assigned
to instructions in exactly the same way as basic type variables, how-
ever, they must be typed in manually since there is no window to
drag them from.

1.4.3 Completing the Program

Since you have learned how to assign variables to instructions, you can now complete
the remaining rungs of the program. A diagram of the completed rungs is presented on
the following page.
Notice that the MOV instruction on rung 6 and the NC instruction on rung 7 contain the
variables “Fill_Timer.PT” and “Fill_Timer.Q” respectively. These variables refer to the
“PT” and “Q” elements of the Timer with the “Fill_timer” variable assigned to it.
The following three procedures are available for entering these variables. You can either:
• select the Instruction Parameter Box and type the “Fill_Timer” variable in directly.
• click on and drag the “Fill_Timer” variable from the [Variable List] dialog box and

add the “.PT” and “.Q” extensions in the Instruction Parameter Box.
• drag the Instruction Parameter Box to the instruction you want to copy, and enter a

variable selected from the special Variable List.
1. Select the source Instruction Parameter Box you want to copy from.
2. Drag the counter and timer variables to the destination instruction you ant to copy.
3. Select and double click on the desired parameter from the Variable List Box.
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These methods are used with rungs 6,7, and onwards. The application
instructions’ exclusive variables such as “Fill_Timer.PT” or ”Fill_Timer.Q”
consist of a variable name and a file extension:

***.CV (Current value)
***.PT (Set value)
***.Q (Output bit)
***.R (Reset bit)
7.2 Variable Types

3. Select and double click on the desired parameter from the Variable List Box.
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Summary
In this section, you have learned how to assign operands to instructions.

Sample of Tutorial Program
The following logic program was created from the tutorial lessons so far.
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1.5 Documenting a Ladder Logic Program
It is recommended that you document your ladder logic program. This data explains to
users exactly how the program and each of its elements perform and is useful when the
program needs to be altered or debugged later on. In the LT Editor, you can document
how the program performs, how each rung operates and what specific variables are
used for.

1.5.1 Adding a Program Description

The first description to add to your ladder logic program is an explanation of the
program’s features.

To Add a Program Description
1. Double-click on the “Program Description” field at the top of the screen, and the

[Description] dialog box will appear.

All LT Editor descriptions are entered here.

The word “Program”,  above the text field in the description dialog
box, indicates that the text field contains a description of the pro-
gram.

2. Click on the “Program Description” text.
3. Type “This program runs a typical fast food restaurant soft drink dispensing

machine”.
4. Click on [OK]. This description now appears at the very top of the ladder logic

program. (You may need to scroll up to see it.)

You can also add or edit a Program Description by double-clicking
the lower left-hand panel of the status bar.

Message Field

Text  Field
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To add descriptions to the remaining rungs of your program easily, keep the [Descrip-
tion] dialog box open.

To add a description to rung 3
1. Click anywhere on rung 3, outside of the Instruction Parameter Boxes. The

descriptor at the top of the [Description] dialog box now says Rung 3.
2. Click on the text field.
3. Type “The Light remains on until the Power_Off_Pushbutton is pressed”.
4. Click on [Apply]. In this tutorial only the comments for rungs 3 and 5 are explained.

1.5.2 Adding a Rung Description

Via the Logic Program Editor, you can add descriptions to each rung of your program.
In the following example, a description is added to rung 5.

To add a rung description
1. Right-click on rung 5’s left side number.
2. Select [Description] from the shortcut menu and the [Description] dialog box

opens. It is the same dialog box you opened previously, however, the descriptor
above the text field now says Rung 5 instead of Program.

You can also open the [Description] dialog box by selecting [De-
scription] from the [Edit] menu or by clicking on    in the toolbar.

Rung 5 controls the ice dispenser.
3. Click on the text field of the [Description] dialog box.
4. Type “Ice is dispensed for as long as the push-button is pressed, providing a

cup is present”.
5. Click on [Apply].
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1.5.3 Adding Descriptions to Variables

Descriptions can also be added to each of the variables in your ladder logic program.
You cannot however, add descriptions to labels or constants.

To add a description to a variable
1. The [Variable List] dialog box should be open. If it is not, open it now by selecting

[Variable List] from the [Data] menu.
2. The [Description] dialog box should also be open. If it is not, open it now by

selecting [Description] from the [Edit] menu.
3. Click on any Instruction Parameter Box containing the variable “Fill_Timer”. Note

that not only does the [Description] dialog box contain the descriptor “Fill_Timer”,
but that “Fill_Timer” is also highlighted in the [Variable List] dialog box.

4. Click on the text field of the [Description] dialog box.
5. Type “The Fill Timer decides how long to keep the soda valve open. The operating

time depends on the set value”.
6. Click on [Apply].

You can also add descriptions to a variable by selecting the variable
in the [Variable List] dialog box, instead of selecting it from the
ladder logic program.

To add a description
Here you will add a description to the variable “Power_On_pushbutton”.
1. Click on the variable “Power_On_pushbutton” in the [Variable List] dialog box.

The [Description] dialog box now contains the descriptor
“Power_On_pushbutton”.

2. Click on the text field of the [Description] dialog box.
3. Type “The Power On pushbutton starts the soft drink machine”.
4. Click on [Apply].
In this tutorial, descriptions are added to only the “Fill_Timer” and
“Power_On_Pushbutton” variables. Descriptions for other variables can be created by
simply repeating the procedure described here.
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1.5.4 Description List Dialog Box

The [Description List] dialog box displays brief, one line descriptions of all variables
and rungs in the program.

To bring up the Description List dialog box
•  From the [View] menu, select [Description List].

To view a detailed description from the Description List
dialog box
Double-click the “Fill_Timer” variable in the [Description List] dialog box. The
[Description] dialog box displays the detailed description of the “Fill_Timer” variable.
The [Variable List], [Description], and [Description List] dialog box displays
change to reflect the rungs and variables selected in the ladder logic program. However,
the opposite is not possible; for example, if a variable in the [Variable List] dialog box
or a description from [Description] or [Description List] dialog boxes is selected, the
corresponding choice is not reflected in the ladder logic. The search function of the
Logic Program Editor allows you to find the specific variables easily. This will be ex-
plained in more detail in “1.8 Navigating a Ladder Logic Program.”

Summary
You have learned how to add descriptions to the program, to rungs and to variables as
well as how to call up the [Description List] dialog box.
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1.6 Copying, Cutting and Pasting Rungs
When creating a ladder logic program, you may find you have to duplicate sequences of
instructions on several rungs. You can speed up your work by copying and pasting
completed rungs.

1.6.1 Copying a Rung

In the following exercise, two rungs are added between rungs 5 and 7. These additional
rungs contain the same instructions as rung 6 with different variables assigned to them.

To copy a rung
1. Click on the number “6”, shown on the left of the rung, to select entire Rung 6.
2. From the [Edit] menu, select [Copy].

If  you wish to select a range of rungs to be cut or copied, click on
the rung number of the first rung you wish to select. Hold the [SHIFT]
key down and select the rung number of the last rung you wish to
select. All rungs between the two are then selected and can be cut
or copied. Copying is limited to approximately 25 rungs.

1.6.2 Pasting a Rung

The Logic Program Editor pastes rung(s) below the current rung, as long as all the
current rung is not selected. If [Append new rungs and instructions] is not selected in
the [Preferences] dialog box, the copied rung is inserted above the current rung.
A rung cut and pasted is loaded to the LT Editor’s internal clipboard,
then copied to the program. If you select an entire rung when pasting
from the clipboard, the Logic Program Editor replaces the rung you have
selected with the rung in your clipboard.

To paste a rung
1. Click anywhere on rung 6.
2. From the [Edit] menu, select [Paste]. Rungs 6 and 7 are now identical.
3. Click anywhere on rung 6.
4. From the [Edit] menu, select [Paste]. Rungs 6 to 8 are now all alike.

When pasting a rung, all variables and descriptions associated with
that rung are also pasted. Be aware that you may have to edit the
pasted rung.

The variables on rungs 7 and 8 should now be changed, according
to the following example.
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5. Change the variable name of the PT instruction on the rung as shown in the example
above.

1.6.3 Cut Command

The Logic Program Editor’s Cut command allows you to take a rung or section of rungs
out of one part of your program and move them to another. In the following tutorial,
rung 4 is to be moved to the last rung of your program.

To use the “Cut” command
1. Click on rung 4. The entire Rung 4 is selected.
2. From the [Edit] menu, select [Cut]. The rung is now taken from the ladder logic

program and placed on the clipboard.
3. Click anywhere on rung 8.
4. From the [Edit] menu, select [Paste]. Rung 4 is now appended to below rung 8.

The end of the program now appears as follows:

To move an entire rung to another part of the program, first select
the rung and drag it using the middle of the rung to the new loca-
tion.

Summary
In this section, you have learned how to copy, cut, and paste rungs.
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1.7 Subroutines and Labels
When a [JSR] (jump to subroutine) or [JMP] (jump) instruction is inserted in a rung, it
tells the Controller to resume scanning starting at that subroutine or label. The main
difference between a subroutine and a label is that Editor executes a subroutine and then
returns to the point in the ladder logic directly after the [JSR] instruction. If Editor
jumps to a label (through the use of the [JMP] instruction), it continues executing the
ladder logic program at that point and does not return to the [JMP] instruction during
that scan.

 For more information on the [JMP] and [JSR] instructions, see the
9.2.41 JMP (jump)/ 9.2.42 JSR (jump to subroutine) .

1.7.1 Inserting a Subroutine

At the bottom of every LT Editor program are two rungs labelled “END” and “PEND”.
The “END” label signifies the end of the main program area. The Logic Program Editor
executes the instructions between “START” and “END” with every scan. The area
between the “END” label and the “PEND” (Program End) label is reserved for subrou-
tines.
In the following tutorial, a subroutine is added.

To insert a subroutine
1. Click on the [END] label.
2. From the [Insert] menu, select [Subroutine]. The [Insert Subroutine] dialog box

appears.

A maximum of 32 characters, numbers, or underscore characters, can be used for a
subroutine name. Variable names cannot begin with numerical characters and cannot
contain spaces.

1.2.1 Creating a Variable List
4. Click on [OK]. At the end of your program the subroutine will appear.
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Here, you insert your subroutine between the two new rungs labelled
“SUBSTARTReset_Counters” and “SUBENDReset_Counters”.

5. Right click on the “SUBSTARTReset_Counters” label.
6. Select [Insert Rung] from the shortcut menu to insert a rung between the

“SUBSTART” and “SUBEND” rungs.
7. Right click on the rung “SUBSTART” and “SUBEND”.
8. Insert an “OUT” instruction in the rung.
9. Insert 2 branches around the “OUT” instruction.
10. Insert an “OUT” instruction on each branch. The following is the completed subrou-

tine.
This routine will reset each of the Counters every time the LT is turned ON.

Each of the variables you see here should be assigned to each of the “OUT” instruc-
tions. Assign these variables now.
This completes the subroutine you can add more than one subroutine to a ladder logic
program by selecting either the “SUBSTART” or “PEND” rungs and repeating steps 2
through 6.
If you want a subroutine to be executed at some point in your ladder logic program you
must insert a [JSR] instruction. This is explained in the following tutorial.
This subroutine is executed as soon as the ‘Light’ OUTPUT COIL on rung 3 turns
ON. Therefore, the [JSR] instruction must be placed on rung 4.

To insert a [JSR] instruction:
1. Select rung 3.
2. From the [Insert] menu, select [Rung].
3. Insert a [PT] instruction on rung 4.
4. Assign the variable ‘Light’ to the [PT] instruction.
5. Insert a [JSR] instruction to the right of the [PT] instruction. This is done from the

[Insert Instruction] dialog box.
6. Type ‘Reset_Counters’, the name of the subroutine, in the [Instruction Param-

eter Box] of the [JSR] instruction. The rung appears as follows:
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Whenever the [JSR] instruction “Reset_Counters” receives power, it will jump to the
subroutine “Reset_Counters”. Execution will resume from rung 5 once the subroutine
has finished execution.

To delete a subroutine, you must first delete the individual rungs.
After that, delete the “SUB START” rung. The “SUB END” rung
will then be automatically deleted when the “SUB START” rung is
deleted.

1.7.2 Inserting Labels

A label, which is combined with a [JMP] (Jump) instruction, can be inserted in any part
of a ladder logic program. When the Controller executes a [JMP] instruction, it jumps
to the designated label and begins executing the program at that point.
Labels are inserted above or below the selected rung depending if [Append new rungs
and instructions] is selected in the [Preference] dialog box. This tutorial does not use
any labels. However, to insert one, the following procedure is used.

To assign a label to your ladder logic program:
1. Click anywhere on the rung.
2. From the [Insert] menu, select [Label]. The [Insert Label] dialog box appears

prompting you to insert a name for your label.

This is the name that is designated in the [JMP] instruction in your ladder logic program.
The same rules that apply to naming variables apply to naming labels.

To insert a [JMP] instruction
1. Right click on the right of the last instruction on the rung and select [Insert Instruc-

tion] from the shortcut menu.
2. Double click the [JMP] instruction in the [Insert Instruction] dialog box. The

[JMP] instruction is inserted as the last instruction on the rung. Whenever the Logic
Program Editor sees this instruction in your program, it jumps to the designated label.

Summary
This section explained how to create subroutines and labels and insert [JMP] (jump)
and [JSR] (jump to subroutine) instructions.
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1.8 Navigating a Ladder Logic Program
If a logic program is large, using the scroll bars to locate specific points in the program
can take quite a bit of time. The Logic Program Editor features commands to help you
find specific points in your program much more quickly. These are the [Find], [Refer-
ences], [Bookmark], [Go to Rung] and [Go to Label] commands.

1.8.1 The  [Find] Command

The [Find] command allows you to locate specific textual references in your ladder
logic.

To use the Find command:
1. If you have any windows open, close them before you use the [Find] command.
2. From the [Search] menu, select [Find]. The [Find Text] dialog box appears:

The [Find Text] dialog box can also be opened by clicking   in
the tool bar.

Specifying the type of matching to apply to the search
• You can specify the type of matching to apply to the search. If you were trying to find

the word ‘Fill’, the Logic Program Editor would find all instances of that word, even
if it found it as a lower case ‘fill’ or as part of another word such as ‘Fillet’.

• If you selected [Case sensitive], the Logic Program Editor would find ‘Fill’ but not
‘fill’. If you selected [Whole words only], the Logic Program Editor would find
‘Fill’ but not ‘Fillet’.

Specifying the scope and direction of the search
• You can specify the scope and direction of the search. If [Selection only] is se-

lected, the scope is limited to the highlighted portion of your program.
• Selecting [Global] includes the entire program. You can begin the search from the

top of the selected scope by selecting [Entire scope] or from a given position by
selecting [From cursor]. This tutorial starts the search from the beginning of the
program.
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3. Re-size and move the [References] dialog box to the lower right hand corner of
your screen.

4. Click on the rung 6’s “Fill_Timer.PT” variable and the [References] dialog box will
appear as follows:

3. Select the [START] label in your program.
4. Click the [Text to find] field of the [Field Text] dialog box.
5. Type ‘FILL’.
6. Select [Global], [Forward], and [From cursor].
7. Click on the [Find] button. The “focus” moves to the first match found, a part of the

‘Fill_Timer’ variable.
8. Click on the [Find] button again. The “focus” moves to the next match found. When

you have reached a point in your program where there are no more instances of the
items you are trying to locate, a beep sounds.

After the first [Find] operation. You can locate subsequent occur-
rences of  a text match by selecting [Find Next] from the [Search]
menu.

1.8.2 The [References] Command

The [References] command allows you to locate all occurrences of a specific variable
in your ladder logic program. It identifies the rung numbers and the instructions the
variable appears on.
For this tutorial, you will select the [START] label. However, the [References] com-
mand can be implemented from any point in your program.

To use the Reference command:
1. Click on the [START] label.
2. From the [Search] menu, select [References]. The [References] dialog box

appears:
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5. Select [Exact matches only].

In the [References] dialog box display:
• The number at the left of the line signifies the rung number the variable appears on.

This display tells you the ‘Fill_Timer’ variable appears on rung 6,7,8,9 and 10.
When [Exact matches only] is selected, the display shows that ‘Fill_Timer.PT’
occurs on rung 6,7 and 8.

• The next column on the line is the instruction type. This is the instruction that this
variable has been assigned to on this rung. This display tells you the ‘Fill_Timer’
variables has been referred by three (3) [MOV] instructions, one [NC] instruction
and a [TON] instruction.

• The last column on the line lists the parameter that has been assigned to this instruc-
tion, including the variable you initially referenced. In this display, you can see the
integers 4000, 6000 and 8000 assigned to the IN elements, and ‘Fill_Timer.PT’
assigned to OUT elements.

The [References] dialog box changes in accordance with your selection every time you
click on a variable in your ladder logic program. One advantage is when you click on
any of the lines in its display, the corresponding point in your ladder logic appears.

You must click on the parameter itself, not the instruction for the
corresponding information to be displayed in the [References] dia-
log box.
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3. Click on the variable ‘Fill_Timer’ in the [Variable List] dialog box.

The displays of the [Description List] and [References] dialog box
will change according to your selection. The [References] dialog
box now displays every instance of the variable ‘Fill_Timer’. Also,
note that even though you change a dialog box’s display, the ladder
logic program’s display does not change. The corresponding point
in your logic will appear when you select any variable line in the
[References] dialog box.

4. Click on the first line in the [References] dialog box. Your ladder logic program
now displays that variable highlighted on the rung and the instruction you specified.

1.8.3 [References] Dialog Box with Other Dialog Boxes

Using only the [Reference] dialog box when you do not know where at least one
instance of the desired variable is located is not the most convenient search method. You
can also use the [Find] command to locate it, however, there is an even quicker
method. You can use the [References] dialog box in conjunction with the [Variable
List] and/or the [Description List] dialog box.

To use the references dialog box with other dialog boxes.
1. Open the [Variable List], [Description list] and [References] dialog boxes.
2. Move and re-size them until your screen appears as follows:
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3. Type ‘Power Off’ in the [Bookmark name] field, then click on [ADD]. The
[Bookmark] has now been set. Thus, whenever you select ‘Power Off’ and click
on [Go To] to return to your [Bookmark], you will return to the [NC] instruction on
rung 3. If you wish to set a new [Bookmark], simply select a new point on the
ladder logic and repeat steps 1 through 3. The Logic Program Editor supports the
use of multiple [Bookmarks].

To go to a [Bookmark]
1. From the [Search] menu, select [Bookmarks]. The [Bookmarks] dialog box

appears.

1.8.4 Using Bookmarks

If you are constantly referring back to a specific point in your ladder logic program,
using a [Bookmark] saves you repeatedly scrolling the screen.
To set a [Bookmark], you must signify the exact point where you wish to return to.
Anything you can select or highlight can be a [Bookmark]. For this demonstration, the
[NORMALLY CLOSED CONTACT (NC)] instruction on rung 3 is set as a [Book-
mark].

To set a [Bookmark]
1. Click on the [NC] instruction on rung 3.
2. From the [Search] menu, select [Bookmark]. The [Bookmarks] dialog box

appears.

2. Select a [Bookmark Name] from the list, then click on [Go To]. Wherever you are
in your ladder logic program, the LT Editor automatically takes you back to where
you placed the [Bookmark].

You can use the [CTRL] + [M ] keys to open the [Bookmarks]
dialog box.
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2. Select the label to go to.
3. Click on [OK]. You are now positioned at the specified label.

Summary
This section has explained how to use [Find], [References], [Bookmark], [Go To
Rung] and [Go To Label] commands.

To change the position of a [Bookmark]
1. Select the new position in the ladder logic program.
2. Select the [Bookmark name] you wish to reposition.
3. Click on [Update] in the [Bookmarks] dialog box.

1.8.5 Using the [Go To Rung] Command

The [Go To Rung] command allows you to move the “focus” to a specified rung in
your ladder logic program.

To use the [Go to Rung] command
1. From the [Search] menu, select [Go To Rung] and the following dialog box will

appear:

2. Enter a [Rung Number].
3. Click on [OK]. You are now positioned at the specified rung.

1.8.6 Using the [Go To Label] Command

The [Go to Label] command allows you to jump to a specific “label” in your ladder
logic program.

To use the [Go to Label] command:
1. From the [Search] menu, select [Go TO Label]. The [Go To Label] dialog box

appears:
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1.9 I/O Configuration
Once you have finished constructing a ladder logic program, you must assign I/O to
selected variables. In this tutorial, variables were created first and I/O assigned after the
ladder logic program was completed. This was done in order to present the various
features of the LT Editor in a logical order. If you know what your I/O will be before
beginning programing, you can specify your I/O first and then assign it to your variables
as you create your program. Both methods are demonstrated in this section.

1.9.1 Assigning Variables to I/O

Once you have created variables in a ladder logic program, there are a number of
methods you can use to assign them to your I/O.
The "Ice_pushbutton", "Large_pushbutton", "Medium_pushbutton", and
"Small_pushbutton" will be placed on the LT screen for touch-panel inputs. These
buttons are not assigned to the terminals.

Due to the differences of the I/O drivers, the procedures for “Opening the [Configure
I/O] window” and “Setting up the driver” on the LT Type A differ from the procedures
used for LT Type B, LT Type B+, and LT Type C.

When using a Type A unit, please refer to “To set up the DIO driver”.

When using Type B, Type B+, and Type C units, please refer to “To
set up the Flex Network driver”.
When using an LT Type H unit, please refer to the LT Type H driver
manual (sold separately).

The explanations in the tutorial lessons so far used the LT Type A as the model environ-
ment. However, the “To set up the Flex Network driver” section uses the LT Type B+
as the model environment.

Variable Name Terminal Type Terminal No.
Power_ON_pushbutton Input I0
Cup_Present_for_Ice Input I2
Power_OFF_pushbutton Input I6
Light Output Q0
Ice Output Q1
Soda_valve Output Q2



1–44 LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 1 – Creating a Program

To open the [Configure I/O] window:
From the [Data] menu, choose [Configure I/O] and the following window will appear.

For the DIO driver

For the Flex Network driver

You can also open the [Configure I/O] dialog box by clicking on

   on the tool bar or by clicking on   in the [Variable
Type] dialog box.
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To set up the DIO driver:
1. Select ‘Module 0’.
2. Click on [Setup]. The [Module Setup] dialog box appears:

Displayed underneath Module 0 are 16 input terminals and one output terminal (for a
16-bit word) associated with the DIO module displayed. You will assign variables to
them later in this tutorial.
5. Click on  next to Module 0. The terminals are hidden and  appears in place

of   .

* Only "0" can be designated for a Module number.

3. “16 Discrete (bit)” is factory set for both Input/Output terminals.
4. Click on [OK]. The [Configure I/O] window appears as follows:
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To set up the Flex Network driver:
When assigning the B+ unit’s built-in I/O, setup the following driver first. (The DIO built
into the LT Type-B+ is treated as a single Flex Network station.)
Model Code: FN-XY16SK
S-No.: Select a number that will not overlap with other connected devices.

In this lesson, select “1”.
1. Select "S-No. 1 (FN-XY16SK)" in the Configure I/O window, then click [Setup].

The [I/O Unit Setup] dialog box appears.

2. Change "FN-X16TS” to “FN-XY16SK" in the “Model Code” field.
3. Click on [OK]. The [Configure I/O] window appears as follows:

Displayed underneath ‘S-No.1 (FN-XY16SK)’ are 16 input terminals and one output
terminal (for a 16-bit word) associated with the Flex Network module displayed. You
will assign variables to them later in this tutorial.

5. Click on  next to ‘S-No.1 (FN-XY16SK)’. The terminals are hidden and 
appears in place of   .

6. Up to 63 units (when 2 lines are used) can be connected with the Flex Network
driver. Use the same method for selecting a module for another unit.
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To click and drag variables to the I/O terminals:
1. Click on  next to ‘Module 0’. The [Configure I/O] window appears as follows:

You can use the first 16 terminals for input with Module 0 .

2. Locate the variable ‘Power_On_pushbutton’ on the NO instruction of rung 3.
3. Click and drag ‘Power_On_pushbutton’ toward terminal I0. As well as when

inserting branches, note that your cursor initially becomes a  . When the cursor is
in this state you cannot assign the variable to any I/O terminal.

4. Drag the cursor over terminal 0 and release the mouse. The variable
‘Power_On_pushbutton’ is now assigned to terminal I0.
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When you assign (click and drag) a variable to [Configure I/O] from the
[Variable List] or [Description List] window, that I/O attribute is enabled
and any other variable attribute will be changed to Input/Output.

The variable ‘Power_On_pushbutton’ on the NO instruction of rung 3 now has a series
of digits and letters above it. This is the IEC I/O address of that variable.

For more information about the IEC addressing format of your I/O
driver, refer to your driver’s Help system.

To click and drag variables to I/O terminals from the [Vari-
able List] dialog box:
1. Open the [Variable List] dialog box. The [Configure I/O] window should still be

open.
2. Arrange the dialog boxes so that both can be viewed.
3. From the [Variable List] dialog box, click and drag the variable

‘Cup_Present_for_Ice’ to terminal I2 in the [Configure I/O] window.
4. Release the mouse. The variable ‘Cup_Present_for_Ice’ is now assigned to input

terminal I2.

You can also use the above procedure to assign variables to I/O
from the [Description List] dialog box.
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To assign variables via text input:
1. Click on terminal I6.
2. Press the [Enter] key. The terminal test field is activated.

3. Type ‘Power-Off-pushbutton’.
4. Press the [Enter] key. ‘Power-Off-pushbutton’ is now assigned to input terminal I6.

When variables are assigned to I/O via text entry, the variables will
be automatically listed in the [Variable List] dialog box.
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1.9.2 Unassigning Variables from the [Configure I/O] Dialog Box

To unassign a variable from the [Configure I/O] window:
1. Click on terminal I0 in the [Configure I/O] window.
2. Click on [Unmap]. The ‘Power_On_pushbutton’ is now unassigned from terminal I0

and can be assigned to any other terminal you select. In this tutorial, assign it back to
terminal I0.

Assigning variables to output terminals is the same as assigning them to input terminals.
Use the above procedures to assign variables from the following table to the input and
output terminals.

The input and output modules are displayed in the [Configure I/O] dialog box as shown
here:

Variable Name Terminal Type Terminal #
Light Output Q0
Ice Output Q1
Soda_valve Output Q2
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1.9.3 Assigning I/O to Variables

The easiest way to configure I/O for new programs is to type the variables directly into
the terminals. They are then automatically created, configured and mapped to the
correct I/O point. In this case, when you configure your I/O first and then construct your
ladder logic program, creating your I/O points is explained.

To use variables assigned to I/O with Instructions:
1. Click the target variable and drag to the I/O terminals as described above to assign

variables to the input and output terminals of your driver.
2. Construct your ladder logic program.
3. Click and drag the variables from the [Configure I/O] dialog box to the instructions

you want I/O assigned to.

1.9.4 Converting I/O Configuration Data

The variables assigned to the I/O of the LT Type A are automatically converted to the
Flex Network. The variables can be converted to an FN-X32TS 32-point I/O unit,
FN-XY16SK, FN-XY16SC, or the I/O (FN-XY16SK) that are built in the Type B+
unit.
This section describes the steps used to convert LT Type A I/O to LT Type B+ I/O
(FN-XY16SK).

1. Click the [Export] button on the [Configure I/O] window. Save the variables
assigned to the I/O of the LT Type A in a CSV format file.
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Summary
This section explained how to:
• select an I/O driver,
• configure the Flex Network driver,
• use variables assigned to I/O.

4. The variables are imported from the CSV file and assigned to the LT Type B+ unit’s
I/O (FN-XY16SK).

2. In the [New/LT Type] in the Project Manager, change the model type from “Type
A” to “Type B+”.

 1.1 How to Start the LT Editor
3. Open the [Configure I/O] window via the Logic Program Editor.

Select [S-No.1 (FN-XY16SK)] and then click the [Import] button. Select the
previously saved CSV file and click on [Open].
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1.10 Checking the Validity of a Program
Before running a ladder logic program online, use a validity check to make sure the
program is free of errors.

To run a validity check
From the [File] menu, select [Check Validity] and the following dialog box will
appear.

The [Validity] dialog box lists all errors and possible trouble spots the Logic Program
Editor can detect in your program. Trouble spots are listed as “warnings”.
In the lower right hand corner of the dialog box is a check box marked [Errors only].
If this box is selected, only the “errors” that the Logic Program Editor detects in your
program are displayed; the “warnings” are not. The Logic Program Editor can run a
program that contains “warnings” in the Controller, however, it cannot run a program
that contains errors. These errors must be corrected first.

A validity check can also be performed by clicking on    in the
tool bar.

The [Validity] dialog box displays “errors” and “warnings” in the order they appear in
your ladder logic program. In other words, the “errors” in rung 1 are presented first,
then rung 2 and so on.
If you double-click on the “errors” or “warnings” in the [Validity] dialog box you can
go directly to the problem.
• If it is a logic problem, that part of your program is displayed.
• If it is a problem with assigning I/O, the [Configure I/O] dialog box is displayed.
As previously mentioned, there can be a variety of “error” types displayed in the [Valid-
ity] dialog box. Your validity check will show the following error.
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To fix an error
1. Double-click on the “error” line in the [Validity] dialog box. The [Instruction

Parameter Box] of the instruction on rung 9 is highlighted, indicating there is no
variable assigned to it.

2. Enter “Soda_valve” as the instruction variable.
For more information on specific errors and warnings, refer to the
Editor Help system or “Chapter 4 Errors and Warnings” in this
manual.

When you have corrected the “errors” listed in the [Validity] dialog box, run a validity
check again. Any errors that exist are displayed. If they have all been corrected your
program can be written to the Controller.

Summary
In this section you have learned how to check the validity of an Editor ladder logic
program. The preparation for transferring a program to the LT for execution is com-
plete. The details of the procedures hereafter are explained in 2.1 Configuring the LT
Controller.
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1.11  Printing Your Ladder Logic Program
With the Logic Program Editor, you can print different aspects of your ladder logic
program.

To print a ladder logic program
From the [File] menu, select [Print] and the following dialog box is displayed. You can
view the logic program on the screen before it is printed using the Preview function.

Select [All] to print all the rungs of the program or, click on [Selected] and type in the
range of rungs you wish to print.
Use the [View] menu to adjust the logic program’s printout size.

You can select the number of columns (1 to 4) into which your report will be formatted.
Under the [Reports] section there are four check boxes labelled [Logic], [Variable
List], [I/O Configuration] and [References]. These check boxes provide the follow-
ing options when printing your ladder logic program:

 [Logic]:
This option allows you to print the rungs of your ladder logic program. If you click on
[Options] next to it, the following dialog box appears:
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[Variable List]
This option allows you to print a variable list. Click on [Options] to select the items you
wish to include in that variable list.

[I/O Configuration]
This option allows you to print your I/O configuration.

[References]
This option allows you to print a cross reference report showing all instances of all
variables.

You can also print your program by clicking on   in the tool bar.

Summary
This section explained how to select which aspects of your ladder logic program you
wish to print.

Option Description
Type Displays the variable type.
I/O Address Displays the I/O addresses of all assigned variables.
Value Displays the data value of all variables.
Attribute Displays the Retentive and Global settings
Descriptions Displays any descriptions given to the variables.
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1.12 Importing/Exporting a Logic Program
The Logic Program Editor allows you to export a logic program exclusively for use with
the LT.
Conversely, a logic program file can be imported for use as a project file for another LT.
You can import and export all logic programs created in the project. You can also
export part of a logic program using [Export | Part], and import part of a logic program
using [Import | Insert].

1.12.1 Export

The following three types of logic programs can be exported.
• All logic programs including subroutines (*.wll)
• A selected part of a logic program (*.wlp)
• Subroutine in a logic program (*.wlf)

To Export a Logic Program
Procedures for exporting the above three types of logic programs are explained as
follows.

♦♦♦♦♦ To Export All Logic Programs including Subroutines
1. Select the [Export | All] command from the [File] menu.

2. Enter a file name in the [Save As] dialog box.
3. Click [Save].

The Logic Program is saved in .WLL format.
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♦♦♦♦♦ To Export Selected Part of a Logic Program
1. Select the [Export | Part] command from the [File] menu.

2. Select the rungs to be exported and click [OK].

2. Enter a file name in the [Save As] dialog box.
3. Click [Save].

The Logic Program is saved in .WLF format.

3. Enter a file name in the [Save As] dialog box.
4. Click [Save].

The Logic Program is saved in .WLP format.

♦♦♦♦♦ To Export Subroutine in a Logic Program
1. Select the [Export | Subroutine] command from the [File] menu. When [Subrou-

tine] is selected, a list of subroutines created in the logic program is displayed. Select
the subroutine to be exported from the list.
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2. Select the .WLL file you want to import in the [Open] dialog box.
3. Click [Open].

The specified logic program is imported, and the variables used in the logic program
are registered to the Variable List.

4. Saving the logic program will register a global variable in the Symbol Editor as a logic
symbol.

Operation Manual – Screen Creation Guide, 4.2.5 – “Symbol
Editor.”

1.12.2 Import

The following three import commands can be used to import logic programs.
• [Update] command – imports all logic programs including subroutines
• [Insert] command – imports a selected part of a logic program
• [Subroutine] command – imports a subroutine part
Please note that when importing all logic programs, including subroutines, the logic
program is updated to a logic program in the current project.
The location where imported rungs are inserted can be set up with the [File | Prefer-
ences | Editor] command.

Please see the “Preference Area Settings (Prior to Creating a Logic
Program)” section at the beginning of Chapter 1.

To Import a Logic Program
Procedures for importing logic programs using the above three methods are explained
as follows.

♦♦♦♦♦ To Import All Logic Programs including Subroutines
1. Select the [Import | Update] command from the [File] menu.
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♦♦♦♦♦ To Import Selected Part of a Logic Program
1. Select the [Import | Insert] command from the [File] menu.

3. Select the .WLP file you want to import in the [Open] dialog box.
3. Click [Open].

The specified logic program is imported, and the variables used in the logic program
are registered to the Variable List.

4. Saving the logic program will register a global variable in the Symbol Editor as a logic
symbol.

Operation Manual – Screen Creation Guide, 4.2.5 – “Symbol
Editor.”

When the imported logic program contains variables with the same name
as variables in the current logic program, the imported logic program’s
variable types are changed to match those of the current logic program.

Summary
In this section, you have learned how to import and export a logic program.

2. Specify a location (rung number) to insert the logic program.
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♦♦♦♦♦ To Import Subroutines of a Logic Program
1. Select the [Import | Subroutine] command from the [File] menu.

2. Select the .WLF file you want to import in the [Open] dialog box.
3. Click [Open].

The specified logic program is imported, and the variables used in the logic program
are registered to the Variable List.

4. Saving the logic program will register a global variable in the Symbol Editor as a logic
symbol.

Operation Manual – Screen Creation Guide, 4.2.5 – “Symbol
Editor.”

When the existing logic program contains variables with the same name
as variables in the current logic program, the imported logic program’s
variable types are changed to match those of the current logic program.
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To Start the Drawing Board
1. In the Project Manager window, click [Draw | Screen] to activate the Drawing

Board (Screen Editor).
2. Click [Screen | New] on the Menu Bar. Check that "Base Screen" is selected, and

click the [OK] button.

To Draw using Drag and Drop Operations
1. Select “Ice-pushbutton” in the Logic Program, and drag it to the Drawing Board

(Screen Editor).

1.13 Developing a Screen Program
Create “Ice_Pushbutton,” “Large_Pushbutton,” “Medium_Pushbutton,” and
“Small_Pushbutton” with the Drawing Board (Screen Editor). The illustration below is
the completed sample screen.
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2. The [Bit Switch Settings] dialog box appears on the screen. Select "Momentary"
from the [Function] field. Check that the [Operation Bit Address] is set to [Add
Ice], and then click the [Place] button to place the pushbutton.

3. “Add Ice” is completed. Create “Large_pushbutton,” “Medium_pushbutton,” and
“Small_pushbutton” using the same procedure.
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Memo
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2 Running the Ladder Logic Program
Once you have developed a ladder logic program that is free of errors, it can be run by
the LT Controller.
This chapter explains how to configure the LT Controller, send (write) a program to it
and run the program online.

2.1 Configuring the LT Controller
Before writing a ladder logic program to a LT Controller, please be sure that the con-
troller is configured properly. When running a program on the LT, there are two settings
in the Controller Setup: “Tuning” and “Memory”.

To Configure the Controller:
From the [Controller] menu, select [Setup], which calls up the following screen.

When you set parameters on the [Tuning] tab, you are setting the parameters the ladder
logic program uses when it is written to the LT Controller. From this point onward,
whenever this particular program is run, the LT Controller uses these settings, unless
they are changed. These settings are unique to this program.
Controller [Tuning] options are explained below.
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Option Description
In [Target Scan T ime] (System Variable: "#TargetScan"), enter the
amount of time in milliseconds you would like each scan of your
program to take.
(Note): If the logic time exceeds the 50% of the scan time, the  "Scan"
operation is not guaranteed. Specify the setting in 10-ms increments.

Percent Allocation
In [Percent allocation] (System Variable: "#PercentAlloc"), enter a value
in % to designate the scan time by the percentage of the whole dealing
time. The 1-ms place of the calculated scan time is round up.

Watchdog T imer
When a logic program alarm occurs that delays the scan so that the
value entered here is exceeded, a Major Fault alert occurs.
Only when the LT OFFLINE mode's "MODE WHEN POWER IS ON"
selection is set to [DEFAULT] is this feature enabled.*1 When the
controller is restarted after being stopped, this feature will automatically
prevent the Logic Program from restarting. The system variable
#DisableAutoStart can also be used for this setting.
                                 8.2.20 #DisableautoStart

Stop on Minor Fault
This setting designates if the logic program is stopped when a minor
controller fault occurs. The system variable #FaultOnMinor can also
be used for this setting.                                   8.2.22 #FaultOnMinor
This function enables the inputs/outputs to the LT  main unit and
external I/O of the I/O unit. In normal operation, the input/output of the
external I/O is disabled when the LT is set to RUN mode after
performing a Logic Program download.
For safety reasons, this function prevents the possibility of accidental
startups of machines caused by errors in operation and logic
programs.

Enable I/O

Disable Controller Auto
Start

Target Scan T ime

• For details on Target Scan Time and Percent Allocation, refer to
Chapter 6: Controller Features.

• For details on the system variables, refer to Chapter 8: System
Variables.

• The "Enable I/O" feature can be selected when starting and stop-
ping the controller. For details, refer to 2.2 Starting and Stopping
the Controller.

1. To set up the “MODE WHEN POWER IS ON”, select [PLC Setup] - [Controller]
- [Setup]. If [Start/Stop] is selected in the [Controller] menu, the settings of the
LT Editor are ignored while the off-line settings are prioritized.
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Memory
The [Memory] tab shows the percentages of  [Estimate of controller memory
required] and [Estimate of variable memory required] with bar graphs.

[Store entire program in controller]
Transmits the entire ladder logic program,  including comments. Comments for the
ladder logic program can be read when reading is done from the LT.

[Remove descriptions before writing (to save memory)]
Reduces the size of the file you are downloading to the LT, therefore, when the file is
uploaded from the LT, there will not be any description data.

[Estimate of controller memory required]
Shows the memory of the current program as a percentage of the LT’s usable memory.

[Estimate of variable memory required]
Shows the total memory of all variables currently registered as a percentage of the LT’s
usable memory.

[Estimate of rung memory required]
Shows the total memory of currently used instructions and rungs as a percentage of the
LT’s usable memory.
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2.1.1 Writing to the Controller

After you have completed creating a ladder logic program with the Logic Program
Editor and it is free of errors, you can write it to the LT and run it online.
To write a logic program to an LT, you can either;
• transfer the screen data and logic program via the "Transfer" window of the LT

Editor.
• transfer the logic program exclusively via the "Transfer" window of the LT Editor.
Make sure to set up your LT before writing the logic program. To set up an LT, transfer
the system along with a Project File via the "Transfer" window of the LT Editor. For
details on transferring data, refer to Operation Manual - Screen Creation Guide Chap-
ter 7: Transferring Data.
This section describes how to transfer only a logic program using the LT Editor.

To Write to the Controller:
1. From the [Controller] menu, select [Write to Controller] and the following dialog box

appears, prompting you for your OK before writing to the Controller. Before a program
is written to the Controller, the LT Editor automatically runs a validity check. A program
containing errors cannot be written to the Controller.
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2. Click on [OK]. The [Download Progress] dialog box appears and displays the
status of the download of data to the LT.

• The Flex Network driver software etc. will be downloaded (if
needed) when you write your LTE file to the controller. If no
changes in the driver have occurred since the last download, the
download of the driver is skipped.

• The size of the downloaded file can be reduced by removing de-
scriptions before transferring.

 2.1 Configuring the LT Controller

The LT resets itself after the logic program write is completed.

2.1.2 Going to Monitoring Mode

To Go to Monitoring Mode:
1. From the [Controller] menu, select [Monitoring Mode]. A dialog box then ap-

pears asking if you wish to go online.

2. Click on [OK]. You are now online and can operate the program in the LT through
the Monitoring Mode.
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2.2 Starting and Stopping the Controller
When the Controller is operating in Monitoring Mode, the start/stop of the Controller
can be controlled via the LT Editor. From now we will use this feature to monitor the
controller’s mode.
As mentioned previously, you must be online to the Controller before you can use the
start/stop, or online editing functions.

To Start/Stop the Controller:
1. From the [Controller] menu, select [Start/Stop]. If you are in Programming Mode,

however, this option is unavailable. The [Start/Stop Controller] window is dis-
played.

The functionality of the [Start/Stop Controller] window is explained below.

When the setting is changed from Start/Stop, the system internally
checks the status for the "Enable IO" setting. Therefore, "Enable
IO" setting changes made during the "Start" mode will not be re-
flected. Be sure to change the setting to "Stop" before changing
the "Enable IO" setting, and then return to the "Start" mode.

Option Description

Start The [Start] button starts the Controller. Once it starts, it scans from the 
beginning of the program and executes all logic sequentially. The first 
scan executes any initialization logic.

Stop The [Stop] button stops the Controller.
Reset The Reset button causes the Controller to reload the ".LTE" file, 

initialize any I/O and then stop.
1 Scan Press this button to perform a single scan of logic. This function is 

useful for troubleshooting or debugging an application.
Pause Pause button stops the Controller from scanning logic but leaves the 

I/O enabled.
Continue The Continue option is available after the Pause button has been 

pressed. It allows the Controller to continue executing logic (or a single 
scan) with the current data values.

Enable All Forces Enables the forced variables.
Disable All Forces Disables the forced variables.
Forces Lists all forced variables in the ladder logic program.

This function enables the inputs/outputs to the LT  main unit and 
external I/O of the I/O unit. In normal operations, the input/output of the 
external I/O is disabled when the LT is set to the RUN mode after 
performing a Logic Program download. For safety reasons, this 
function prevents the possibility of accidental startups of machines 
caused by errors in operation and logic programs.

Enable I/O
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Go Command Mode

Go Online

Write to controller

Read from controller

Reset

Start

Continue

Stop

Pause

1 Scan

Enable Forces

Enable IO

You can also select these items from the [Controller] menu’s [Command].

If you click on [Reset], all LT Editor variables will be reset except
retentive variables. Use the MOV instruction etc. if any values need
special initialization.
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2.3 Troubleshooting Using System Variables
System variables can be used to help troubleshoot for an application if it does not
perform as expected.
The system variables are the most useful for detecting problems with either the Control-
ler or the I/O are #Fault, #IOFault, #IOStatus and #ScanCount.
Option Description

#FaultCode #FaultCode identifies the most recent fault condition. It is reset to 0 
when the first scan operates after the Controller started.

#Faultrung #Faultrung detects the rung number which has a fault.
#IOFault #IOFault is a discrete variable that is turned ON when a fault is 

detected in your I/O system.
#IOStatus is an array which displays I/O specific errors. These errors 
are indexed with a numeric code. This code differs from driver to

#IOStatus driver. (Reference: For a detailed explanation of the error see the 
driver's Help system.) An error is displayed in #IOStatus only if #IOFault 
has been turned ON.

#ScanCount #ScanCount indicates the number of scans the Controller has 
executed since it was last started. When monitored, this variable 
should constantly be increasing. If it is not, the Controller is not running.

For details on system variables, please refer to Chapter 8 System
Variables.
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You can view the system variables to show information about I/O status, scan time and
controller status.  Chapter 8 System Variables

To View System Variables:
1. From the [Data] menu, select [Variable List] and the [Variable List] window

appears. All LT Editor system variables (variables which begin with #) should be
displayed. If they are not, select [System] from the [View] menu.

2.4 Viewing System Variables

2. From the [Data] menu, select [Data Watch List]. The [Data Watch List] window
appears.

3. Click and drag the system variables you wish to monitor from the [Variable List]
window to the [Data Watch List] window.

These monitored variables display the appropriate errors if they occur while the logic is
being scanned.
In the following example, I/O error 821 has occurred with driver one. The #IOFault is
turned ON.
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To edit and save a logic program located in the LT unit, read out the program from the
Controller.
To read a logic program from the LT, you can either;
• receive the screen data and logic program via the "Transfer" window of the LT

Editor.
• receive a ladder logic program only in the LT Editor's [Transfer] window.
• receive only a logic program via the Logic Program Editor.
This section describes how to receive a logic program exclusively using the LT Editor.

For details on how to receive a logic program via the "Transfer" win-
dow in the LT Editor, refer to Operation Manual - Screen Creation
Guide Chapter 7 Data Transfer.

To Read from the Controller:
1. If the Controller is online, from the [Controller] menu, select [Programming

Mode].

 The Controller must be stopped before doing a “read from controller” if
the program contains values that are not initialized.

2. From the [Controller] menu, select [Read from Controller]. A copy of the pro-
gram written to the Controller will be opened by the LT Editor.
You can now make changes to the program and /or save it as a “*.lte”.

2.5 Reading from the Controller

2.6 Property
Select the [Controller] menu’s [Property]. The LT program’s property information list
box will appear.
The [Property] box is shown below.
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3 On-Line Editing
The LT Editor allows you to make On-Line changes to a program running in the Con-
troller and have these changes take effect immediately. For the demonstrations and
examples in this chapter use the ‘Soda.lte’ file, located in ‘C:\Program Files\Pro-
face\LT\SAMPLE’. All examples used here assume that the ladder colors and prefer-
ences use the system default.

To execute the example program:
1. Open ‘Soda.lte’ file. It is included as an LT Editor sample program and is located in

‘C:\Program Files\Pro-face\LT\SAMPLE’.
2. Write this program to the Controller.
3. Go On-Line to the Controller.
4. Start the Controller.

 For Controller operation, refer to “Chapter 2 Running the Ladder
Logic Program”.

LT Online Program Change Features
On-Line editing features are restricted for the LT platform, however, the following
changes can be made to a program while it is running On-Line in the Controller.
• Turning ON/OFF discrete variables
• Integer value changes

3.1 Before Editing
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To Change the Color Defaults in the Logic Program Editor:
1. From the [View] menu, select [Colors] and the [Colors] dialog box appears.

2. Select the [Element] and then the [Color] you want associated with that element,
then click on [Apply].

The Logic Program Editor uses default colors to indicate specific aspects and changes
to a ladder logic program while running On-Line. The default colors are:

Color Meaning
Green Indicates circuit is charged
Red Indicates an error has occurred.

Purple Indicates online edit feature is being used

3.2 Using Colors for On-Line Editing
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Discrete variables can be manually turned ON or OFF while the logic program is
running. A discrete that has been turned ON is not the same as a discrete that has been
forced ON, since its state can be affected by the program as it is scanned.

To Turn a Discrete ON or OFF:
1. Right-click on the variable ‘Light’ assigned to the output coil on rung 2.
2. Select [Turn ON] from the short cut menu. The ‘Light‘ variable turns ON and the

power flow indicates that power is flowing through the rung.

3. Right-click on the variable ‘Light’ assigned to the output coil on rung 2.
4. Select [Turn OFF] from the short cut menu. The ‘Light’ variable now turns OFF and

the power flow disappears, indicating that power no longer flows through the rung.

Power flow is not displayed in your logic if the [Power Flow] check
box is not selected in the [Monitoring] section of the [Preferences]
dialog box.
Chapter 1 Preference Area Settings (Prior to Creating a Logic Pro-
gram)

3.3 Turning a Discrete ON and OFF
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Indicates variable has been forced ON

A discrete can be forced ON or OFF while you are online in the Controller. The
difference between turning a discrete ON or OFF and forcing it ON or OFF is that if
you force it, the variable does not change its state until the force is manually changed.
The program logic and I/O cannot change its state. The discrete ON and OFF opera-
tion described in section 3.3 depends on the calculation result of the program; however,
the force discrete ON and OFF operation does not depend on the calculation result.

To Force a Discrete ON or OFF:
1. Right-click on the variable ‘Soda_valve’ on the output coil on rung 9.
2. Select [Force ON] from the short cut menu.
3. Click on [OK] in the [Force] dialog box.

The variable turns ON and cannot be turned OFF by the ladder logic program.

If you find that forced variables have no effect in your ladder logic
program, they have probably been disabled in the LT Editor. To
enable forces click on the [Enable All Forces] button in the [Start/
Stop Controller] dialog box, or use the [Controller] menu and the
toolbar.

3.4 Forcing Discrete ON and OFF
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While you are online to the Controller you can set the value of any LT Editor variable
included in your ladder logic program.

Changing a Variable Value:
1. From the [Data] menu, select [Value]. The [Data Value] dialog box appears.
2. Click on the variable ‘Number_of _Smalls’ in the ladder logic. The [Data Value]

dialog box appears as follows:

3. Select the ‘0’ in the [Change to] field, then type ‘5’.
4. Click on [Apply].

The value of ‘Number_of _Smalls’ is now 5. You can change other values or close
the [Data Value] dialog box by clicking on [Close].

•   You can enter data values in Decimal, Hexadecimal, Octal or
Binary number format. Simply select one from the [Format] list.

•   Use the [Variable List] or [Data Watch List] in conjunction with
the [Data Value] dialog box to quickly find and set LT Editor
variables.

3.5 Changing Variable Values
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Changing a Variable Attribute  (Retentive)
Select the [Data] menu’s [Variable List]. The [Variable List] window will appear.
Select the variable you wish to change its attribute, and change the attribute using this
window as shown below. However, the system variable’s “retentive” cannot be
changed.

You can use the [Data] menu to change the variable attributes (Retentive/Global.)
This menu is enabled only when you are in the programming mode.

Changing  a Variable Attribute (Global)
Select the [Data] menu’s [Variable List]. The [Variable List] window will appear.
Select the variable you wish to change its attribute, and change the attribute using this
window as shown below.

3.6 Changing Variable Attributes
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To change the display mode of all selected variables at the
same time
Select the [Data] menu’s [Data Watch List], and select a display mode in the [View]
list box. This allows you to change all of the selected variables’ display mode to the
designated display mode at the same time.

To Display Array Elements
When creating an array via [Data Watch List], you can display array counter/timer’s
values by element.
1. Select the [Data] menu’s [Variable List] and [Data Watch List].
2. Select the [Data Watch List] menu’s [Edit], and select [Add Elements] from the
[Edit] box.

3.7 Data Watch List
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4 Errors and Warnings
Error or warning displays may appear in the [Validity] dialog box when a validity check
is done on a program. These errors and warnings may be related to a problem with the
program’s logic, variables or I/O. The errors are indexed numerically, with each numeral
being part of a specific range. Each range specifies a general area for you to focus on
when determining why the error or warning has occurred.

200-299: Logic errors and warnings
 For information on instruction for the logic program, select it in the
main window, and then from the [Help] menu select [Context], or
press the [F1] key.

Error 200 – Parameter should be a Discrete
The instruction requires a Discrete operand. This can be:
• A Discrete variable,
• An element of a Discrete array, or
• A Discrete element of an Integer variable.

Error 201 – Parameter should be a Counter
The instruction requires a Counter variable.

Error 202 – Parameter should be a Timer
The instruction requires a Timer variable.

Error 203 – Parameter should be an Integer or Real
The instruction requires an Integer of Real, either as a variable or a constant.

Error 204 – Parameter should be a non-constant Integer or Real
The instruction requires an Integer or Real variable. It cannot be a constant.

Error 205 - Parameter should be an Integer
The instruction requires an Integer as a variable or a constant.

Error 206 – Parameter should be an Integer but not an array
The instruction requires an Integer, either as a variable or a constant. It cannot be an
array.

Error 207 – Parameter should be a non-constant Integer
The instruction requires an Integer variable. It cannot be a constant.

Error 208 – Parameter should be a label
The instruction requires a label name, and a label with that name must exist.

Error 209 – Parameter should be a subroutine
The instruction requires a subroutine name.

Error 210 – Label is out of scope
The specified label exists, but cannot be reached from here.
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Error 211- Subroutine cannot call itself
The Jump Subroutine instruction is attempting to call the subroutine that contains it. This
is not allowed.

Error 212 – X should be the same type as Y
The two parameters should have the same type (Integer, Real, etc.).

Error 213 – X should be the same size as Y
The two parameters must be the same size. That is, both must be either:
• Arrays with the same number of elements, or
• Non-arrays.

Error 214 – X should be the same size as Y or be an Integer.
The two parameters must be the same size or the second can be an Integer that is
treated as if it is the larger size.

Error 215 – X should be an Integer, a Real or a Discrete array
The instruction requires an Integer, Real or Discrete, either as a simple variable or a
complete array.

Error 216 – X should be a non-constant Integer, Real or Discrete array.
The instruction requires an Integer, Real or Discrete, either as a simple variable or a
complete array. It cannot be a constant.

Warning 217 – Both parameters are constants
The instruction is comparing two constants.

Warning 218 – Input parameter used on output instruction
The variable is marked as an input (refer to [Variable Type] window), however, it is
used in an output instruction. Double-check its I/O assignment.

Warning 219 – Preset value is zero
The preset value of the counter is set to zero.

Warning 220 – Preset time is zero
The preset time of the timer is set to zero.

Warning 224 – Parameter should not be retentive
The variables assigned to the instruction parameter cannot be “Hold” type.

Warning 225 – X should be an Integer Array
The instruction requires Integer as a complete array.

Error 250 – Duplicate labels are not allowed
The same label is defined more than once. This is not allowed, even in different sections
of the program.

Warning 251 – Empty subroutines have no effect
The subroutine contains no rungs. If you do not alter the empty subroutine it will have no
effect on your program.
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Warning 252 – Empty rungs have no effect
The rung contains no instructions. If you do not alter the empty rung it will have no effect
on your program.

Warning 253 – Empty branches have no effect
The branch contains no instructions. If you do not alter the empty branch it will have no
effect on your program.

Error 254 – Control instruction should be last on rung.
The instruction cannot have any others to the right of it.

Warning 255 – X is used by more than one timer instruction
The timer variable is used by more than one timer instruction. The results are indefinite.

 You can use the [References] window to find the other instruction(s).

Error 256 – X is used by more than one counter instruction
The Counter variable is used by more than one counter instruction. The results are
indefinite.

 You can use the [References] window to find the other instruction(s).

Error 257 – Last instruction on rung should be an output
The instruction is not an output instruction (i.e., it does not change the values of its
parameters).

Error 258 – Multiple outputs are not allowed
An output instruction cannot have other instructions to the right of it.

Error 259 – Last instruction on branch should be an output
An output instruction cannot have other instructions to the right of it.

Error 260 – Maximum level of nesting exceeded
The rung has too many levels of branches (the maximum number of levels is 25). Try
dividing the rung into several smaller ones.

Error 262 – Program is too large (by xx %), see Controller | Setup |
Memory
The program size is larger than the LT Flash Memory.

Warning 263
The variable is used by more than one coil. When the ladder logic program is executed,
the result of the last instruction to which the variable is assigned will be effective.

Error 269
The rung memory usage has been exceeded by xx%.

Error 270
The maximum label number has been exceeded. The maximum number is 2048.

Error 271
The maximum variable number has been exceeded. The maximum number is 8192.
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Error 272
The maximum constant number has been exceeded.

Error 273
The maximum numbers of NT instructions and PT instructions have been exceeded. The
maximum number is 2048.

Error 274
The maximum numbers of Advanced instructions was exceeded. The maximum number
is 100.

300-399: Variable errors and warnings
Warning 300 – Variable has input or output type but no I/O address
assigned
The variable is marked as an input or output (refer to the [Variable Type] window),
however, it is not mapped to any I/O.

Error 301 – Type not assigned
The variable has not been assigned a variable type. To assign a variable type use the
[Variable Type] window.

Error 302 – Label not found
The Jump Subroutine instruction refers to a label that does not exist.

Error 303 – Variable referenced should be a Timer or Counter
You have specified an element of a Timer or Counter variable, however, the variable is
actually of a different type. Refer to the [Variable Type] window.

Error 304 – Variable(s) referenced should be Integer type
You have used a variable to specify an array element or modifier. This variable must be
an Integer. Refer to the [Variable Type] window.

Error 305 – Array reference to non-array variable
You have specified an element of an array, however, the variable is not designated as an
array. Refer to the [Variable Type] window.

Error 306 – Array reference is beyond size of array
You have specified an element of an array using a constant that is equal to or larger than
the array’s size. (Note that the valid elements are numbered 0 to size-1). You can
change the size in the [Variable Type] window.

Error 308 – Modifier reference is out of range
You have specified a bit, byte or word element that is out of range.

Error 309 – Reference is invalid for the variable
You have specified a timer reference for a counter variable, or vice versa.

Warning 310 – …Already exists and will be replaced
A variable by that name already exists. The new one will replace the original one if you
click on [OK] in the [Variable Import Status] window.
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Error 311 – The clipboard buffer is not a recognized format
The current contents of the clipboard are not suitable for pasting into the [Variable
List] window.

Error 312 – Too many warnings
The [Variable Import Status] window only shows a certain number of warnings. If
you see this message, there may be more warnings that does not show.

Warning 313 – Missing  ]
An array type requires the size enclosed in square (“[ ]”)brackets. For example, Integer
[10].

Warning 314 – Array size is invalid …Assuming a size of 1
This variable apparently is intended to be an array, however, the size is not recognizable.
The size should be an integer within square brackets. For example, Integer [10].

Warning 315 – Unknown type …will be Not Assigned
The text is not recognized as a LT Editor variable type. Possible causes are:
1. It is spelled incorrectly
2. It has leading and / or trailing blanks.

Warning 316 – Unsupported array type … Ignoring array settings
That variable cannot be an array.

Error 317 – Invalid variable name…
You have entered an invalid variable name.

Error 318 – Too many errors
The [Variable Import Status] window only shows a certain number of errors. If you
see this message, there may be more that it does not show.

Error 320 – Too many variables
You have attempted to assign too many variables.

Error 321 – Too many variables
You have attempted to assign too many variables. Reduce the number of variables.

400-499: Logic Program LT Editor I/O errors and warnings
Error 400 – Variable Name has already been mapped
The variable is mapped to more than one I/O point. Refer to the [Configure I/O]
window.

500-549: Generic I/O driver errors
Error 500
The LTE file may be corrupted or was damaged during download.

Error 501 – Internal variable mapped to I/O terminal
The variable is marked as “internal”, however, it is mapped to an I/O terminal. Refer to
the [Variable Type] window.
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Error 502 – Input variable mapped to output terminal
The variable is marked as an input, however, it is mapped to an output terminal. Refer to
the [Variable Type] window.

Error 503 – Output variable mapped to input terminal
The variable is marked as an output, however, it is mapped to an input terminal. Refer to
the [Variable Type] window.

Error 504 – Discrete variable mapped to analog terminal
A Discrete variable cannot be mapped to an analog terminal.

Error 505 – Integer variable mapped to discrete terminal
An Integer variable cannot be mapped to a discrete terminal.

Error 506 – Variable type not supported by I/O driver
The I/O driver requires a different type of variable to be mapped to this terminal.

Error 507
Variables have not been allocated to terminals.

Error 508
LT type has been selected that is not supported by the current set of drivers.

600-799: PID Instruction Error
Error 600
Set a control block variable to the Integer array with at least seven elements.

Error 601
Set a special variable “Variable.SP” to the Integer.

800-899: Specific I/O driver errors
 For information about any errors pertaining to your I/O driver, refer
to your I/O driver user guide.

900-1000: Specific I/O driver warnings
 For information about any warnings pertaining to your I/O driver,
refer to your I/O driver’s User Guide.
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Array
A Discrete, Integer or Real variable can be designated as an array. This means that
multiple elements of that type are allocated under a single name.

Bit
The basic storage element, its value may be either 1 or 0.

Bookmark
An invisible marker that can be placed anywhere in your logic, allowing you to instantly
return to that portion of your program.

Branch
A parallel path of execution on a rung.

Byte
A storage element containing 8 bits of information. A byte may be assigned values from
0 to 255. A Logic Program Editor integer is composed of 4 bytes.

Clipboard
A temporary storage place maintained by Windows for copying and pasting data. This
can be done between applications or within a single application.

Data Watch List Window
Shows data values as they change. You can adjust the update rate in the [Preferences]
dialog box.

Descriptions
A description can be any amount of text, up to 32767 single-byte characters, that
describes some part of your program. A summary of descriptions may be viewed with
the [Description List] window.

Discrete point
A point that can have one of two states: OFF or ON.

Drag and Drop
To press and hold down the left mouse button, move the mouse, then release. The
mouse pointer indicates whether this is a valid place to let go.

5 Glossary of Terms
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Element
An element is a name for some part of a variable, rather than the whole thing. This part
can be:
•  An element of a Timer or Counter variable,
•  An element of an array, or
• Part of an Integer

 Error (Fault Conditions)
There are three types: Major, Minor, and I/O.
A Major Fault is serious. When this occurs, the Controller stops executing logic imme-
diately. The editor shows the state as “MAJOR FAULT”. To clear the condition, the
Controller must be reset using the [Start/Stop] window.
A Minor Fault is one that can be safely ignored.
An I/O Fault is a failure to read or write I/O in.

Focus
A black rectangle that highlights a selection in the ladder logic program.

Forces
Discrete points can be forced either ON or OFF. This overrides any actions the logic
may take. For example, if a variable is forced OFF, but the logic is trying to turn it on, it
stays off. A list of the forces in your program can be viewed with the [Force List]
window.

LT Controller
The LT Controller executes ladder logic and controls I/O. The Controller is invisible and
performs the LT unit’s extended tasks. The Logic Program Editor monitors the control-
ler in Monitoring Mode.

Hexadecimal
A base-16 representation of an integer value. These can be entered with 16# in front.
For example, 16#FF is 255.

IEC 61131-3
A standard developed by the International Electrotechnical Commission defining the
printed and displayed representation of five control languages including: Instruction List
(IL), Ladder Logic Diagrams (LD), Function Block Diagrams (FBD), Structured Text
(ST), and Sequential Function Charts (SFC).
The smallest component in a rung which instructs the LT Editor Controller to perform a
specific function (i.e., Discrete, Bit operand, Data control, Operand, Timer/Counter, and
Program control instructions). Instructions in LT Editor are based on the IEC 61131-3
specification.



5–3LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 5 – Glossary of Terms

Instruction
The smallest component in a rung which instructs the LT Controller to perform a specific
function (i.e., Discrete, Bit operand, Data control, Operand, Timer/Counter, and Pro-
gram control instructions). Instructions in Logic Program Editor are based on the IEC
61131-3 specification.

Integer
A storage element containing 32 bits of information. An integer may be assigned values
ranging form –2147483648 to 2147483647 (16#0000000 to 16#FFFFFFF in hexa-
decimal). Integers cannot contain decimal points.

Internal Variable
A variable that is not mapped to an I/O point.

I/O
Input/Output . The LT Controller connects to physical (real-world) devices through I/O
hardware supplied by third parties.

I/O Address
An address assigned to a variable when it is mapped to an I/O device. The format of an
I/O address depends on the driver it is mapped to.

Label Name
A name containing up to 32 characters that identify or label a position within the ladder
logic. It cannot start with a digit.

Ladder Logic
The collection of rungs that make up your application. So called because it looks
vaguely like a ladder.

Off-Line
When Off-Line, the LT Editor works with the disk file ‘.lte’ containing a ladder logic
program. This program is developed Off-Line and then run On-Line with the Controller.

On-Line
The LT Editor monitors a program which is running ‘live’ with the LT Controller. For
example; Power_off_pushbutton, ResetButton, ALARM2 etc.

Parameter
An input to or output from an instruction. Parameters are entered into the Instruction
Parameter Box.

Power Flow
The path power is taking through the ladder logic program.
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Real
Any number containing a decimal point or being represented in scientific notation. The
range for a real in Logic Program Editor is +2.25e-308 to +1.79e-308. It can have up to
15 significant digits.

State Flow
Highlights individual instructions based on their parameters. Each contact is highlighted if
it is able to pass power (as opposed to whether it actually gets power), based on the
state of its parameter.

Subroutine
A group of rungs in a separate, named area.
Subroutines are placed between the END and PEND (Program End) markers, and
cannot be placed within other subroutines. When you click on [Subroutine] from the
[Insert] menu, both a “Subroutine Start” and a “Subroutine End” markers are created.
You can then insert logic between the two.
Subroutine are called with a “Jump Subroutine (JSR)” instruction. The advantage is that
they can be called from many places, and the code only needs to be written once. A
subroutine name is required.

Subroutine Name
A Subroutine Name consists of up to 32 letters, digits, and / or underscores. It can only
start with a letter.

System Variables
System Variables are special, predefined variables that provide information about the
controller’s status or affect its operation. They perform like ordinary variables, except
that they are created automatically and cannot be deleted.

Variable
Storage locations for data values are called variables. Easy-to-understand names are
recommended to use, rather than using numbered addresses. A variable name is up to
20 letters, digits, and / or underscores. It cannot start with a digit. Some valid examples
are: Power_Off_pushbutton, ResetButton and ALARM2, etc. LT Editor creates an
appropriate type of variable automatically as soon as a new variable name is entered
either in [Parameter Box] or the [Configure I/O] window.

Watchdog Timer
Detects an error if the program did not finish running up to the “END” rung within a
certain length of time. To set “Watchdog Timer”, select [Setup] from the [Controller]
menu, and enter time in millisecond in the [Watchdog Timer] box in the [Tuning] tab.

Word
A storage element containing 16 bits of information. A word may be assigned values
ranging from 0 to 65535.
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The LT contains both screen display and I/O control features. These features and their
respective modes are described below.

• Understanding the LT’s operation modes is critical for designing a
system. Please read this chapter thoroughly to understand the opera-
tion and design the system in consideration of safety issues.

• When OFFLINE mode is entered, the controller will stop. Re-entering
RUN mode will reset the LT.

6 Controller Features

6.1 Operating the LT

LT Features
Operation Controller Features RUN Mode Constant Scan Mode
Mode  - Control Features Logic Program Runs the Logic Program 

 - Read/Write I/O RUN Mode at the designated time.

Display Mode Percent Scan Mode
 - Screen Display Designates the percent of 
 - Data Transfer with a single scan used by the 
   PLC, temperature controller's program.

OFFLINE Mode    controllers, inverters,
 - Initial Settings    etc. STOP Mode
 - Screen Data Transfer Halt Logic Program Mode
 - Self Diagnosis (Allows the editing, writing,

etc. of the Logic Program)
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The Controller feature functions as follows. The facing page provides detailed descrip-
tions of each step.

6.1.1 Controller Feature Overview

Initial Processing
This is the original state of the engine use to perform the Logic Program. Once initializa-
tion is finished, the Controller enters the “Loading” state.

Loading
Here, the actual reading in from memory of the Logic Program is performed. After a
check is performed to determine whether the Logic Program is successfully loaded or
not, error processing is performed if an error has occurred. If Loading is successful, the
program enters the [STOP] state. If the [Power ON Operation Mode] is set to
[START], the [RUN] instruction is automatically performed.

[STOP]
[Perform 1 Scan]

First Scan
[Perform 1 Scan]

[PAUSE]

[Continue] [STOP]

Running STOPTemporary
Stop

[RESET]

[RUN]
First Scan

Initial Processing

Loading

[RESET]

[RESET]

[STOP]

Power ON
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S T O P
In this condition the Controller is waiting to receive another instruction. Once the [RE-
SET], [Perform 1 Scan], [Continue], or [PAUSE] instructions are received, the Con-
troller changes to that condition.

The [RESET] instruction will change the program to the [Loading] condition.

At this time, variables are initialized. Retentive variables maintain data before the power
shuts down or the LT resets. However, when triggering Controller reset in Monitoring
mode (*1), or when using the #Command, the value set in Programming Mode (*2) is
used as the initial value. Non-retentive variables are cleared to zero.

The [RUN] instruction will change the program to the [Running] condition.

The [Perform 1 Scan] instruction will perform the program once.

First Scan
Executes the I/O Read, performs any Logic Program that is higher the START level,
and executes the I/O write.

Running
This is the Logic Program performance engine’s continuous performance mode. In this
mode, it executes I/O Reads, performs Logic Programs, executes I/O writes, and
updates  System Variables. (#AvgLogicTime, #AvgScanTime, etc.)

The [RESET] instruction will change the program to the [Loading] condition.
The [STOP] instruction will change the program to the [STOP] condition.
The [PAUSE] instruction will change the program to the [Temporary Stop] condition.

Temporary Stop
The logic program execution engine is temporarily stopped in this state. To avoid an I/O
watchdog timeout, the system executes an I/O read and I/O write. However, the logic
program is not executed, so the output state does not change. When a command is
received, the system switches to the appropriate state.

The [RESET] instruction will change the program to the [Loading] condition.
The [Perform 1 Scan] instruction will perform the program once.

The [STOP] instruction will change the program to the [STOP] condition.
The [Continue] instruction will change the program to the [Running] condition.

1. Mode used edit the program currently being executed by the controller.
2. Mode used to create a program.
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RUN Mode uses the following steps.

6.1.2 RUN Mode

Scan Time Adjustment
This adjustment is performed every 64 scans. The various types of adjustments are
described below for Constant Scan Time, and Percent Scan Time.

Constant Scan Time Mode
LT scan time = (#AvgLogicTime x 100) / 50

Percent Scan Time Mode
LT scan time = (#AvgLogicTime x 100) / #PercentAlloc

 For information about #AvgLogicTime or #PercentAlloc, Chapter 8
System Variables

The LT’s Scan Time includes an error of approximately +0.3%.

No

Yes

No

Yes

RUN Mode

Perform Logic
Program

END Processing
(Renew System Variables, etc.)

Scan Time Adjustment

Scan
Completed

Constant Scan/
Percent Scan

64 Scan
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6.1.3 LT Scan Overview

LT Scan time has two modes, Constant Scan time mode and Percent Scan time mode.
Their basic scan time includes two parts, logic program execution controller and display
(screen/touch panel processing time, external device processing time) as follows.

 6.1.2 RUN Mode

START
Start Stop Operation

Operation

END
PEND

1

2

3

4
5

Scan
time

Display feature section
  Executes only during the set scan time, minus
  the logic time (when performing a constant scan).

Controller feature section
   -I/O Input Data Read

Logic Program Execution

I/O Output Data Write

- Screen Display
- Touch Panel Processing
- Communication ProcessingGraphic

processing
time

Logic time

����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
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Graphic processing time = Setting time for constant scan time mode (ms) - logic time
(variable)

e.g.)  If constant scan time is set to 50ms and logic executing time is 20ms

         Graphic processing time = 50ms - 20ms

= 30ms

The longer the logic time, the shorter the graphic processing time will become.
Though LT display response will be slower, the logic program will execute constantly.

When the logic time exceeds 50% of the designated setting value for con-
stant scan mode, the scan time is automatically adjusted so that it is
twice as long as the logic time.

Example) When the logic time is 30 ms and the constant scan
mode is 50 ms, the scan time is 60 ms.

• Make sure to enter the setting value for the scan time in 10-ms
increments.

• When determining the value for the setting time, use the
#AvgScanTime value obtained from a test run of the LT.
8.2.2 #AvgScanTime

Constant Scan Mode
This mode constantly executes the program during the scan time set.

When this setting is used, the screen is used mainly for data display and less for opera-
tion, with control (logic program) being the priority.

Scan time
(fixed scan
period)

Logic Time
Processing time
for logic program
(variable)

Graphic pro-
cessing time
= Scan time -
logic time

I/O Input Data Read

Logic Program Execution

I/O output Data Write

START
Start Stop Operation

Operation

END
PEND

1

2

3

4
5
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I/O Input Data Read

Logic Program Execution

I/O Output Data Write

Scan Time
Logic set time
+ screen
processing
time = 100%
(variable)

Logic Time
Processing time
for logic pro-
gram
(Set by percent-
age, variable)

Graphic pro-
cessing time
= Total scan time
- Logic time (set
by %)

Scan time = Logic time / Percent scan set time (%)

e.g.)  If percent scan time is set to 40% and logic executing time is 20ms

         Scan time = (20 ÷ 40) × 100

= 50ms

         Graphic processing time = 50ms - 20ms

= 30ms

When logic time increases, display processing time also increases, resulting in longer
scan times.
The longer the logic time, the longer the time allocated to display processing. There-
fore, the display is updated more quickly, however, the logic program processing
cycle slows.

START
Start Stop Operation

Operation

END
PEND

1

2

3

4
5

• There is no change in the processing time for one instruction in the
logic program.

• The scan setting (%) cannot be set to more than 50%.
• When the percent scan setting is set to 50%, the display and logic

program are processed at the same time. The display process will
not be given priority.

Set the percent scan value so that the scan time is set in 10-ms
increments.

Percent Scan Mode
This mode varies the scan time according to the percentage set by the logic time
This feature sets the priority to screen operation speed and screen switching speed
required during Logic Program execution.
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7 Variables
This chapter explains the different types of variables used by the LT software.

Using hardware-independent variables enhances the reusability of your programs.

7.1 Variable Names
LT Editor uses variables to store I/O and counter data. Variables  settings and names
are user designated and are used as-is in the logic program.
In a conventional PLC, the area used to store data is called a device address. These
addresses are given specific names by each PLC manufacturer.

With the LT Editor, you can assign names to these device addresses and use them as
variables in the logic program.

PLC LT Editor

Manufacturer’s Device Address Variable Name
(User-defined name)

PLC Manufacturer External I/O Internal
Relay Timer Data

Register
Mitsubishi X001 M100 T200 D00001
Omron 01 1001 TIM000 DM0000
Digital Electronics
Corporation Switch1 Timerstart Timer Operating

Time, etc.

In LT Editor (Ver. 1.03 or later), the preprogrammed variables listed
below are registered in the following files in the Program Files\Pro-
face\LT\SAMPLE folder: Variable Sample I (TypeA): lte; Variable
Sample II (TypeA): lte; and Variable Sample III (TypeA): lte.
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Variable Sample I (TypeA): lte

Variable Sample II (TypeA): lte

Variable Sample III (TypeA): lte

Variable names can be designated by the user. When designating variable names, be
aware of the following limitations.

• Maximum Variable Name length is 20 characters (20 bytes).

Each array’s element and timer and each counter’s special variables ([.PT], [.PV],
etc.) are also counted as a character.

• No differentiation is made between upper- and lower-case characters. If duplicates
are created, only the first word registered will be enabled (valid).

E.g.: If “TANK” was registered before “tank,” “tank” will be invalid, even though
entering it will not create an error.

• Except for the first character, variable names can use numbers.

• Variable names cannot contain spaces.

Device type Variable name Variable type Variable attributes
Internal relay M0 to M127 Discrete Non-retentive/Global/Internal
Counter C0 to C63 Counter Retentive/Global/Internal
T imer T0 to T63 Timer Retentive/Global/Internal
Register D0 to D127 Integer Retentive/Global/Internal
Retentive relay L0 to L127 Discrete Retentive/Global/Internal
Input relay X0 to L127 Discrete Non-retentive/Global/Input
Output relay X0 to X15 Discrete Non-retentive/Global/Output

Device type Variable name Variable type Variable attributes
Internal relay M[0] to M[255] Discrete Non-retentive/Non-global/Internal
Counter C0 to C31 Counter Non-retentive/Global/Internal
T imer T0 to T31 Timer Non-retentive/Global/Internal
Register D[0] to D[255] Integer Non-retentive/Non-global/Internal
Retentive relay L[0] to L[255] Discrete Retentive/Non-global/Internal
Link relay B[0] to B[127] Discrete Non-retentive/Global/Internal
Link register W[0] to W[127] Integer Non-retentive/Global/Internal
Input relay X[0] to L[15] Discrete Non-retentive/Non-global/Input
Output relay Y[0] to Y[15] Discrete Non-retentive/Non-Global/Output

Device type Variable name Variable type Variable attributes
Internal relay R[0] to R[255] Discrete Non-retentive/Non-global/Internal
Counter CNT0 to CNT31 Counter Non-retentive/Global/Internal
T imer TIM0 to T IM31 Timer Non-retentive/Global/Internal
Register DM[0] to DM[511] Integer Retentive/Global/Internal
Retentive relay HR[0] to HR[255] Discrete Retentive/Non-global/Internal
Link relay LR[0] to LR[127] Discrete Non-retentive/Global/Internal
Input relay IN[0] to IN[15] Discrete Non-retentive/Global/Input
Output relay OUT[0] to OUT[15] Discrete Non-retentive/Global/Output
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• The underscore ( _ ) is the only special character that can be used.
However, underscores ( _ _ ) cannot be used consecutively

(OK: tank_1; Not OK: tank_ _1).

• The “#” sign cannot be used since it is a reserved character, .

• “LS” and “LSS” are reserved names for use by the LT unit’s system in the System
Data Area, the Read Area, and for Special Relays. Therefore, they cannot be used
for variable names.

Chapter 10 LS Area Refresh

When creating variable names, Pro-face recommends using the un-
derscore character to divide the variables into blocks, or groups.
This will make the variable names easier to find.

E.g.: If you have several conveyor belts in your factory system (Conveyer A, Con-
veyor B, Conveyor C, etc.), include an identifying character in the motor and
sensor variable names:

Conveyor A variables:

A_Motor

A_Sensor

You could also name a Discrete (bit) as B, Integer as I, floating point as F:

AB_MotorStartingSwitch

AI_MotorRotationNumber

AF_MotorPowerRatio

Here, the variables used for contacts and coils are distinguished from the
variables used for basic mathematical operations.

• You can also use an array to set up variable names for each of your PLC’s  devices.

Example

For information about Variable Settings, refer to 1.2 Creating
Variables.
For information about reserved System Variables, refer to Chap-
ter 8 System Variables.

Array Variabe Variable Type
External Input X[100] Discrete
External Output Y[100] Discrete
Internal Relay M[100] Discrete
Data Register D[100] Integer

PLC Device LT Editor
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Conventional PLC

External Input Contact (X) A
External Output Contact (Y) B
Internal Relay (M ) C
Data Register (D) D
Timer E
Counter F

PLC Device and LT Variable Comparison

Total 32 KB

LT Editor Variables

Real

Integer

Discrete

Counter
Timer

7.2  Variable Types
The Logic Program Editor uses three types of variables — Discrete (bit), Integer, and
Real. Within these types, Timers and Counters are also used. Arrays can be defined and
used with each type of variable.

For details on defining arrays, refer to 7.3 Access to Variables.

The maximum size of an array (the number of elements it contains) is 65535. However,
the actual number of elements that can be used by any application is limited by the size
of the LT unit’s variable storage area. The amount of memory available to the LT for
variables is limited to 32KB. Be sure to design your system so that the number of
variables used does not exceed the LT unit’s memory limit.

Use the following table to find the amount of memory used by each variable.

Discrete Variables
These variables are used to define a discrete condition, i.e. ON or OFF, using a single
bit and the values “0” or “1”.

Integer Variables
These variables use 32 bits to define integer values from -2147483648 to 2147483647.

In the PLC, the number of variables that can be used by each device is limited. In the
LT, however, variables can be registered, regardless of type, as long as the overall limit
of 32 KB is not exceeded.

Real Variables
These variables use 64 bits to define floating decimal point values from +/-2.25e-308 to
+/-1.79e+308, and “0”.

Variable Type Memory Used (unit:byte)
Discrete 12
Discrete Array 20 + (No. of elements x 12)
Integer 8
Integer Array 20 + (No. of elements x 8)
Real 16
Real Array 20 + (No. of elements x 16)
T imer 48
Counter 80
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* Any names can be used for these variables.

Even when a timer is designated as non-retentive, the special-purpose
variable “Timer.PT” will retain data.

For a list of retentive/non-retentive  variables, refer to n
Variable Attributes.

Counter
The following seven dedicated variables are used for the Counter instructions.

For details, refer to 9.2 Instructions Details.

* Any names can be used for these variables.

• Even when a counter  is designated as non-retentive, the special-pur-
pose variable “Counter. PV” will retain data.

• A scan update will not be performed for a counter when it is reset. One
scan is required for resetting the counter.

 For retentive/non-retentive variable details, refer to  Vari-
able Attributes.

Special-Purpose
Variables Description Variable Type

PT Preset Value Integer
ET Current Value Integer
Q Timer Output Bit Discrete
TI T imer Measuring Bit Discrete

Special Purpose
Variables Description Variable Type

PV Preset Value Integer
CV Current Value Integer
R Counter Reset Discrete
UP UP Counter Discrete
QU UP Counter Output Discrete
QD DOWN Counter Output Discrete
Q Counter Output Discrete

Timer/Counter
The Timer and Counter consist of multiple special-purpose variables.

Each dedicated variable’s type is set up individually.

Timer
The following four dedicated variables are used for Timer instructions.

For details, refer to 9.2 Instruction Details.
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Variable Attributes
Variables have the following attributes, in addition to the variable type.

Internal
Used internally by the LT. It cannot be used for external input/output. Internal variables
are equivalent to PLC internal relays (internal registers).

Input/Output
External input/output is available. Assign variables to I/O in the [Configure I/O] window.
This feature is equivalent to the input/output relays of the PLC.

For I/O configuration details, refer to 1.9 I/O Configuration.

Retentive
Retentive-type variables use the LT unit’s SRAM, which preserves data values in the
case of a power failure. The initial values for these variables are set via Programming
mode. When the LT unit is powered down or reset, all current data is retained. How-
ever, when the LT unit’s Controller is reset in Monitoring mode or by using the #Com-
mand, or when logic programs are downloaded, all data is initialized using Programming
mode preset values.

In addition, reading the LT unit’s .lte files will save the execution results to the Editor.
However, be careful when using retentive-type variables as initial values. If these vari-
ables are designed to vary while the logic program is being executed, the predetermined initial
values will be lost when the data is loaded into the Editor. Non-retentive variables are either
cleared to 0 or set to OFF.

Global
These variables can be designated as either global or non-global. Specify "global" for
variables that are used to display Drawing Board Parts. Global variables are automati-
cally registered as LT symbols in the Symbol Editor when you save the ladder logic
program. These variables can also be shared with the Drawing Board’s display feature.
Global/non-global settings of multiple variables can be performed at one time by select-
ing the desired variables from the Variable List. Up to 2048 global variables can be set.

3.6 Changing Variable Attributes

Preprogrammed system variables are set to "global" in the LT unit’s
initial settings.
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This section explains how to access variable array elements, bits, bytes and words.

An array is a method of declaring and handling multiple elements with a single variable
name. Variables of the same type can be registered as one group using an array.

One analogy is the drawers of a cabinet.

The array variable Cabinet[10] has 10 drawers, numbered
from [0] to [9]. These drawers are called Cabinet[0], Cabi-
net[1], . . . Cabinet[9]. Each drawer corresponds to an
individual data register in the PLC.
When using 10 locations of Cabinet memory, first declare the
variable name of Cabinet and the array size (number of ele-
ments) of 10. The variable type settings are listed as follows:

7.3 Accessing Variables

[0]
[1]
[2]
[3]
[4]
[5]
[6]
[7]
[8]
[9]

Cabinet

MotorSetting[6] Fan

Accessing a Discrete Array
To access the elements of a Discrete array, a modifier [n] must be attached to each
element. To access the modifier, it is assigned an element number, however the first
element number in an array must be “0.”

E.g.: The Discrete array “MotorSetting” is a Discrete array of 10 elements. The seventh
element controls the output coil Fan. When the seventh element is turned ON, the
output coil turns ON. To access the seventh element of MotorSetting, enter
MotorSetting[6].
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Accessing an Integer/Integer Array
Integers and Integer Arrays can be accessed via array elements, bits, bytes, and words.

To access an array’s element, add [n] to the end of the variable name. To access using
bits, bytes, and words, the following suffixes are used. The modifier [m] is used to
denote the position of the element in the array being accessed.

To Access an Element with the Integer Array
An Integer Array can be used for numerical calculation, tracking of repetitive informa-
tion and data logging.

E.g.: To record the number of sodas sold in
one month in the Integer Array
Water_Sales, design your array as
follows.
The array consists of 31 Integer type
elements which correspond to each of
a month’s days (31).

The following diagram is an example of the Integer Array Pressure, using three ele-
ments.

• Pressure[0] represents the current pressure of the boiler.

• Pressure[1] represents the pressure upper limit value.

• Pressure[2] represents the pressure lower limit value.

When the pressure is higher or lower than the pressure limit, an alarm turns ON.

Pressure[0]
Pressure[1]

Pressure[0]
Pressure[2]

High Pressure Alarm

Low Pressure Alarm

Access Item/Unit Suffix
Bit .X[m]
Byte .B[m]
Word .W[m]

[Day 0] Water_Sales[0]
[Day 1] Water_Sales[1]
[Day 2] Water_Sales[2]
[Day 3] Water_Sales[3]

—
—
—

[Day 27] Water_Sales[27]
[Day 28] Water_Sales[28]
[Day 29] Water_Sales[29]
[Day 30] Water_Sales[30]

Current Pressure Pressure[0]
Pressure Upper Limit Value Pressure[1]
Pressure Lower Limit Value Pressure[2]
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Also, for Water_Sales[1].X[29]:

As a result, since Water_Sales.X[61] = Water_Sales[1].X[29]‚ both can be
used to access the 62nd bit of the Integer array Water_Sales.

• To access the 6th byte of the Integer array variable Water_Sales‚ both
Water_Sales.B[5] and Water_Sales[1].B[1] can be used.

• To access the 5th word of the Integer array variable Water_Sales‚ both
Water_Sales.W[4] and Water_Sales[2].W[0] can be used.

Water_Sales.X[61] and Water_Sales[0].X[61] have the same meaning.

In the following example the 3rd bit of the system variable #Status is used as a NO
instruction variable. The third bit of #Status identifies whether the LT unit has an I/O
error or not. Therefore, when the third bit is turned ON, the output coil’s IO_Error is
turned ON, which provides notification that an I/O error has occurred.

• To access the 62nd bit of the Integer array variable Water_Sales, type
Water_Sales.X[61].

As is the case with the discrete array variables, integer arrays can be accessed via bits,
bytes, and words. To access the m+1st bit of the n+1st element in the
Integer_Array_Variable_ Drink Sales, enter Drink_Sales[n].X[m].

E.g.: • To access the Integer array Alarm’s seventh bit, type Alarm.X[6].

Accessing an Integer Array using bits

32nd Bit First Bit
31 … 6 … 1 0

7th Bit

32nd Bit First Bit
31 … 1 0
63 62 61 … 33 32

64th Bit 33rd Bit

62nd Bit

32nd Bit First Bit
31 … 1 0 First Element (Element No. 0)
31 30 29 … 1 0 Second Element (Element No. 1)

64th Bit 33rd Bit

62nd Bit = First Element's 29th Bit



7–10 LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 7 – Variables

Array Indirect Access
Array elements [n] can be indirectly accessed by an Integer variable. Numbers in the
square brackets [ ] of suffixes such as .X[m], B[m], and W[m] can also be indirectly
accessed.

The following example assumes that you press the switch. In the INC instruction, "N"
increments by one with every single scan. The result of the ADD instruction, i.e. the sum
of "N" and "1", is then assigned to A[N]. After 5 scans have been performed, "1" is
assigned to A[0], "2" to A[1], "3" to A[2], "4" to A[3], and "5" to A[4]. Note that the
initial value of "N" is 0.

Accessing a Real Array
Real Arrays can be accessed using array elements. To access the elements of a Real
array, the modifier (n) must be attached to each element, which represents the element
number. Also, “0” is used for the first element in the array.

E.g.: To access the 5th element in the Real array SolutionTemperature, you would
use "SolutionTemperature[4]".

The LT Editor can handle up to 2048 LT variables. The elements of the
array become single variables. Thus, an array with five elements be-
comes five variables.

An Real array can be used for numerical calculation, tracking of repetitive information
and data logging.

E.g.: To record the temperature of a solu-
tion every 24 hours in the Real array
Solution_Temperature, the structure of
data is as follows.
The array consists of 24 Real type ele-
ments that correspond to each hour of
a day.
Real element 0 corresponds to the tem-
perature data at 0:00.

INC ADD

N

N
1

A[N]

Switch

Solution_Temperature[0]
Solution_Temperature[1]
Solution_Temperature[2]
Solution_Temperature[3]

—
—
—

Solution_Temperature[20]
Solution_Temperature[21]
Solution_Temperature[22]
Solution_Temperature[23]
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System Variables are used to display the Controller’s current condition, and effect its
operation. System variables have similar variable types as ordinary variables and per-
form similarly. Since system variables are preprogrammed and defined, they cannot be
deleted and their names cannot be changed.

8.1 System Variable List

The following table provides a list of the Controller’s predefined System Variables.

8 System Variables

G
ro

up System Variable Explanation Initial
Value

Variable
Name

#AvgLogicTime
Displays the average Logic Time
(Read, Perform, Write) once every
64 scans. (Unit: ms)

0 Integer

#AvgScanTime
Displays the latest Logic Time
(Read, Perform, Write, Display
processing).  (Unit: ms)

0 Integer

#Clock100ms Create 0.1s clock. - Discrete
#Day Stores Day data as BCD two digits. - Integer
#EditCount Currently not used by LT - Integer

#ForceCount Counts the number of times a
variable is forced ON or OFF. 0 Integer

#IOStatus Displays the I/O Driver's condition. - Integer [10]

#LogicTime Displays the latest Logic Scan Time
(Read, Perform, Write).  (Unit: ms) 0 Integer

#Month Stores Month data as BCD two digits. - Integer
#Platform Indicates the controller's platform. - Integer

#ScanCount Excluding the current scan, counts
the number of scans performed. 0 Integer

#ScanTime
Displays the latest Logic Scan Time
(Read, Perform, Write, Display
processing).  (Unit:ms)

0 Integer

#Status Indicates the controller's current
status. – Integer

#StopPending Currently not used by LT – Discrete
#Time Stores Time data as BCD four digits. – Integer
#Version Displays the controller's version data. – Integer
#WCLScan Currently not used by LT – Integer
#WCLStatus Currently not used by LT – Integer

#WeekDay Stores Weekday data as value of 0
to 6 - Integer

#Year Stores Year data as BCD two digits. – Integer

#WatchdogTime
Displays the value set via the Editor
or the GP unit's OFFLINE screen.
(Unit:msec.)

– Integer

Da
ta

Re
ad

 O
nly
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#Year, #Month, and #Day are saved as the LT unit’s time data. Time data
changes are performed via the LT unit’s Initial settings, or the System
Data Area’s Write settings.

LT Series User Manual (sold separately), External Device Con-
nection Manual.

This section uses a #Screen to explain how to use system variables.
The following logic program switches the screen to base screen (B100), which is screen
number 100. Pressing the switch changes the screen by substituting 100 in the #Screen.

8.1.1 How to Use System Variables

G
ro

up System Variable Explanation Initial
Value

Variable
Name

#FaultCode Displays the latest error code. – Integer

#FaultRung Displays the rung where the error
occurred. – Integer

#IOFault Turns ON when an error occurs. – Discrete

#Overflow

Turns ON when an overflow occurs
due to mathematical commands or
conversion of a variable from Real
to Integer.

0 Discrete

#Command Changes the controller's mode. 0 Integer

#DisableAutoStart Defines the mode entered when the
GLC starts up. – Discrete

#Fault Used to stop the performance of an
Error Handler subroutine. 0 Discrete

#FaultOnMinor
Controls the completion of the logic
performed when a minor error
occurs.

0 Discrete

#PercentAlloc Calculates the Percent Scan's
percentage. (Unit: % ) 0 Integer

#PercentMemCheck Not currently used by the LT – Integer

#Screen Switches LT screens by assigning
screen numbers. – Integer

#StopScans Not currently used by the LT – Integer

#TargetScan Sets the Constant Scan Time.
(Unit: ms) – Integer

Er
ro

rs
Se

ttin
gs

Re
ad

 O
nly

W
rite

 O
nly
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This section describes each system variable in detail.

8.2 System Variable Details

#AvgLogicTime stores the average logic time in ms units.
The average logic time refers to the average time required in one scan for reading I/O,
executing the ladder logic program, and reading I/O. Every 64 scans, this system
variable updates the average logic time since its last calculation.

Variable Type: Integer
Set by: Controller
Read Only

8.2.1 #AvgLogicTime

Execute

Write

Read

Display
Processing

#AvgScanTime stores the average amount of time, in milliseconds, that the controller
uses to read inputs, execute logic, write outputs, and perform display processing in a
single scan. Every 64 scans, this system variable updates the average scan time.

Variable Type: Integer
Set by: Controller
Read Only

8.2.2 #AvgScanTime

Execute

W
rite

Read

Display
Processing
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• If an LT unit’s scan time exceeds 50ms, #Clock100ms clock will
not be guaranteed.

• If the #Clock100ms clock reads in the internal clock 100ms at the
beginning of each LT scan, an error will occur.

Scan Time Every 30ms

8.2.3 #Clock100ms

#Clock100ms generates clock in milliseconds. Do not change the clock value since this
is used for read in only. An initial value is undefined.

Variable Type: Discrete
Set by: Controller
Read Only

Scan Time

Internal Clock
(100ms)

#Clock100ms Value

#Clock100ms
provides the user
program with the

clock data

30ms30ms30ms30ms 30ms 30ms 30ms

50ms 50ms 50ms50ms 50ms

60ms 60ms 30ms 60ms

#Clock100ms includes approximately the same amount of error as the
scan time.
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#Day displays the Day data, as set by the controller, using two digits in BCD format.
Variable Type: Integer
Set by: Controller
Read Only

Year, Month, Day, and Time data are displayed using the following system variables:
E.g., July 14, 2001 at 6:19 a.m.

8.2.4 #Day

#ForceCount stores the number of variables that are forced ON or OFF in the current
ladder program.

Refer to 2.2 Starting and Stopping the Controller.

Variable Type: Integer
Set by: Controller
Read Only

The Data Watch List window indicates the five variables that are forced ON or OFF in
the logic program.

8.2.5 #ForceCount

Year Month Day Time
System Variable #Year #Month #Day #Time
Value 01 07 14 0619
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Execute

W
rite

Read

Display
Processing

#Day #IOStatus is set by the I/O driver, and stores the I/O driver’s current status in
#IOStatus[1].
A value of 0 indicates that the I/O is normal. The status indicated by a value other than 0
differs, depending on the I/O driver.
Variable Type: Integer[10]
Set by: Controller
Read Only
The Data Watch List window shows that Error 802 occurred in the I/O driver 1.

8.2.6 #IOStatus

#LogicTime indicates the amount of time, in milliseconds, that the controller uses in a
single scan to read inputs, execute logic, and write outputs of the previous scan. Logic
time does not include the display processing time allowed by the controller for other
programs to execute.
Variable Type: Integer
Set by: Controller
Read Only

8.2.7 #LogicTime

For I/O driver error code descriptions, refer to Chapter 11 I/O
Drivers.
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#ScanCount is a counter incremented by the controller at the end of each scan.
The value range of #ScanCount is 0 – 16#FFFFFFFF. When the counter value exceeds
the maximum value (16#FFFFFFFF), the value of #ScanCount is set to zero (function-
ing as a Rollover, but without setting the Overflow variable).
Variable Type:  Integer
Set by: Controller
Read Only

Whether or not the logic program is running can be easily checked
using #ScanCount.

8.2.9 #Platform

#Platform displays which platform the controller is running on.
Variable Type:  Integer
Set by: Controller
Initial Value: 1
Read Only

8.2.10 #ScanCount

8.2.8 #Month

#Month displays the Month data, as set in the controller, using two digits in BCD
format.
Variable Type: Integer
Set by: Controller
Read Only
Year, Month, Day, and Time data are displayed using the following system variables:
E.g., July 14, 2001 at 6:19 a.m.

Year Month Day Time
System Variable #Year #Month #Day #Time
Value 01 07 14 0619

Value Platform
16#54 LT Type A
16#64 LT Type B/Type B+
16#74 LT Type C
16#114 LT Type H-AD
16#144 LT Type H-ADP
16#154 LT Type H-ADT
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8.2.12 #Status

#Status indicates the controller’s status.
Within the #Status system variable:
Byte 0 indicates the current fault conditions of the controller.
Byte 1 is used to show the fault status history, and is reset to 0 only when the controller
is reset.
Byte 2 indicates the current operating status of the controller.
Byte 3 is reserved.
Variable Type:  Integer
Set by: Controller
Read Only

Intermittent errors can be detected by using the latch fault flag.
Use hexadecimal format for #Status.

ExecuteRead

Write
Display

Processing

8.2.11 #ScanTime

#ScanTime stores the amount of time, in milliseconds, that the controller uses during its
last complete scan, to read I/O, execute logic, write I/O, and display processing.
Variable Type: Integer
Set by: Controller
Read Only
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When the following fault flags become 1, the corresponding conditions are indicated as
follows:

Fault Flags Latched Fault 
Flags

Bit0 Major fault Bit8 Major fault
Bit1 M inor fault Bit9 M inor fault
Bit2 I/O fault Bit10 I/O fault
Bit3 Reserved Bit11 Reserved
Bit4 Read error Bit12 Read error
Bit5 Reserved Bit13 Reserved
Bit6 Scan time error Bit14 Scan time error
Bit7 Reserved Bit15 Reserved

Controller Status
Bit16 Running
Bit17 I/O EnabledDisabled

Bit18 Forces 
Enabled/Disabled

Bit19 Paused
Bit20 Reserved

Reserved

B
yt

e0

B
yt

e1

Reserved

B
yt

e2

Bit 21-23
B

yt
e3

8.2.13 #Time

#Time displays Time data, as set in the controller, using four digits in BCD format.
Variable Type:  Integer
Set by: Controller
Read Only
Year, Month, Day, and Time data are displayed using the following system variables:
E.g., July 14, 2001 at 6:19 a.m.

Year Month Day Time
System Variable #Year #Month #Day #Time
Value 01 07 14 0619
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8.2.15 #Year

8.2.14 #Version

#Version indicates the version number of the controller. #Version is displayed in hexa-
decimal format.
Variable Type: Integer
Set by: Controller
Read Only

#Year displays Year data, as set in the controller, using two digits in BCD format.
Variable Type: Integer
Set by: Controller
Read Only
Year, Month, Day, and Time data are displayed using the following system variables:
E.g., July 14, 2001 at 6:19 a.m.

8.2.16 #Weekday

#Weekday displays present Weekday data, with a value of 0 to 6.
Variable Type: Integer
Set by: Controller
Read Only
#Weekday reflects the number LS2054.
LS2054 cycles a value of 0 to 6 (.. 5  6  0  1) at the time-of-day change
(23:59 to 00:00).

When the power is plugged in, values of 0 to 6 are reflected by default. It is not neces-
sarily reflect that Sunday is 0 and Monday is 1. To coordinate Weekday data with the
actual day of the week, map values of 0 to 6 to LS2062.

Byte No. Description Ver. 1.0.0
Byte3 Major version 01
Byte2 Minor version 00
Byte1 Reserved –
Byte0 Reserved –

Year Month Day Time
System Variable #Year #Month #Day #Time
Value 01 07 14 0619
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8.2.17 #FaultCode

#FaultCode identifies the most recent fault status. A controller resets all these values to 0.
Refer to 12.2 Error Codes.

Variable Type: Integer
Set by: Controller
Read Only

In the Data Watch List window, #FaultCode 7 is displayed.
This indicates that the scan time has exceeded the watchdog time.

Code Type Cause
0 Normal No fault.

1 M inor Overflow resulting from a mathematical operation or a Real-to-Integer
conversion.

2 Major Array reference is out of bounds.
3 Major Bit reference of the Integer (32 bits) is out of bounds.
4 Major Stack overflow.
5 Major Invalid instruction code.
6 Reserved by the system
7 Major Scan time exceeds watchdog time.
8 Reserved by the system

9 Major Software error – typically a malfunctioning custom function block – may
require a system reboot to recover.

10 Reserved by the system
11 Reserved by the system
12 Minor BCD/BIN conversion error
13 Minor ENCO/DECO conversion error
14 Reserved by the system
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#IOFault turns ON when an I/O fault occurs with the I/O driver. This error remains until
the next error occurs or the controller is reset. Check the #IOStatus variable for de-
tailed status of the I/O driver.
When #IOFault turns ON, #IOFault is displayed in the Data Watch List window.
Variable Type: Discrete
Set by: Controller
Read Only

For I/O driver error code descriptions, refer to Chapter 11 I/O
Drivers.

#FaultRung stores the rung number where a fault occurred. #FaultRung is set to 0 if
there are no faults.
The following example shows when an error occurred at Rung 3.
This error is caused by subtracting the Integer by 0 when DIV Instruction is executed.
This error remains until the next error occurs or the controller is reset.
Variable Type: Integer
Set by: Controller
Read Only

8.2.18 #FaultRung

8.2.19 #IOFault
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If an overflow does not occur during Real-to-Integer conversion,
#Overflow will not turn ON.

#Overflow turns ON when a mathematical fault occurs. #Overflow stays ON until the
next mathematical instruction or conversion.
Mathematical faults include instruction overflows, Real-to-Integer conversion overflows,
and divide by zero errors.
When a mathematical fault occurs, a minor fault also occurs, which executes an
ErrorHandler subroutine, if one exists.

Refer to 12.2 Error Codes.

The ErrorHandler subroutine is an error process subroutine, and must first be created
under the name “ErrorHandler.”
The value in the #Fault system variable defined whether the controller will stop or
continue execution of the logic program.

Refer to 8.2.21 #Fault.

Variable Type: Discrete
Set by: Controller
Read Only
In the following example, the ErrorHandler subroutine detects BCD/BIN conversion
errors and stops execution of the logic program.

8.2.20 #Overflow
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8.2.22 #DisableAutoStart

8.2.21 #Command

8.2.23 #Fault

If the power is turned ON while #DisableAutoStart is ON, the controller starts up in the
STOP mode.
If the power is turned ON while #DisableAutoStart is OFF, the controller starts up in
the state it was in (START or STOP) prior to shutdown.
The above settings are enabled only when the Controller State setting is set to Default in
the LT unit’s initial settings.
Variable Type: Discrete
Set by: User
Initial Value: OFF
Writable

#Command is an Integer variable used as a controller command. After the controller
reads #Command, it resets the value to 0. When multiple bits are ON, the lowest bit
takes precedence.
Variable Type:  Integer
Set by: User
Initial Value: OFF (All bits)
Writable

#Fault is referred to by the controller as to whether the logic program will stop or
continue to execute at the completion of the ErrorHandler subroutine.
By turning #Fault ON, the controller will be able to stop executing the logic program.

For information about ErrorHandler subroutines, refer to 8.2.18
#Overflow.

Variable Type: Discrete
Set by: User
Initial Value: OFF
Writable

#Fault has no meaning when there is no ErrorHandler subroutine.

Bit0 (=1) Stop Controller
Bit1 (=2) Run Controller
Bit2 (=4) Reset Controller
Bit3 (=8) Execute single scan
Bit4 (=16) Continue
Bit5 (=32) Pause
Bit7 (=128) Enable I/O
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8.2.24 #FaultOnMinor

8.2.25 #PercentAlloc

#FaultOnMinor is checked by the controller to determine whether the logic program will
stop or continue to execute when a minor fault occurs and there is no ErrorHandler
subroutine in the logic program.
Turning ON the #FaultOnMinor allows you to pause the execution of a ladder logic
program.

Refer to 12.2 Error Codes.

For information about ErrorHandler subroutine, refer to 8.2.18
#Overflow.

Variable Type: Discrete
Set by: User
Initial Value: OFF
Writable

#PercentAlloc is used when the controller is set to the Percent Scan mode. It sets the
percentage of the LT unit’s total CPU time available to the controller. Set a scan time
value in multiples of 10ms.
#PercentAlloc can be set in the initial settings or the configuration settings when the
controller is in RUN mode. Usually, #PercentAlloc can be set up in the Setup dialog
box.

Refer to 6.1.2 RUN Mode.

Variable Type: Integer
Set by: User
Range: 0 to 50%
Initial Value: 50
Writable
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• When changing screens, use the #Screen in the logic program. Do
NOT write directly to the #Screen using touch input. Change screens
using the logic program diagram below as an example.

• After power is turned ON, if the #Screen variable is used to change
the initial screen, be sure to wait more than 200ms or use the
LSS[0].x[3] (LS2032’s bit 3) bit rising (0 -> 1) timing.

Variable Type: Integer
Set by: User/Controller
Initial Value: 0
Writable

• The screen number set in #Screen defines which base screen to
display. This number is not the currently displayed screen number.

• Since the #Screen variable is write only, it cannot be used to
determine if a screen has changed, etc.

8.2.26 #Screen

#Screen is used to change LT unit screens. This screen change variable’s operation
differs from [Change Screen Check] as follows.
If the [Change Screen Check] feature is enabled and the screen change number is
entered in #Screen, after the screen change is completed the value is reset to “0”.

 Ch. 1 Programming
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8.2.27 #TargetScan

8.2.28 #WatchdogTime

#WatchdogTime is used to set the value of the watchdog timer, in milliseconds. When
#ScanTime exceeds this value, a major fault occurs.

Refer to 12.2 Error Codes.
The #WatchdogTime setting should not be changed while the controller is starting up.
Even if the value is changed, the actual setting will not change. Usually, #WatchdogTime
is set in the OFFLINE mode’s [Setup] dialog box.
Variable Type:  Integer
Set by: User (prior to starting RUN mode)
Initial Value: 500ms
Read-only

#TargetScan is used when the controller is set to the Constant Scan mode.
The #TargetScan variable is designated in multiples of 10ms units.
When the logic time is constant, increasing the value in #TargetScan means that the
display processing time will be longer.
Decreasing the value in #TargetScan means that the display processing time will be
shorter. This is because most of the processing time is used by the controller.
#TargetScan can be set in the initial settings or the configuration settings when the
controller is in RUN mode. Typically, #TargetScan can be set up in the Setup dialog
box.

Refer to 6.1.2 RUN Mode.

Variable Type: Integer
Set by: User
Range: 10–2000ms
Initial Value: 10ms
Writable
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Instruction Type Symbol Function

NO Normally Open
Allows power to pass when the contact
turns ON.

NC Normally Closed
Allows power to pass when the contact
turns OFF.

OUT/M*1 Output Coil/Retention
Coil

/
Turns physical output devices or
internal discrete variables and
expressions ON or OFF.

NEG/NM*1 Negated Coil/Negated
Retention Coil

/
Turns a variable OFF if the coil
receives power, and ON if it doesn't.

SET/SM*1 Latch Coil/ Latch
Retention Coil

/
Turns a variable ON if the coil receives
power.Stays ON until receiving another
explicit instruction.

RST/RM*1 Unlatch Coil/ Unlatch
Retention Coil

/
Turns a variable OFF if the coil
receives power. Stays OFF until
receiving another explicit instruction.

PT*2 Positive T ransition
Allows power to pass if the variable was
OFF during the previous scan, but is
ON now.

NT *2 Negative Transition
Allows power to pass if the variable was
ON during the previous scan, but is
OFF now.

1.  For the instructions listed above, when a variable is retentive, it automatically changes
to one of the right-side instructions. Therefore, when entering data in this screen, be
sure to use one of the left-side (non-retentive) instructions.

    In the following example, when an OUT instruction’s variable is retentive, the screen
icon changes to M.

Designate a
variable

Select
“Retentive”

Variable is
converted to M

9 Instructions

9.1 Instruction List
The Instructions supported by the LT Editor software are as follows.

Discrete Instructions

2.  Up to 2048 PT/NT instructions can be used.
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Arithmetic Operation Instructions
Instruction Type Symbol Function

AND Logical Multiply A and B      C
Normal Continuity

OR Logical Add A or B      C
Normal Continuity

XOR Exclusive
Logical Add

A xor B      C
Normal Continuity

NOT Bit Negation A      C
Normal Continuity

Movement Instructions
Instruction Type Symbol Function

MOV Transfer  IN      OUT
Normal Continuity

BMOV Block Transfer

FMOV File Transfer

Array A Array E

 B        C
  D

Normal 
Continuity

Array D

   A    C

 Normal 
Continuity

       B

Shift Instructions
Instruction Type Symbol Function

ROL Rotate Left C  Normal Continuity

ROR Rotate Right C Normal Continuity

SHL Shift Left C Normal Continuity

SHR Shift Right C Normal Continuity

A
N Shift

A
N Shift

A
N Shift

0 A
N Shift
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Instruction Type Symbol Function

TON ON Delay
Timer See 4.2.33 – "TON (ON Delay Timer)."

TOF OFF Delay
Timer See  4.2.34 – "TOF (OFF Delay Timer)."

TP Timer Pulse See 4.2.35 – "TP (Timer Pulse)."

CTU UP Counter See 4.2.36 – "CTU (UP Counter)."

CTD DOWN
Counter See 4.2.37 – "CTD (DOWN Counter)."

CTUD UP/DOWN
Counter See 4.2.38 – "CTUD (UP/DOWN Counter)."

Mathematical Instructions

Timer and Counter Instructions

Instruction Type Symbol
ADD Add A + B       C Normal Continuity
SUB Subtract A – B       C Normal Continuity
MUL Multiply A x B       C Normal Continuity
DIV Divide A ÷ B      C Normal Continuity

MOD Residual
Processing A % B     C Normal Continuity

INC Increment A + 1       A Normal Continuity

DEC Decrement A – 1       A Normal Continuity

Function

Comparison Instructions

Instruction Type Symbol
EQ Equal To (=)
GT Greater Than (>)
LT Less Than (<)

GE Greater Than or
Equal To (>=)

LE Less Than or
Equal To (<=)

NE Not Equal (< >)

Function

When A < or = B, Continuity

When A < > B,  Continuity

When A = B, Continuity
When A > B,  Continuity
When A < B,  Continuity

When A > or = B, Continuity

The Timer Instruction includes an approximate amount of error
equal to the scan time.
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Instruction Type Symbol Function
JMP Jump  ->>label name Jumps to a label

JSR Jump to 
Subroutine

 ->>Subroutine 
Name<<- Jumps to subroutine

RET Return from 
Subroutine  -<RETURN>- Returns to called JSR command.

FOR, NEXT Repeat
Repeats execution of the logic program 
between FOR and NEXT for the number 
of times assigned at A.

Instruction Type Symbol Function

BCD BCD 
Conversion

A        BCD conversion       B
Normal Continuity

BIN Binary 
Conversion

A        Binary conversion       B
Normal Continuity

ENCO Encode A        Encode conversion       B
Normal Continuity

DECO Decode A        Decode conversion       B
Normal Continuity

Convert Instructions

Program Control Instructions

Instruction Type Symbol Function
When EN is energized:
SP and PV perform the PID calculation,
and output via CV.
When EN is not energized:
TB and CV go to MOV.

PID CalculationPID

Special Instruction*1
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Variable

The NO instruction allows power to pass when the variable is ON.
The following diagram is an example of the NO instruction’s function.

A: When the Start variable turns ON, the Motor variable turns ON.
B: When the Start variable turns OFF, the Motor variable turns OFF.

MotorStart

Start

Motor

9.2 Instruction Details

9.2.1 NO (Normally Open)
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The NC instruction allows power to pass when the variable is OFF.
The following diagram is an example of the NC instruction’s function.

A: When the Start variable turns ON, the Motor variable turns OFF.
B: When the Start variable turns OFF, the Motor variable turns ON.

MotorStart

Start

Motor

Variable

9.2.2 NC (Normally Closed)



9–7LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 9 – Instructions

The OUT instruction is used to turn ON/OFF the variables mapped to the I/O, or the
Discrete variables in the internal memory .
Since this instruction is a coil-type output instruction, only one instruction can be used
for each rung. Other instructions cannot be used on the right side of the output instruc-
tion. The output instruction should be placed immediately left of the right-hand power
line.
When the variable mapped to the OUT instruction is retentive, the following symbol is
displayed in the logic program.

The following diagram is an example of the OUT instruction’s function .

Variable

A: When the Start variable turns ON, the Motor variable turns ON.
B: When the Start variable turns OFF, the Motor variable turns OFF.

The OUT instruction can be used only with non-retentive variables.
With retentive variables, use the M (Retention Coil) instruction.

MotorStart

Start

Motor

9.2.3 OUT/M (Output Coil)
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When the NEG instruction is executed, the variable turns OFF when the coil receives
power, and ON when the coil does not receive power.
Since this instruction is a coil-type output instruction, only one instruction can be used
for each rung. Other instructions cannot be used on the right side of the output instruc-
tion. The output instruction should be placed immediately left of the right-hand power
line.
When the variable mapped to NEG instruction is retentive, the following symbol is
displayed in the logic program.

The following diagram is an example of the NEG instruction’s function.

MotorStart

Start

Motor

A When the Start variable turns ON, the Motor variable turns OFF.
B When the Start variable turns OFF, the Motor variable turns ON.

The NEG instruction can be used only with non-retentive variables.

Variable

9.2.4 NEG (Negated Coil)
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Variable

When the SET instruction is executed after the coil receives power, the variable turns
ON. The variable will remain ON until explicitly turned OFF by another instruction
(such as an RST instruction).
Since this instruction is a coil-type output instruction, only one instruction can be used
for each rung. Other instructions cannot be used on the right side of the output instruc-
tion. The output instruction should be placed immediately left of the right-hand power
line.
When the variable mapped to SET instruction is retentive, the following symbol is
displayed in the logic program.

The following diagram is an example of the SET instruction’s function.

Start

Start

Motor

Stop

Motor

Motor

Stop

A: When the Start variable turns ON, the Motor variable turns ON.
B: The Start variable turns OFF, but does not affect the Motor variable.
C: The Stop variable turns ON, the Motor variable resets.
D: The Motor variable stays reset until the Start variable turns ON.

The SET instruction can be used only with non-retentive variables.
With retentive variables, use the SM (Latch Retention Coil) instruc-
tion.

9.2.5 SET (Set Coil)
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Variable

When the coil receives power after the RST instruction is executed, the variable turns
OFF. The variable remains OFF until explicitly turned ON by another instruction (such
as a SET instruction).
Since this instruction is a coil-type output instruction, only one instruction can be used
for each rung. Other instructions cannot be used on the right side of the output instruc-
tion. The output instruction should be placed immediately left of the right-hand power
line.
When the variable mapped to the RST instruction is retentive, the following symbol is
displayed in the logic program.

The following diagram is an example of the RST instruction’s function.

Stop Motor

Motor

Stop

A: When the Stop variable turns ON, the Motor variable resets.
B: When the Stop variable turns OFF, the Motor variable reset by the RST instruc-

tion will remain OFF until another instruction turns it ON.

• The RST instruction can be used only with non-retentive variables. With reten-
tive variables, use the RM (Unlatch Retention Coil) instruction.

• Real and Integer variables cannot be reset (set to zero) with an RST instruc-
tion.

9.2.6 RST (Reset Coil)



9–11LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 9 – Instructions

When the PT instruction is executed, if the variable was OFF during the previous scan
but is currently ON, power is allowed to pass for a single scan.
When starting up the program, the state of positive transition contact during the previous
scan is considered to have been OFF.
The following diagram is an example of the PT instruction’s function.

Start Motor

A: When the Start variable turns ON, the Motor variable turns ON.
B: After one scan (the current scan), the Motor variable turns OFF.
C: Since the rising edge of the variable Start is not detected, the variable Motor

remains OFF.

Motor

Start

Previous
Scan

Current
Scan

Next
Scan

Next
Scan

PT Detected

Variable

9.2.7 PT (Positive Transition Contact)

Be careful when using PT (Rising-type contacts) and NT (Falling-type
contacts) instruction operands for indirect addressing of elements in ar-
rays or bit designations via variables.
The condition of variables set for operands and used during previous
program execution and those variables set for operands are compared
and then executed. Therefore, when designated variable values differ,
the condition comparison object also differs.
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When the NT instruction is executed, if the variable was OFF during the previous scan
but is currently ON, power is allowed to pass for a single scan.
During the first scan, the state of transition during the previous scan is considered to
have been OFF. Therefore, the NT instruction does not pass power during the first
scan.
The following diagram is an example of the NT instruction’s function.

Start Motor

A: When the Start variable turns OFF, the Motor variable turns ON.
B: After one scan, the Motor variable turns OFF.
C: Since the falling edge of the variable Start is not detected, the variable Motor

remains OFF.

Motor

Start

Previous
Scan

Current
Scan

Next
Scan

Next
Scan

NT Detected

Variable

9.2.8 NT (Negative Transition Contact)

Be careful when using PT (Rising-type contacts) and NT (Falling-type
contacts) instruction operands for indirect addressing of elements in ar-
rays or bit designations via variables.
The condition of variables set for operands and used during previous
program execution and those variables set for operands are compared
and then executed. Therefore, when designated variable values differ,
the condition comparison object also differs.
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When the AND instruction is executed, the bit in C turns ON if the corresponding bit in
both A and B is ON. Otherwise, the bit in C is turned OFF.

The AND instruction always passes power.
The following table lists the combinations of A, B and C that can be used with an AND
instruction.

A Operator B C Integer A 0 1 1 0 ... 1 1 0 0
ON ON ON
ON OFF OFF Integer B 1 1 0 0 ... 0 0 0 1
OFF ON OFF
OFF OFF OFF Integer C 0 1 0 0 ... 0 0 0 0

AND

A B C
Integer Integer Integer
Integer Array Integer Array Integer Array
Integer Integer Constant Integer
Integer Array Integer Constant Integer Array

9.2.9 AND (And)

Start

Data A Data C

Data A

Data C

There are three types of AND instructions:
1. When all the variables are not array variables, a simple 32-bit AND operation is

performed.
2. When A and C are array variables and B is not an integer array, AND operations

are performed for each element of A and B, and the results are stored the corre-
sponding elements of C. Make sure that the size of A and C arrays are the same.

3. When the three variables are arrays of the same size, AND operations of array A
and array B are performed. The results are stored in array C.

Operation Example
When Start is ON, the 3rd digit of the 4-digit BCD data of Data A is masked to "0",
and the result is stored in Data C.
Example) When Data A is "16#5678" (5678 in hexadecimal system), "16#5078" is
stored in Data C.
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When the OR instruction is executed, the bit in C turns ON if the corresponding bit in A
and/or B is ON. Otherwise, the bit in C is turned OFF.

Operation Example
When Start is ON, the result of the logical OR operation of Data A and Data B is
stored in Data C.

A B C
Integer Integer Integer
Integer Array Integer Array Integer Array
Integer Integer Constant Integer
Integer Array Integer Constant Integer Array

A Operator B C Integer A 0 1 1 0 ... 1 1 0 0
ON ON ON
ON OFF ON Integer B 1 1 0 0 ... 0 0 0 1
OFF ON ON
OFF OFF OFF Integer C 1 1 1 0 ... 1 1 0 1

OR

9.2.10 OR (Or)

The OR instruction always passes power.
The following table lists the combinations of A, B and C in which OR instructions can be
executed.

Start

Data A
Data B

Data C

There are three types of OR instructions:
1. When both variables A and B are integers, simple 32-bit OR operation is per-

formed.
2. When A and C are array variables and B is not an integer array, logical OR

operations are performed for each element of A and B, and the results are stored
the corresponding elements of C. Make sure that the size of A and C arrays are
the same.

3. When the three variables are arrays of the same size, logical OR operations of
array A and array B are performed. The results are stored in array C.
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When the XOR instruction is executed, the bit in C turns ON if the corresponding bit in
A or B is ON. Otherwise, the bit in C is turned OFF.

A Operator B C Integer A 0 1 1 0 ... 1 1 0 0
ON ON OFF
ON OFF ON Integer B 1 1 0 0 ... 0 0 0 1
OFF ON ON
OFF OFF OFF Integer C 1 0 1 0 ... 1 1 0 1

XOR

Operation Example
When Start is ON, the result of the exclusive OR operation of Data A and Data B is
stored in Data C.

The XOR instruction always passes power.
The following table lists the combinations of A, B and C in which XOR instructions can
be executed.

A B C
Integer Integer Integer
Integer Array Integer Array Integer Array
Integer Integer Constant Integer
Integer Array Integer Constant Integer Array

Start

Data A
Data B

Data C

There are three types of XOR instructions:
1. When both variables A and B are integers, simple 32-bit exclusive OR operations

are performed.
2. When A and C are array variables and B is not an integer array, exclusive OR

operations are performed for each element of A and B, and the results are stored
the corresponding elements of C. Make sure that the size of A and C arrays are
the same.

3. When the three variables are arrays of the same size, exclusive OR operations of
array A and array B are performed. The results are stored in array C.

9.2.11 XOR (Exclusive OR)
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When the NOT instruction is executed, the bit in C turns ON if the corresponding bit in
A is OFF.
The NOT instruction turns OFF the bit in C if the corresponding bit in A is ON.

The NOT instruction always passes power.
The following table lists the combinations of A and C in which NOT instructions can be
executed.

When the MOV instruction is executed, IN is copied to OUT.
If IN and OUT are different variable types, the resulting type will be converted to the
same type as OUT. To transfer arrays, both IN and OUT must be identical in type and
size.
The MOV instruction normally  passes power. The following table lists the combinations
of IN and OUT in which MOV instructions can be executed.

A Operator C Integer A 0 1 1 0 ... 1 1 0 0
ON OFF
OFF ON Integer C 1 0 0 1 ... 0 0 1 1

NOT

A C
Integer Integer
Integer Array Integer Array

9.2.12 NOT (Bit Invert)

9.2.13 MOV (Transfer)

Operation Example
When Start is ON, the result of the NOT operation of Data A and Data B is stored in
Data C.

Start

Data A Data C

There are two types of NOT instruction:
1. When the A variables are integers, simple 32-bit bit conversion is performed.
2. When the A variables are an array, bit conversion is performed for the entire A

array. The result is stored in C. Make sure that the size of A and C arrays are the
same.
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Current_Recipe
Current_Recipe [0]
Current_Recipe [1]
Current_Recipe [2]

Current_Recipe [99]

#Overflow will turn ON if the operation involves a Real-to-Integer data-type con-
version, and the value is too large to transfer. In this case, the result will be unde-
fined.

The following examples illustrate how to use the MOV instruction.
Example 1: Clear a variable
A variable can be cleared with the MOV instruction by transferring a “0” into the
variable.

Example 2: Block-transfer an array
A block transfer can be performed with the MOV instruction by specifying two arrays
of the same type and size.
For example, when transferring Recipe A, which consists of 100 elements, to the
Current_Recipe of the same type and size, simply transfer Recipe A with a MOV
instruction.

IN Type OUT Type
Discrete Array Discrete array same size as IN
Integer Variable or Array in Integer or Real
Integer Array Integer array or variable that is the same size as IN
Integer Constant Variable or Array in Integer or Real
Real Variable or Array in Integer or Real
Real Array Integer array or variable that is the same size as IN
Real Constant Variable or Array in Integer or Real

Clear_Sales

Sales

Recipe_A
Recipe_A [0]
Recipe_A [1]
Recipe_A [2]

Recipe_A [99]

When designating an entire array, enter only the variable names.
E.g.: OK : Recipe_A

Not OK : Recipe_A [*]
Not OK : Recipe_A [100]

Transfer_Recipe_A

Recipe_A Current_Recipe



9–18 LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 9 – Instructions

When the BMOV instruction is executed, elements of one array can be copied into
elements of another array. Specifically, the D elements are copied from index B in array
A to index C in array E.
The BMOV instruction is valid for Integer arrays only. When transferring, arrays can be
different sizes.
The BMOV instruction always passes power. The following table lists the types of A, B,
C, D, and E that can execute BMOV instructions.

While the program is running, the controller checks whether references to array A and E
elements exist in the BMOV instruction. If an invalid array is referred to, a major error
occurs and #FaultCode is set to 2.

Source

A and E B, C, and D
Integer
Integer Constant

Integer Array

Example
When copying, Source [3], [4], and [5] of the source integer array’s 7th element   are
copied to Destination [2], [3], and [4] of the destination array’s 6th element. This data
transfer is performed as follows.

9.2.14 BMOV (Block Transfer)

A: Source variable
B: Start from Array A[B]
C: To Array E[C]
D: Amount of data to be transferred
E: Destination variable

Start

8.2.15  #Faultcode

DestinationSource
Source[0]
Source[1]
Source[2]
Source[3]
Source[4]
Source[5]
Source[6]

Destination[0]
Destination[1]
Destination[2]
Destination[3]
Destination[4]
Destination[5]

Source [3] is copied to Destination [2].
Source [4] is copied to Destination [3].
Source [5] is copied to Destination [4].

Destination
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When the FMOV instruction is executed, the C elements, starting at index B of Integer
array D, are filled with value A.
The FMOV instruction is valid for Integer arrays only. The FMOV instruction always
passes power.
The following table lists the types of A, B, C and D in which FMOV instructions can be
executed.

Example
When copying, the values are transferred to Destination [3], [4], [5], and [6] of the
destination array’s 7th element. The transfer operates as follows.

While the program is running, the controller checks whether references to array D
elements exist in the FMOV instruction. If an invalid array is referred to, a major error
will occur and #Faultcode is set to 2.

 8.2.15  #FaultCode

A, B, and C D
Integer
Integer Constant

Integer Array

TransferValue

9.2.15 FMOV (Fill Transfer)

A: Source data
B: Start from Array D[B]
C: Amount of data to be transferred
D: Variable name of destination array

Start

TransferValue is copied to Destination[3].
TransferValue is copied to Destination[4].
TransferValue is copied to Destination[5].
TransferValue is copied to Destination[6].

Destination

Transfer
Value

Destination[0]
Destination[1]
Destination[2]
Destination[3]
Destination[4]
Destination[5]
Destination[6]

Destination
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The ROL instruction left-shifts the bits in A by N positions. Bits are rotated from the left
end (most significant bit) to the right end (least significant bit). The result is placed in C.

The ROL instruction always passes power.

A N C
Integer Integer or Integer Constant Integer
Integer Array Integer or Integer Constant Integer Array is same size as A
Integer Constant Integer or Integer Constant Integer

Bits

Rotate Left 1 bit
position

9.2.16 ROL (Rotate Left)

A: Variable name to be rotated
N: Number of bit positions to shift
C: Destination variable

Example
The following example describes the operation of a 1-bit rotation using a product
presence/absence signal.

Start

Product presence/
absence signal

Most significant bit Least significant bit

Product
presence/
absence
signal

Product presence/
absence signal

Product presence/
absence signal

#Overflow is turned ON if N is out of range. The result is undefined.

8.2.18  #Overflow

There are two types of ROL instructions:
1. If both A and C are Integers, a simple 32-bit rotation is performed. N must range

from 0 to 31.
2. If both A and C are Integer arrays of the same size, the array is treated as a large

Integer.
Bits are shifted from one element to the next, rather than rotating only within each
element. N must range from 0 to [(32 x array size) – 1], inclusive.

The following table lists the types of A, N and C in which ROL instructions can be
executed.
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A: Variable name to be rotated
N: Number of bit positions to shift
C: Destination variable

The ROR instruction right-shifts the bits in A by N positions. Bits are rotated from the
right end (least significant bit) to the left end (most significant bit). The result is placed in
C.

The ROR instruction always passes power.

Bits

Rotated Right 1
bit position

Most significant bit Least significant bit

9.2.17 ROR (Rotate Right)

Start

Product presence/
absence signal Product

presence/
absence signal

Product presence/
absence signal

Product presence/
absence signal

Example
The following example describes the operation of 1-bit rotation using the signal of
product presence/absence.

A N C
Integer Integer or Integer Constant Integer
Integer Array Integer or Integer Constant Integer Array is same size as A
Integer Constant Integer or Integer Constant Integer

The following table lists the types of A, N and C in which ROR instructions can be
executed.

#Overflow is turned ON if N is out of range. The result is undefined.

8.2.18  #Overflow

There are two types of ROR instruction.
1. If neither A nor C is an array, a simple 32-bit rotation is performed. N must range

from 0 to 31.
2. If both A and C are Integer arrays of the same size, the array is treated as a large

Integer.
Bits are shifted from one element to the next, rather than rotating only within each
element. N must range from 0 to [(32 x array size) – 1], inclusive.
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The SHL instruction left-shifts the bits in A by N positions. Bits are dropped from the
left end (most significant bit) of the element, and 0 is inserted in the now-vacant bit
positions at the right end (least significant bit). The result is placed in C.

Example

The following diagram is an example of a one-bit left shift, used to track the position of a
bit.
Each bit in the product presence/absence signal represents the actual position of the
product.
When "Move_Cart" is turned ON, bit is shifted left to the next position.
When the bit reaches the final bit position in the variable (31), the Product Removal
Completion Bit is turned ON, indicating that the operation is completed.

9.2.18 SHL (Shift Left)

A: Variable name to be rotated
N: Number of bit positions to shift
C: Destination variable

There are two types of SHL instruction.
1. If neither A nor C is an array, a simple 32-bit shift is performed. N must range

from 0 to 31.
2. If both A and C arrays are the same size, the A array is treated as a large Integer.

Bits are shifted from one element to the next, rather than the most significant bit
being dropped from the left end of each element. Only the most significant bit of
the highest-numbered element within the array is dropped. N must range from 0
to [(32 x array size) – 1], inclusive.

A N C
Integer Integer or Integer Constant Integer
Integer Array Integer or Integer Constant Integer Array is same size as A
Integer Constant Integer or Integer Constant Integer

The SHL instruction always passes power.
The following table lists the types of A, N and C in which SHL instructions can be
executed.

#Overflow is turned ON if N is out of range. The result is undefined.

 8.2.18  #Overflow
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Bits

Shift Left 1 bit position

Position after the operation

Delete

Move_Cart x[31] Product Removal
Completion Bit

Product presence/
absence signal

Product presence/
absence signal

Product presence/
absence signal

Product presence/
absence signal

Product presence/
absence signal

9.2.19 SHR (Shift Right)

A: Variable name to be rotated
N: Number of bit positions to shift
C: Destination variable

The SHR instruction right-shifts the bits in A by N positions. Bits are dropped from the
right end (least significant bit) of the element, and 0 is inserted in the now-vacant bit
positions at the left end (most significant bit). The result is placed in C.

There are two types of SHR instructions.
1. If neither A nor C is an array, a simple 32-bit shift is performed. N must range

from 0 to 31.
2. If both A and C arrays are the same size, the A array is treated as a large Integer.

Bits are shifted from one element to the next, rather than the least significant bit
being dropped from the right end of each element. Only the least significant bit of
the lowest-numbered element within the array is dropped. N must range from 0 to
[(32 x array size) – 1], inclusive.

A N C
Integer Integer or Integer Constant Integer
Integer Array Integer or Integer Constant Integer Array is same size as A
Integer Constant Integer or Integer Constant Integer

The SHR instruction always passes power. The following table lists the types of A, N
and C in which SHR instructions can be executed.

#Overflow is turned ON if N is out of range. The result is undefined.

 8.2.18  #Overflow
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Bits Shifted Right
1 bit position

The position after the operation

Delete

• When Using Arrays
The following diagram is an example an SHR instruction being used to transfer values of
each element in an Integer array.
A 32-bit shift rotates the entire 32-bit Integer.
Every second, the “Table1” Integer array’s values are moved up one position towards 0
and a new value is placed at the end of the elements “Table1[99]” in the “Table1”
Integer array.

Timer2_Start
Timer2

Table1 Table1 New_Value Table1[99]

New_Value = 3

Delete

Delete Table1 Table1

Product presence/
absence signal

Product
presence/

absence
signal

Move_Cart x[0] Product Removal
Completion Bit

Product presence/
absence signal

Product presence/
absence signal

Product presence/
absence signal

Example

• When Using Bits
The following diagram is an example of a one-bit right shift, used to track the position of a bit.
Each bit in the product presence/absence signal represents the actual position of the product.
When "Move_Cart" is turned ON, bit is shifted right to the next position.
When the bit reaches the final bit position in the variable (0), the Product Removal
Completion Bit is turned ON, indicating that the operation is completed.
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• If the result C exceeds the range expressed with the variable data type in C,
#Overflow turns ON and the result of ADD is undefined.

 8.2.18  #Overflow
• If either A or B are Real, both are converted to Real prior to the addition.

However, if C is an Integer, the number is truncated after the decimal point,
since the result is placed in C.

A B C
Integer Integer Integer or Real
Integer Constant Integer Constant Integer or Real
Real Real Integer or Real
Real Constant Real Constant Integer or Real

9.2.20 ADD (Add)

A: Data
B: Data
C: Destination Variable

When the ADD instruction is executed, A and B are added, and the result is placed in
C.
If both A and B are Integers or Integer constants, the ADD instruction performs an
Integer addition. Otherwise, the instruction performs a floating-point instruction, which
may reduce the processing speed.
The ADD instruction always passes power. The following table lists the combinations of
A, B and C in which ADD instructions can be executed.

Example
When Start is turned ON, Data A and Data B are added and the result of the operation
is stored in Data C.

Start

Data A
Data B

Data C
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A B C
Integer Integer Integer or Real
Integer Constant Integer Constant Integer or Real
Real Real Integer or Real
Real Constant Real Constant Integer or Real

A: Data
B: Data
C: Destination Variable

When the SUB instruction is executed, B is subtracted from A, and the difference is
placed in C.
If both A and B are Integers or Integer constants, the SUB instruction performs an
Integer subtraction. Otherwise, the instruction performs a floating-point instruction,
which may reduce the processing speed.
The SUB instruction always passes power. The following table lists the types of A, B
and C in which SUB instructions can be executed.

9.2.21 SUB (Subtract)

• If the result C exceeds the range expressed with the variable
data type in C, #Overflow turns ON and the result of SUB is
undefined.

 8.2.18  #Overflow

• If either A or B are Real, both are converted to Real prior to the
subtraction. However, if C is an Integer, the number is truncated
after the decimal point, since the result is placed in C.Example

When Start is turned ON, Data B is subtracted from Data A and the result of the
operation is stored in Data C.

Start

Data A
Data B

Data C
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A: Data
B: Data
C: Destination variable

When the MUL instruction is executed, A is multiplied by B, and the result is placed in
C. If both A and B are Integers or Integer constants, the MUL instruction performs an
Integer multiplication .
Otherwise, the instruction performs a floating-point instruction, which may reduce the
processing speed.
The MUL instruction always passes power. The following table lists the combinations of
A, B and C in which MUL instructions can be executed.

• If the result C exceeds the range expressed by the variable data
type in C, #Overflow turns ON and the result of MUL is unde-
fined.

 8.2.18  #Overflow

• If either A or B are Real, both are converted to Real prior to the
multiplication. However, if C is an Integer, the number is trun-
cated after the decimal point, since the result is placed in C.

A B C
Integer Integer Integer or Real
Integer Constant Integer Constant Integer or Real
Real Real Integer or Real
Real Constant Real Constant Integer or Real

9.2.22 MUL (Multiply)

Example
When Start is turned ON, Data A is multiplied by Data B, and then the result of the
operation is stored in Data C.

Start

Data A
Data B

Data C
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• If B is zero or if the result C exceeds the range expressed by the
variable data type in C, #Overflow turns ON and the result of
DIV is undefined.

 8.2.18 #Overflow

• If either A or B are Real, both are converted to Real prior to the
division. However, if C is an Integer, the number is truncated
after the decimal point, since the result is placed in C.

A: Data
B: Data
C: Destination variable

When the DIV instruction is executed, A is divided by B, and the quotient is placed in
C.
If both A and B are Integers or Integer constants, the DIV instruction performs an
Integer multiplication. Otherwise, the instruction performs a floating-point instruction,
which may reduce the processing speed.
The DIV instruction always passes power.
The following table lists the combinations of A, B and C in which DIV instructions can
be executed.

A B C
Integer Integer Integer or Real
Integer Constant Integer Constant Integer or Real
Real Real Integer or Real
Real Constant Real Constant Integer or Real

9.2.23 DIV (Divide)

Example
When Start is turned ON, Data A is divided by Data B and the result of the operation is
stored in Data C.

Start

Data A
Data B

Data C
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A: Data
B: Data
C: Destination variable

When the MOD instruction is executed, A is divided by B, and the remainder is placed
in C. The MOD instruction performs only Integer or Integer Constant operations.
The MOD instruction always passes power.
The following table lists the combinations of A, B and C in which MOD instructions can
be executed.

#Overflow is turned ON when divided by zero, and the result C is
undefined.

  8.2.18  #Overflow

A B C
Integer Constant Integer Integer
Integer Integer Constant Integer

9.2.24 MOD (Modulus)

The following example is an Integer (27) divided by 5, and the result (2) is placed in C.

Example
When Start is turned ON, Data A is divided by Data B and the remainder is stored in
Data C.

Start

Data A
Data B

Data C

#Overflow is set if A increments from 0x7FFFFFFF to 0x80000000.
 8.2.18  #Overflow

When the INC instruction is executed, one (1) is added to A, and the result is then
placed in A.
The INC instruction always passes power.

9.2.25 INC (Increment)

A: Data
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A: Data

When the DEC instruction is executed, one (1) is subtracted from A, and the result is
then placed in A.
The DEC instruction always passes power.
The following table lists the combinations of A in which DEC instructions can be ex-
ecuted.

#Overflow is set if A decrements from 0x80000000 to 0x7FFFFFFF.
 8.2.18  #Overflow

A
Integer

Example
When Start is turned ON, "1" is added to Data A.

Start

Data A

9.2.26 DEC (Decrement)

Example
When Start is turned ON, "1" is subtracted from Data A.

Start

Data A

The following table lists the combinations of A in which INC instructions can be ex-
ecuted.

A
Integer
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The EQ instruction passes power if A is equal to B.
The following table lists the combinations of A and B in which EQ instructions can be
executed.

Real values need to be compared very carefully. For example, a calculation might
result in 1.99999999999, which is not equal to 2.00000000000.

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

9.2.27 EQ (Compare: = )

A: Data
B: Data

Example
Run mode is triggered when the values of Data A and Data B are equal after Start is
turned ON.

Start

Data A
Data B

The GT instruction passes power if A is greater than B.
The following table lists the combinations of A and B in which GT instructions can be
executed.

Real values need to be compared very carefully. For example, a calculation might
result in 2.000000000001, which is greater than 2.

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

9.2.28 GT (Compare: > )

A: Data
B: Data

RUN
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The LT instruction passes power if A is less than B.
The following table lists the combinations of A and B in which LT instructions can be
executed.

Real values need to be compared very carefully. For example, a calculation might
result in 1.99999999999, which is less than 2.

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

Example
Run mode is triggered when the value of Data A is greater than that of Data B after
Start is turned ON.

RUNStart

Data A
Data B

9.2.29 LT (Compare: < )

A: Data
B: Data

Example
Run mode is triggered when the value of Data A is smaller than that of Data B after
Start is turned ON.

RUNStart

Data A
Data B
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The GE instruction passes power if A is greater than or equal to B.
The following table lists the combinations of A and B in which GE instructions can be
executed.

The LE instruction passes power if A is less than or equal to B.
The following table lists the combinations of A and B in which LE instructions can be
executed.

Real values need to be compared very carefully. For example, a calculation might
result in 1.99999999999, which is not greater than or equal to 2.

Real values need to be compared very carefully. For example, a calculation might
result in 2.000000000001, which is not less than or equal to 2.

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

A: Data
B: Data

9.2.30 GE (Compare: >= )

A: Data
B: Data

Example
Run mode is triggered when the value of Data A is equal to or greater than that of Data
B after Start is turned ON.

RUNStart

Data A
Data B

9.2.31 LE (Compare: <= )
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The NE instruction passes power if A is not equal to B.
The following table lists the combinations of A and B in which NE instructions can be
executed.

When power is passed to the timer starting bit (IN), the TON instruction starts, and:
• Variable.ET (the elapsed time) begins to increment in milliseconds.
• Variable.TI (the timing bit) turns ON.
• Variable.Q (the timer output bit) turns OFF.

A B
Integer Integer
Integer Constant Integer Constant
Real Real
Real Constant Real Constant

9.2.32 NE (Compare: <> )

A: Data
B: Data

Real values need to be compared very carefully. For example, a calculation might
result in 1.99999999999, which is not equal to 2.

Example
After Start is turned ON, Run mode is triggered when the values of Data A and Data B
are not equal.

Start

Data A
Data B

RUN

Example
Run mode is triggered when the value of Data A is equal to or smaller than that of Data
B after Start is turned ON.

RUNStart

Data A
Data B
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When the elapsed time (Variable.ET) increments and equals the preset time
(Variable.PT):
• Variable.ET (the elapsed time) holds the current value.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns ON, and the instruction passes power.

When the timer starting bit (IN) stops passing power to start the TON instruction:
• Variable.ET (the elapsed time) is reset to zero.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns OFF.

Enable_Drive Start_Drive
Charging_Condenser

A: When power is applied to the timer input bit (IN), the timing bit (TI) turns ON,
the timer begins timing, and the elapsed time (ET) increments. The timer output bit
(Q) remains OFF.

B: The elapsed time (ET) equals the preset time (PT), the timer output bit (Q) turns
ON, and the elapsed time (ET) stays fixed at the preset time. The timing bit (TI)
turns OFF.

C: The timer input bit (IN) turns OFF, the timer output bit (Q) turns OFF, and the
elapsed time (ET) is reset to 0.

D: The timer input bit (IN) turns ON, and the timing bit (TI) turns ON. The timer
begins timing, and the elapsed time (ET) increments.

Example
In the following example, the drive will be started 5 seconds after "Enable_Drive" is
turned ON.
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9.2.33 PID (PID Calculation)

SP: Setpoint
PV: Process Variable
TB: Tieback
CV: Control Variable

d(E)
dt

t
0

∫

The PID (Proportional Integral Derivative) instruction compares a measured value
(Process Variable), from the analog input or temperature input, with a preset value
(Setpoint). The PID then adjusts the Control Variable to eliminate the difference
between the Process Variable and the Setpoint.
When performing the PID control, the proportional (P), the integral (I), and the
derivative (D) controls can be combined freely. By setting each parameter (de-
scribed later in this section), these controls can be executed.
The control value calculated by the PID control can be expressed in the following
equation.

CV=KC(E+Reset        (E)dt+Rate         )

KC : Proportional Coefficient*1

E : Error Signal (SP-PV or PV-SP)
Reset : Integral Time*1

Rate : Derivative Time*1

*1 This is set in the “Tuning” tab, explained on the following page. This is not a control
block variable value.

By adjusting the sampling period in the Tune tab which is described later, the
effect of noise on the error signal can be reduced. The filtered error signal can be
expressed in the following equation.

EFn=EFn-1+           (En-EFn-1)

EF : Filtered Error Signal
Tloop : Data Refresh Period   (Loop update time)
TFilter : Sampling Time (DFTC)

               E : Error Signal (SP-PV or PV-SP)

TLoop

TFilter
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When using the PID instruction in a logic program, map variables to the control
block, SP, PV, TB, and CV variables.

Parameter and Variable Type

Overview
When the PID instruction passes power, it adjusts the PID output (Automatic
Mode). If the PID instruction is not passing power, a constant control amount is
output (Manual mode). In Manual mode, the Control Variable is set to the Tieback
value.

Parameter Description Variable Type

SP Setpoint Integer, Integer Constant, Integer
Array

PV Process variable Integer, Integer Array

TB

Tieback
When the instruction
doesn't receive power,
value set in this is
output.

Integer, Integer Constant, Integer
Array

CV Controlled variable Integer, Integer Array

Control Block Variable
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Control Block Variable
When a variable is mapped to the PID instruction, an array with seven elements
(see following table) is mapped to the variable. Element [0] represents the current
status, and Elements [1] to [6] are used for the PID control to make fine-tuning
adjustments.

Bit 0 Mode
ON Automatic Mode (PID Calculation)
OFF Manual Mode

PID Instruction Process Completion Flag (Bit 1)
When the calculation process is finished and the CV is output, bit 1 turns ON. Bit
1 stays ON during one scan.

The variable type of a control block variable will be retentive.

The values in the control block variable for the proportional coefficient,
the number of integral times per minute, and the derivative time per
cycle are 1000 times  the values  of proportional coefficient, integral
times, and derivative time set in the Tune tab.

Control Block Variable Element [0] Status
Mode Switch Flag (Bit 0)
When the PID instruction in a logic program passes power, bit 0 turns ON.
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������������������������������������
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�����������������������
�����������������������

�����������������������
�����������������������PID Instruction

Bit 1

CV Output
Time

Calculation
Process

Calculation
Process

Description
Bit 0 Mode Switch Flag
Bit 1 PID instruction process completion flag
Bit 2 PID deadband flag
Bit 3 Control variable exceeds upper limit
Bit 4 Control variable exceeds lower limit
Bit 5 Exceeded the number of integration process times

1 Proportional coefficient
2 Integration times per minute
3 Derivative time per cycle
4 PID deadband
5 Offset
6 Sampling time

Element Number

0



9–39LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 9 – Instructions

������������������������������������������������������������������������������������������������������������������������������
������������������������������������������������������������������������������������������������������������������������������
������������������������������������������������������������������������������������������������������������������������������

�����������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������
�����������������������������������������������������������������������������������������������������������������������������������������������

PID Deadband Flag (Bit 2)
When the control variable is within the range specified in the Tune tab of the [PID]
dialog box, or in Element [4] in the control block variable, bit 2 turns ON when the
process variable reaches the setpoint. Bit 2 turns OFF when the process variable is
outside the range.

Control Variable Exceeds the Upper Limit (Bit 3) or Lower Limit (Bit 4)
When there is an output at the upper limit specified in the [Tune] tab of the [PID]
dialog box, bit 3 turns ON. When there is an output at the lower limit, bit 4 turns
ON. Even if a  status bit is turned ON, PID calculation is performed and either the
upper limit value or lower limit value will be output.

Exceeding the Number of Integration Process Times (Bit 5)
When processing is performed for an integration frequency that is outside the
range assigned in the Tune tab of the [PID] dialog box, bit 5 turns ON. Even if this
status bit is turned ON, PID calculation is performed and the value is output at the
upper limit.

Setpoint

Bit 2

PID Process
Disabled Area

Time

Upper Limit Value

Lower Limit Value

Bit 3

Bit 4
Time

Output Range

Bit 4 does NOT turn ON until range is exceeded.

For details about the Tune tab in the [PID] dialog box, see the following  Fine-
Tuning Adjustments and Monitoring of PID Control section.

For details about the Setup tab in the [PID] dialog box, see the following  Fine-
Tuning Adjustments and Monitoring of PID Control section.

For details about the Setup tab in the [PID] dialog box, see the following  Fine-
Tuning Adjustments and Monitoring of PID Control section.
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Control Block Variable Elements [1]–[6] Status
Elements [1]-[6] perform fine-tuning adjustments of PID control.

For details, see the following  Fine-Tuning Adjustments and Moni-
toring of PID Control section.

Fine-Tuning Adjustments and Monitoring of PID Control
Clicking the instruction after setting up special variables and control block vari-
ables to the PID instruction displays the following [PID] dialog box. Fine-tuning
adjustments and monitoring of the PID control settings are available in this dialog
box.

There is no tuning feature to automatically adjust each parameter.

Monitor
While in Monitoring mode, use the Monitor feature to monitor the PID instruction
execution result.

Pro-Control Editor Operation Manual Chapter 4 Online Editing

Type of Chart Lines
The following table lists the types of lines and colors of each item monitored.

Types and colors of graph lines cannot be changed.

Item
Setpoint Black dotted line
Process Variable Black solid line
Control Variable Blue solid line

Types of Lines/Colors
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Setpoint
Sets the target value.

Tieback
When the PID instruction in the logic program does NOT pass power, the value
set here will be output.

Proportional Coefficient [KC]
The Control Variable’s output is based on the difference between the Process
Variable and the Setpoint.
When the proportional coefficient is decreased, the control amount for bringing
the Process Variable closer to the target value decreases, and overshoot is pre-
vented. However, this may increase the remaining difference.
When the proportional coefficient is increased, the control amount for bringing the
current value closer to the target value increases, and the length of time to reach
the target value will shorten. However, this may cause hunting.

Tune
Each value can be adjusted while monitoring. The values set here reflect the
special variables or control block variable elements [1] to [6].

Pro-Control Editor Operation Manual Chapter 4 Online Editing

When proportional
coefficient is large

When proportional
coefficient is small

Remaining
Difference

Time

Setpoint
Difference
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Number of Integration Times [Reset]
The control amount alone can never completely eliminate the difference, since the
control amount (control output) becomes too small when it gets close to the
Setpoint. Using integral control, that remaining difference can be eliminated.
This control method makes adjustments based on the accumulated difference, over
time, between the Process Variable and the Setpoint. If it reaches a certain level, it
affects the output to reduce the difference.
When the number of integration times is increased, the control amount to reduce
the difference increases. The length of time to reach the Setpoint will shorten.
However, this may cause overshoot and hunting.
When the number of integration times is decreased, the control amount to reduce
the difference decreases. Overshoot and hunting are eliminated. However, the
length of time to reach the Setpoint will be greater.

When using proportional control, when the Process Variable is smaller than the
Setpoint and the control amount reaches its maximum limit at 100%, if the Setpoint
and the Process Variable match (no difference), the control amount becomes 0%.

When the number of integration
times is increased

When the number of
integration times is
decreased

Time

Setpoint

* Control amount: output per unit time

Setpoint

OFF

Process Variable

ON
Control amount*

100%

0%
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Deadband
PID control is not performed in the deadband, and the minimum control variable
value is output, which provides smooth control without hunting.

Offset
Set offset value. Offset can reduce the remaining difference created by the propor-
tional control.

Derivative Time [Rate]
Proportional control or integral control that requires a certain time (time constant)
cannot respond quickly to a disturbance, and cannot return to the target value
quickly.
Derivative control monitors the difference against the disturbance, and when a
difference is large compared to the previous difference, a large amount of control
is given to provide a quick response.
When the derivative time is increased, recovery time from the disturbance is
shortened. However, this may cause overshoot and short cycle hunting.
When the derivative time is decreased, overshoot and hunting are eliminated.
However, the recovery time from the disturbance will be greater.

Setpoint

Time

PID Deadband

�������������������������������������������������������������������������������������������������������
�������������������������������������������������������������������������������������������������������

When derivative
time is decreased

When derivative
time is increased

Setpoint

Time

Setpoint

Offset Value

When Offset is set

When Offset is not set

Remaining difference

Time
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Reflect Tune tab setting to Control Block Variable
Each setting in the Tune tab is reflected in the parameter variables (SP and TB)
and the elements [1] to [6] of the control block variable.
The following tables compare the Tune tab and Parameter variables, and the Tune
tab and control block variable. 1000 times the values in the proportional coeffi-
cient, integral times, and derivative period are written in the control block vari-
able.

Sampling Time [DFTC]
Provides noise reduction of the connected device’s measured data acquired by the
Loop Update Time. Calculates a running average of the previous filtering result
and the currently acquired data.
Setting the sampling time allows for the measured data to contain unexpected
measurements. If the previously measured data is calculated as an average, the
effect of unexpected measurements on the output value will be minor.
Sampling Time should be set to a larger value than the Loop Update Time. Also,
setting the sampling value to “0” will disable the filter.
For loop update time information, refer to "Control" in the "Setup" tab.

Tune Tab Scale Factor
Setpoint x 1 SP Variable
Tieback x 1 TB Variable

Tune Tab Scale Factor

Proportional
Coefficient x 1000 Proportional

Coefficient
Control Block
Variable [1]

Integral number
of times x 1000 Integral number of

times per minute
Control Block
Variable [2]

Derivative
period x 1000 Derivative number of

times per operation
Control Block
Variable [3]

Deadband x 1 PID deadband Control Block
Variable [4]

Offset x 1 Offset Control Block
Variable [5]

Sampling time x 1 Sampling time Control Block
Variable [6]

Parameter Variables

Control Block Variable
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Chart
Process Variable (PV), Setpoint (SP), Control Variable (CV), Deadband, and Clamp
Limits can be monitored. The monitoring setup is available in the Chart tab.

Item
Setpoint Black dotted line
Process Variable Black solid line
Controlled Variable Blue solid line
Clamp Limits Red dotted line
Deadband

Types of Lines/Colors

Gray zone

Show
Chart types and lines of each item monitored are listed the following table.

Scale
Top: Set the upper limit of the chart
Bottom: Set the lower limit of the chart
Width: Set the width of the chart in seconds. Sampling time can be

changed in the Preference area of the Monitoring tab by clicking
Option in the Editor’s File menu.

Previous data cannot be monitored.

Types of lines/colors cannot be changed.
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Setup
You can preset the range (upper and lower limits) set to all parameters during the
programming mode.

Scaling
The Raw, Percent, and Engineering Units options set the conversion rate of PV
data values with values, such as monitoring, in the display area. Raw max and
Raw min values specify PV data values, and EU max and EU min values specify
values, such as monitoring, in the display area.
Raw: All Input/Output values to the connected device are shown in

raw form with a conversion rate of 0.
When Raw is selected, set the values of Raw max, Raw min, EU
max, and EU min as follows.
• Raw max=EU max
• Raw min=EU min

Percent: Values in percent are set in the display area.
When Percent is selected, set Raw max, Raw min, EU max, and
EU min as follows.
• Raw max and Raw min values = user-defined value by the

connected device
• EU max = 100
• EU min = 0

Engineering Units: Values of n mole fraction, defined by the user, are set in the
display area.
When Engineering Units is selected, set Raw max, Raw min, EU
max, and EU min as follows.
• Raw max and Raw min values = user defined value by the

connected device
• EU max = n
• EU min = 0

These settings are not available during the monitoring mode.
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Setpoint

Time

Setpoint

Time

Control
Loop Update Time: Set the time cycle to acquire data from the connected device.

The Loop Update Time becomes the output update time/
period.
Setting the Sampling Time allows you to use the Filter fea-
ture, however, the Sampling Time should be set to a lrger
value than the Loop Update Time.

Direct (SP-PV): Specify to perform control to increase the control amount
output when the Process Variable is smaller than the Setpoint
(such as heater).

Reverse(PV-SV): Specify to perform control to decrease the control amount
output when the Process Variable is greater than the Setpoint
(such as cooler).
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Control Amount

Time (Min.)

Loss Time (L)

t

Max. Temperature
Rise Rate (R)
R=Variation/t

Output Clamping
Sets the highest limit and the lowest limit of the Control Variable. When the
Control Variable is outside this range, the highest limit or the lowest limit is
output, and the status bit of Bit 3 or Bit 4 in Element [0] of the control block
variable turns ON.

For details, see • Control Variable Exceeds the Upper Limit (Bit 3)
or Lower Limit (Bit 4) in the  Control Block Variable section.

Anti-Reset Windup
Sets the highest and lowest limits of the Number of Integration Times per minute
of Element [2] of the control block variable.

How to Adjust the PID Constant
This section explains how to adjust the PID constant using temperature control as
an example. To obtain optimum PID control results, each constant of P (Propor-
tional Element), I (Integral Element), and D (Derivative Element) has to be set to
its optimum value. Step Response is one method of adjusting the PID constant
against various control targets, and is based on temperature characteristics.
The optimum value might not be obtained with the Step Response method, de-
pending on the control target used. In these cases, adjust the values in the Tune tab
of the [PID] dialog box.

Step Response
Step Response sets the Setpoint, and 100% of the control amount for the control target
is output in steps. The following example, based on the chart of temperature character-
istics, measures the maximum temperature slope (R) and the loss of time (L).

Variation

Time
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VariableIN: Timer starting bit
PT: Preset time of timer
Q: Time up flag
ET: Present value of timer

When the timer input bit (IN) receives power, the TON instruction adds the preset
time (PT), in milliseconds, and the timer output bit (Q) turns ON.
Overview

Special Variable Description Variable Type
Variable. PT Preset Value Integer
Variable. ET Present Value Integer
Variable. Q Timer Output Bit Discrete
Variable. TI Timing Bit Discrete

9.2.34 TON (Timer ON Delay)

When power is passed to the timer starting bit (IN), the TON instruction starts,
and:
• Variable.ET (the elapsed time) begins to increment in milliseconds.
• Variable.TI (the timing bit) turns ON.
• Variable.Q (the timer output bit) turns OFF.
When the elapsed time (Variable.ET) increments and equals the preset time
(Variable.PT):
• Variable.ET (the elapsed time) holds the current value.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns ON, and the instruction passes power.

When the timer starting bit (IN) stops passing power to start the TON instruction:
• Variable.ET (the elapsed time) is reset to zero.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns OFF.

You can calculate constants of the proportional coefficient, the number of integral
times, and the derivative time by substituting the measured values of the maxi-
mum temperature slope (R) and the loss time (L) in the following equation.
Please enter the calculated values in the Tune tab of the PID dialog box.
“Proportional Coefficient” = 100/(0.83*R*L) [%]
“Number of Integration Times” = 1/(2*L) [cycles/min.]
“Derivative Time” = 0.5*L [min.]
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Enable_Drive Start_Drive
Charging_Condenser

A: When power is applied to the timer input bit (IN), the timing bit (TI) turns ON, the
timer begins timing, and the elapsed time (ET) increments. The timer output bit (Q)
remains OFF.

B: The elapsed time (ET) equals the preset time (PT), the timer output bit (Q) turns
ON, and the elapsed time (ET) stays fixed at the preset time. The timing bit (TI)
turns OFF.

C: The timer input bit (IN) turns OFF, the timer output bit (Q) turns OFF, and the
elapsed time (ET) is reset to 0.

D: The timer input bit (IN) turns ON, and the timing bit (TI) turns ON. The timer begins
timing, and the elapsed time (ET) increments.

E: The timer input bit (IN) is turned OFF before the elapsed time (ET) equals preset
time (PT), the timer output bit (Q) remains OFF, the elapsed time (ET) is reset to 0.

Example
In the following example, the drive will be started 5 seconds after "Enable_Drive" is
turned ON.
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IN: Timer starting bit
PT: Preset time of timer
Q: Time up flag
ET: Present value of timer
When the timer input bit (IN) stops receiving power, the TOF instruction adds the
preset time (PT), in milliseconds, and the timer output bit (Q) turns OFF.

Overview

When power is passed to the timer starting bit (IN), the TOF instruction starts, and:
• Variable.ET (the elapsed time) is reset to zero.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns ON, and the instruction passes power.
When the timer starting bit (IN) stops passing power to start the TOF instruction:
• Variable.ET (the elapsed time) begins to increment, in milliseconds.
• Variable.TI (the timing bit) turns ON.
• Variable.Q (the timer output bit) remains ON.
When the elapsed time (Variable.ET) increments and equals the preset time
(Variable.PT):
• Variable.ET (the elapsed time) stays fixed at the preset value.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns OFF.

Variable

Special Variable Description Variable Type
Variable. PT Preset Value Integer
Variable. ET Present Value Integer
Variable. Q Timer output bit Discrete
Variable. TI Timing bit Discrete

9.2.35 TOF (Timer OFF Delay)
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Example
The following diagram is an example of high-voltage cabinet fans that are kept running
for 1 minute (60,000ms) after the high voltage turns OFF.

A: The timer input bit (IN) turns ON, the timing bit (TI) remains OFF, the timer
output bit (Q) turns ON, and the elapsed time (ET) is reset to 0.

B: The timer input bit (IN) turns OFF, the timer starts timing (TI turns ON), and the
timer output bit (Q) remains ON.

C: When the elapsed time (ET) equals the preset time (PT), the timer output bit (Q)
turns OFF, the timer stops timing (TI turns OFF), and the elapsed time stays fixed
at preset time (ET=PT).

D: The timer input bit (IN) turns ON, the timing bit (TI) remains OFF, the timer
output bit (Q) turns ON, and the elapsed time (ET) is reset to 0.

E: The timer input bit (IN) turns OFF, the timer starts timing (TI turns ON), and the
timer output bit (Q) remains ON.

F: Before the elapsed time (ET) equals the preset time (PT), the timer input bit (IN)
turns ON, and the timer stops timing (TI turns OFF). The timer output bit (Q)
remains ON, and the elapsed time (ET) is reset to 0.

High_Voltage_Cabinet_FansHigh_Voltage_Power_OFF

Power_Supply
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IN: Timer starting bit
PT: Preset time of timer
Q: Time up flag
ET: Present value of timer

When the timer input bit (IN) receives power one time, the TP instruction turns ON the
output bit (Q) for the duration of the preset time (PT), in milliseconds.

Overview

When power is passed to the timer starting bit (IN), the TP instruction starts, and:
• Variable.ET (the elapsed time) begins to increment in milliseconds.
• Variable.TI (the timing bit) turns ON.
• Variable.Q (the timer output bit) turns ON as the instruction passes power.
When the elapsed time (Variable.ET) equals the preset time (Variable.PT):
• Variable.ET (the elapsed time) stays fixed at the preset value if the TP instruction is

still receiving power.
• Variable.ET (the elapsed time) resets immediately to zero if the instruction stops

receiving power.
• Variable.TI (the timing bit) turns OFF.
• Variable.Q (the timer output bit) turns OFF.
When the timer starting bit (IN) stops passing power to start the TP instruction, the
elapsed time (Variable.ET) is reset to zero, and the timer output bit (Variable.Q) turns
OFF — only if it has already reached the value of the preset time (Variable.PT). Other-
wise, it continues timing, and the timer output bit (Variable.Q) remains ON.

Special Variable Description Variable Type
Variable. PT Preset Value Integer
Variable. ET Present Value Integer
Variable. Q Timer output bit Discrete
Variable. TI Timing bit Discrete

9.2.36 TP (Timer Pulse)
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Example
The following diagram is an example of a lamp that lights up for three seconds when the
switch is pressed.

Switch
Light_Up_3 _Seconds

Lamp

A: The timer input bit (IN) turns ON, the timer starts timing (TI turns ON), and the timer
output bit (Q) turns ON.

B: When the elapsed time (ET) equals the preset time (PT), the timer output bit (Q)
turns OFF, the timer stops timing (TI turns OFF), and the elapsed time stays fixed at
the preset time (ET=PT).

C: The timer input bit (IN) turns OFF, and the elapsed time (ET) is reset to 0.
D: The timer input bit (IN) turns ON, the timer starts timing (TI turns ON), and the timer

output bit (Q) turns ON.
E: The timer input bit (IN) turns OFF, the timer continues timing (TI remains ON), and

the timer output bit (Q) remains ON.
F: When the elapsed time (ET) equals the preset time (PT), the timer output bit (Q)

turns OFF, the timer stops timing (TI turns OFF), and since the timer input bit (IN) is
OFF, the elapsed time (ET) is reset to 0.
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CE: Counter starting bit
R: Counter reset bit
PV: Preset value of counter
Q: Counter output
CV: Present value of counter

 Overview

When the counter input bit (CE) passes power, the current value (Variable .CV) is
incremented by one if the counter reset bit (Variable.R) is OFF and the current value
(Variable .CV) is smaller than Preset value (Variable PV).
When the current value (Variable.CV) is equal to the preset value (Variable.PV), the
counter output bit (Variable.Q) is turned ON, and the instruction passes power.
When the counter reset bit (Variable.R) is ON, the current value (Variable.CV) is reset
to zero.
The counter output bit (Variable.Q) is also turned OFF.
Example
The following diagram is an example of the CTU instruction notifying the
Error_Detection output when five errors have been counted during a one-minute period.

Minute_Timer_Start OperationError_Counter_Reset

Operation_Error_Occur
Operation_Error_Counter

Error_Detection

The counter is reset every scan. To count an event like the ex-
ample above, be sure that the PT instruction is positioned before
the CTU instruction’s position. The CTU instruction is a level in-
put.

Special Variable Description Variable Type
Variable. PV Preset Value Integer
Variable. CV Current Value Integer
Variable. R Counter Reset Discrete
Variable. UP UP Counter Discrete
Variable. QU UP Counter Output Discrete
Variable. QD Down Counter Output Discrete
Variable. Q Counter Output Discrete

9.2.37 CTU (UP Counter)

Variable
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CE: Counter starting bit
R: Counter reset bit
PV: Preset value of counter
Q: Counter output
CV: Present value of counter

 Overview

When the counter input bit (CE) passes power, the current value (Variable .CV) is
decremented by one if the counter reset bit (Variable.R) is OFF.
When the current value (Variable.CV) becomes equal to or less than zero after
decrementing, the counter output bit (Variable.Q) is turned ON, and the instruction
passes power.
When the counter reset bit (Variable.R) is ON, the preset value (Variable.PV) is set to
the current value (Variable.CV).
The counter output bit (Variable.Q) is also turned OFF.
Example
The following diagram is an example of the CTD instruction passing power and notifying
the Error_Detection output when five errors have been counted during a one-minute
period. The timer resets the counter every minute.

Minute_Timer_Start OperationError_Counter_Reset

Operation_Error_Occur
Operation_Error_Counter

Error_Detection

The counter is reset every scan. To count an event like the ex-
ample above, be sure that the PT instruction is positioned before
the CTU instruction’s position. The CTD instruction is a level in-
put.

Special Variable Description Variable Type
Variable. PV Preset Value Integer
Variable. CV Current Value Integer
Variable. R Counter Reset Discrete
Variable. UP UP Counter Discrete
Variable. QU UP Counter Output Discrete
Variable. QD Down Counter Output Discrete
Variable. Q Counter Output Discrete

Variable

9.2.38 CTD (DOWN Counter)
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When executing the CTUD instruction while the counter up instruction Variable.UP is
ON, the execution is similar with the CTU instruction (up-counter).
When Variable.UP is OFF, the execution is similar with the CTD (down-counter)
instruction.
After executing the CTUD instruction:
• If the current value (Variable.CV) is equal to or greater than the preset value

(Variable.PV), the Counter Output and UP Counter Output (Variable.Q and
Variable.QU) are turned ON.

• If the current value (Variable.CV) is equal to or less than zero, the Counter
Output and Down Counter Output (Variable.Q and Variable.QD) are turned ON.

Example

The following diagram is an example of the CTUD instruction continuously counting up,
from 0 to 10, and then down from 10 to 0.
The SecondTimer outputs a pulse to the Up/Down Counter every second.
The UP bit turns ON when the Up/Down Counter reaches 0, and turns OFF when the
Up/Down counter reaches 10 (the preset value).

Special Variable Description Variable Type
Variable. PV Preset Value Integer
Variable. CV Current Value Integer
Variable. R Counter Reset Discrete
Variable. UP UP Counter Discrete
Variable. QU UP Counter Output Discrete
Variable. QD Down Counter Output Discrete
Variable. Q Counter Output Discrete

VariableCE: Counter starting bit
UP: Counter Up Instruction
R: Counter reset bit
PV: Preset value of counter
Q: Counter output
QU: UP Counter flag
QD: Down Counter flag
CV: Present value of counter

 Overview

9.2.39 CTUD (UP/DOWN Counter)
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When the BCD instruction is executed, a binary number assigned to A is converted to
binary-coded decimal format, and the result is placed in B.
The BCD instruction does not pass power if an error occurs. The following table lists
the combinations of A and B in which BCD instructions can be executed.

The largest value of A that can be converted is 0 x 5F5E0FF. If A is too large,
#FaultCode is updated with the error code, and #Overflow is turned ON.

 8.2.15  #Faultcode and 8.2.18  #Overflow

If the value cannot be converted, the value in B is undefined.

A B
Integer
Integer Constant

Integer

A: Data
B: Result to be stored

9.2.40 BCD (BCD Conversion)

If the counter reset bit (Variable.R) turns ON when the Counter Up
instruction (Variable.UP) is ON, the current value (Variable.CV) is
set to zero. If the counter reset bit (Variable.R) turns ON when the
Counter Up  instruction (Variable.UP) is OFF, the preset value
(Variable.PV) is entered to the current value (Variable.CV).

UpDown.QD

UpDown.QU

SecondTimer.Q
SecondTimer.Q UpDown

UpDown.UP

UpDown.UP
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Start

Data A Data B

Example) BIN data "99999999" is designated for data A, and BCD conversion is
performed.

Bit Position
 Data A

Bit Position
 Data B

Example
When Start is turned ON, Data A is converted to BCD and stored in Data B.

A: Data
B: Result to be stored

When the BIN instruction is executed, a binary coded decimal number assigned to A is
converted to binary format, and the result is placed in B.
The BIN instruction does not pass power if an error occurs. The following table lists the
combinations of A and B in which BIN instructions can be executed.

If A is not a valid BCD number, #FaultCode will be updated with the error code, and
#Overflow will turn ON.

 8.2.15  #Faultcode and 8.2.18  #Overflow

If the value cannot be converted, the value in B is undefined.

A B
Integer
Integer Constant

Integer

9.2.41 BIN (Binary Conversion)
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9.2.42 ENCO (Encode)

A B
Integer Integer
Integer Array Integer Array (same size as A)
Integer Constant Integer

E.g.: If 0x00000008 is entered in A, the output B is 0x00000003.

• If 0 is entered in Input A, the error code “13” is set to
#FaultCode as a minor error (#OverFlow).

8.2.19  #Overflow

• The ENCO instruction does not support variable modifiers (as-
signed bit, word, or byte).

Bit Position
A

Bit Position
B

A: Data
B: Result to be stored

The value entered in A is encoded and output to B. The ENCO instruction reads the 32
bits in A for the bit position that is ON, and this position is output to B as a binary value.
If several bits in A are ON, the most significant bit position is output to B.
The ENCO instruction always passes power.
The combinations of valid variable data types for the ENCO instruction are as follows:

Start

Data A Data B

Example) BIN data "99999999" is designated for data A, and BCD conversion is
performed.

Bit Position
 Data A

Bit Position
 Data B

Example
When Start is turned ON, Data A is converted to BIN and stored in Data B.
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9.2.43 DECO (Decode)

A: Data
B: Result to be stored

The value entered in A is decoded and output to B. The DECO instruction reads A as a
binary value, and the corresponding bit position in B is up. 0 to 31 are available for
input.
The DECO instruction always passes power.
The combinations of valid variable data types for the DECO instruction are as follows:

• If a value other than 0 to 31 is entered in Input A, the error code
“13” is set to #FaultCode as a minor error (#OverFlow).

8.2.19  #Overflow

• The DECO instruction does not support variable modifiers (as-
signed bit, word, or byte).

E.g.: If 0x00000003 is entered in A, the output B is 0x00000008.
Bit Position

A

Bit Position
B

A B
Integer Integer
Integer Array Integer Array (same size as A)
Integer Constant Integer
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When the JMP instruction receives power, control jumps to the specified label. Unlike
the JSR instruction, control does not automatically return to the rung following the JMP
rung.
A jump cannot be made over a START, SUB START , SUB END, ACT START or
ACT END label.
Jumping upward can create an infinite loop.

9.2.44 JMP (Jump)

Be sure that the time required to execute the entire program will
not exceed the value of the Watch Dog Timer.

8.2.26  #WatchDogTime
Example
If the Jump Instruction is ON, rung 3’s instruction will be skipped and not executed.
Control will jump to rung 4 with the label "Operation Disabled", and instructions below
rung 4 will be executed.

JMP

Start

Operation Disabled

Operation

Operation Disabled
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When the JSR instruction receives power, the control jumps to the specified subroutine.
After the subroutine executes, control returns to the rung that follows the JSR instruction
and continues to execute that rung’s instruction. A subroutine name can not be dupli-
cated.
JSR must be the last instruction on a rung.

Restrictions
A maximum of 128 subroutine jumps from a subroutine can be executed.

Be sure that the time required to execute the entire program will
not exceed the value of the Watch Dog Timer.

 8.2.26  #WatchDogTime

9.2.45 JSR (Jump Subroutine)

9.2.46 RET (Return Subroutine)

When the RET instruction receives power, control is forced from a subroutine and is
returned to its original location . Execution continues from the rung that follows the Jump
Subroutine (JSR) instruction.
When a subroutine is completed, the SUB END instruction forces the program to
automatically return to the jump point. As a result, the RET instruction is not always
needed to perform this function.
The RET instruction must be the last instruction on a rung.
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The FOR/NEXT instruction repeats the logic program between corresponding FOR
and NEXT instructions, for the number of times specified in A. After executing the logic
program between FOR and NEXT the specified number of times (A), the step that
follows the NEXT instruction will be processed.
If A is equal to or less than 0, the logic program between FOR and NEXT is not
executed, but jumps to the step that follows the NEXT instruction.
The FOR/NEXT instruction always passes power.
Valid variable data types for the FOR/NEXT instruction are as follows:

A
Integer
Integer Array
Integer Constant

Restrictions
• Each FOR instruction requires a NEXT instruction.
• Do not insert instructions before or after FOR and NEXT instructions on the same rung.
• Up to 64 nests can be included in each instruction.

If the instruction exceeds more than 64 nests, a major error occurs and error code
“4” is displayed in #FaultCode. 

• Two (2) stacks are used for one nesting. The total number of stacks that can be used
in a logic program is 128. The only other instruction that uses stacks is the JSR
instruction, which uses one (1) stack.

9.2.44  JSR (Jump Subroutine)

• For information about the errors or warnings displayed by the
Editor’s error check, refer to the Pro-Control Editor Operation
Manual, Chapter 7, Appendix 1 – “Errors and Warnings.”

8.2.16  #FaultCode
• When specifying the number of nests, the time required for the

program’s entire execution must NOT exceed the value of Watch-
dog Timer.

8.2.27  #WatchdogTime

9.2.47 FOR/NEXT (Repeat)
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10 LS Area Refresh

LS Area Refresh Feature
The LT unit uses the LS Area’s System Data Area to control the changing of screens,
the sounding of buzzers, etc. These are processed as LT display features.
Therefore, when using the functions assigned to the System Data Area such as the
screen change and clock function via the Controller Feature, the data in the LS Area
should be shared between the Display Features and Controller Features through regis-
tering the LS Area as variables.
This is defined as the LS Area Refresh.
It is also possible to use an area outside of the System Data Area if the LT controller
features or display features need to share data.

10.1 LS Area Refresh Overview

LS Area Variable Area

Display Features Controller Features

CONTROLLER
MEMORY (For User

defined variables,
etc.)

User Area

D
I
S
P
L
A
Y
/
T
O
U
C
H

L
O
G
I
C
 
P
R
O
G
R
A
M

LS Area
Refresh

System Data Area

Other Shared Area

Special Relays

System Data Area

Other Shared Area

Special Relays

The LS area refresh timing and the Logic Symbol update timing are not synchronized.
Therefore be sure to use an interlock when programming a refresh for either of these in
your ladder logic program.
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10.2 LS Area Refresh Settings

Variable Registration
In LT Editor’s Data menu, click Variable Type to open the Variable Type dialog box.
This section describes how to register a variable with a variable name "LS" as an internal
integer array.
The size should be calculated by adding the number of words of data to be shared to
the System Area's 20 words. (Example: When sharing 16 words of data with the
System Data Area, enter "36" words, i.e., 20 words for the System Data Area plus 16
words.)

When using the logic program to designate the LS Area, the desired variable must first
be registered in LT Editor. This section describes this procedure.

For details about the LT Type C unit, refer to the Device/PLC  Con-
nection Manual (provided with the LT Editor).

• The Special Relay Area is called the LSS area.

• The maximum LS size is 276 words.

The relationship between variables and addresses are listed in the following table.

1. Variable Name: System Variables managed by the LT's ladder logic program

Variable Name*1 Address LS Address
LS[0] 0 LS0000
LS[1] 1 LS0001 System Data Area

: : :
LS[19] 19 LS0019

: : :
LS[275] 275 LS0275 Other Shared Data

LSS[0] 2032 LS2032
LSS[1] 2033 LS2033 Special Relays

: : :
LSS[15] 2047 LS2047
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10.2.1 LS Area - When not using a Device/PLC

  System Data Area
You can use controller features in your logic program to update this area and control the
"LT Screen Change" and "Backlight ON/OFF".

Address Var. *1

Name
Detail Function Bit Particulars

1 LS[1] Status 0, 1 Reserved
2 Now Printing
3 Writes a set value

4 to 9 Reserved
10 Backlight Burnout Detection

11 to 15 Reserved
2 LS[2] 0, 1 Unused

2 System ROM/RAM
3 Screen Memory Checksum
4 SIO Framing
5 SIO Parity
6 SIO Overrun

3 LS[3] 7, 8 Unused

9
Initialization of Internal Memory Checksum
Necessary

10 Timer Lock Error
11 to 15 Unused

4 LS[4] Clock Data 0 to 7 Stores the last 2 digits of the Calendar year
(Year) 8 to 15 Unused

5 LS[5] Clock Data 0 to 7 Stores 01 to 12 (Month) as 2 BCD digits
(Month) 8 to 15 Unused

6 LS[6] Clock Data 0 to 7 Stores 00 to 31 (Day) as 2 BCD digits
(Day) 8 to 15 Unused

7 LS[7] Clock Data 0 to 7 Stores 00 to 23 (Hour) as 2 BCD digits
(Hour) 8 to 15 Unused

8 LS[8] Clock Data 0 to 7 Stores 00 to 59 (Minute) as 2 BCD digits
(Minute) 8 to 15 Unused

10 LS[10] Interrupt Output
(Touch OFF)

Error Status

Each bit changes according to the
GP error function. When an error
occurs, the corresponding bit will
turn on.

A bit that has turned ON remains
ON until the power is turned OFF
and back ON, or until RUN mode
is re-entered from OFFLINE mode.

"Year / Month /
Day / Hour /
Minute " Data is
stored in BCD's
2digits.
(E.g.)
98/02/01  17:15

If you use a Switch Part to write in word data, the bottom 8 bits will be
output as an interrupt code after Touch OFF. FFh will not be output.

Do NOT use any areas designated as Reserved.

This area can be accessed by registering LT Editor's internal "[LS]" inte-
ger array variables.

*1   Variable names used when accessing the LT.
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LS
Address

Var. *1

Name
Detail Function Bit Particulars

11 LS[11] Control 0 Backlight
1 Buzzer ON
2 Starts Printing
3 Reserved
4 Buzzer  - - -  0:enabled   1: disabled
5 Reserved

6
Interrupt Output when touching panel to turn
the display ON. (Interrupt Code:FFh)  0:
Disabled    1: Enabled

7 to 10 Reserved
11 Hard copy output - 0: Enabled  1: Disabled

12 to 15 Reserved
12 LS[12] Screen Display FFFFh : Screen clears almost immediately

ON/OFF 0h: Screen turns ON
13 LS[13]

15 LS[15] 0 to 14

15
Forced Screen Change
0: Normal   1: Forced Screen Change

16 LS[16]
17 LS[17]   Reserved
18 LS[18]
19 LS[19]

Interrupt Output Using a Switch Part or other method to write absolute value data from
LT causes an output of the interrupt code using the contents of the
bottom 8 bits ( Will not output  FFh)

Screen Display
No.

Write the Screen
No. in binary to
change the
screen display

Screen change number, 1 to 8999.
( 1 to 1999 when using BCD input)

*1   Variable names used when accessing the LT.
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  Special Relay

*1   Variable names used when accessing the LT.

This area can be accessed by registering LT Editor's internal "[LSS]" in-
teger array.

LS
Address Var. Name *1 Contents

2032 LSS [0] Share Relay Data
2033 LSS [1]
2034 LSS [2]
2035 LSS [3] Binary Counter - 1 second
2036 LSS [4] Part Scan T ime
2037 LSS [5] Reserved
2038 LSS [6] Part Scan Counter
2039 LSS [7]
2040 LSS [8]
2041 LSS [9]
2042 LSS [10]
2043 LSS [11] Reserved
2044 LSS [12]
2045 LSS [13]
2046 LSS [14]
2047 LSS [15]

Reserved
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When using controller features to communicate with a Device/PLC, data is shared via
the LS Area. However, if data sharing between the controller functions and the Device/
PLC's data register exceeds 16 words, the performance of screen display functions may
slow.

10.3 LT and Device/PLC Data Sharing

1. Start Address defined in Initial Settings.
2. n = 0 to 20  Depends on the System Data Area setting items selected in Initial

Settings .
3. m = 0 to 16 Depends on size of Read Area designated in Initial Settings.

Controller
Device/

PLC

LS[0]
System Data

Area LS0000
System Data

Area
Top
Address*1

System Data
Area

LS[19] LS0019    nWord*2

LS[20] Read Area LS0020 Read Area
Read Area

LS[35] LS0035 (Data)     mWord*3

LS[275] LS0275

LSS[0] LS2032
Special Relay Special Relay

LSS[15] LS2047

Display processing
function

Share Area Share Area

SIO Data Transfer
provides data sharing

LS Area refresh provides
data sharing
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Read Area

Controller
Function

Display
Processing

Function
Device/

PLC
System Data

Area
System Data

Area
System Data

Area 20 Words

16 Words

256 Words

If you want set the Read Area and Variable LS to exceed 16 words, the Read Area can
be set up to 256 words, and Variable LS can be set up to 276 words. A maximum of
16 words is recommended when setting data that is shared between the controller,
display processing function and Device/PLC.
E.g.: When the Variable LS size is set to 36 words and the Read Area is set to 256

words.

E.g.: When the Variable LS size is set to 276 words and the Read Area is set to 16
words.

• When the controller’s logic program, tags used to update the Display
Processing feature and the logic program from an external I/O unit
attempt to change the same variable at same time, priority is deter-
mined by the timing.

• When writing data to the LT unit's Read Area, be sure that the Write
Via Parts and Write Via Logic Program functions of the Controller do
not conflict.

Controller
Function

Display
Processing

Function
Device/

PLC
System Data

Area
System Data

Area
System Data

Area

Read Area

20 Words

16 Words

256 Words
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Use the LS Area Refresh feature to control the system area using the controller feature
or to view Read Data from a Device/PLC. Pro-face recommends that you use the data
send/receive related Initialize area or the Operation Designation Change parameter
settings to control the refreshing of data in this area, rather than refreshing the data in
addresses LS000 to LS0035 and LS2032 to LS2047 intermittently via the controller
feature.
If the frequency of the LS Area’s data refresh is increased, the LS Area Refresh may
not be executed within one scan. As a result, Device/PLC communication errors may
occur.
Variable LS is an integer variable, and the length is 32 bits.
When the System Data Area is 16 bits long, the low 16 bits are enabled.

10.3.1 LT Type C and Device/PLC LS Area Refresh Cautions

Utilizing the Read Area to share data between the LT and Device/PLCs
allows you to use the LT as the expansion unit of an external device as
well as for construction of POP machines for factory automation or an
I/O information terminal for production control.

Writes LT Data

Reads Controller Data

LT

External
Device

I/O Unit
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When an I/O error occurs, #IOFault will turn ON. Detailed informa-
tion can be checked by #IOStatus.

8.2.17  #IOFault and 8.2.19  #Command

When an I/O error occurs and the controller stops, create the fol-
lowing logic program. There will be a delay of approximately one
scan, from the time the error is detected until the time the logic
program stops.

In the following example, an I/O error is detected with #IOFault,
and logic execution is stopped by assigning 1 to #Command.

To perform external I/O, the LT unit’s I/O unit must be attached and its related I/O
drivers must be installed.

11 I/O Drivers

11.1 I/O Driver Overview

This chapter explains I/O drivers related to the LT unit’s I/O unit.
When using an LT Type-H unit, refer to the LT Type-H Driver Manual.
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The following diagram describes the action of the LT and I/O signal when
the RUN mode of a ladder logic program is reset or shifted to OFFLINE
mode. All I/O unit output hold settings will be ignored. Be sure you un-
derstand these actions before performing a reset or shifting to OFFLINE
mode.

• The RESET mode's I/O signal OFF timing is NOT fixed.

This section describes how to operate the self-diagnostics of the Flex Network I/F unit.
For details on the self-diagnostics of the LT main unit, refer to the
LT Series User Manual (sold separately).

Select [FLEX NETWORK DRIVER] in the [CONTROLLER MENU]. The following
window will then appear.
<To select communication check>

This section describes the Flex Network driver menus in the LT unit’s OFFLINE mode.
Prior to executing any Flex Network Driver menu instructions, be sure to download the
Flex Network driver from LT Editor software in your PC. The Flex Network Driver is
used with the LT Type-B, Type-B+, and Type-C.

For the procedures on shifting to OFFLINE mode, refer to the
LT Series User Manual (sold separately).

11.2.1 Flex Network I/F Unit Self-Diagnosis

11.2 Flex Network I/F Driver

LT Condition RUN OFFLINE RUN

I/O Signal
ON

Output from Logic 
Program

OFF Output from Logic 
Program

OFF

�
�
�

��
��
��
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2. Press the NEXT button, and the COMMUNICATION CHECK window will
appear.
Press START to begin the communication check.
The currently connected I/O unit's S-No. will be displayed in reverse color.

To return to the FLEX NETWORK MENU window, press the RET button.

11.2.2 Communication Check

The number of the Flex Network I/O units that have been connected to the Flex Net-
work I/F units, as well as the S-No.S that have been connected to each I/O unit, will be
checked.
Via the communication check operation, the following items can be checked:
• currently connected I/O units
• currently malfunctioning I/O units (connection section)

Communication Check Procedure
1. Press the COMMUNICATION CHECK button, and the COMMUNICATION

CHECK SETUP window will appear.
Set Communication Speed to either 6 or 12. Setting the communication speed faster
may cause the unit to be easily influenced by noise. Generally, set this speed to
6Mbps.
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11.2.4 I/O Monitor (I/O Connection Check)

Check each Input and Output terminal between the LT and I/O unit. To check inputs,
monitor the I/O unit of output signals on the LT. To check outputs, monitor the LT unit’s
output signals on the I/O unit.

I/O Monitor Check Procedure
1. Select the CONTROLLER MENU window's FLEX NETWORK DRIVER, and

the FLEX NETWORK DRIVER MENU will appear.
2. Select the FLEX NETWORK DRIVER MENU window's I/O MONITOR, and the

following I/O MONITOR SETUP window will appear.

11.2.3 Error S-No.

If the Error Code No. 841 occurs while a logic program is being executed, the S-Nos.
of the I/O units that have been excluded from the communication circuit and malfunc-
tioning I/O units will be checked.

11.3.3  Flex Network I/F Unit Troubleshooting

Error S-No. Procedure
1. Touch the CONTROLLER MENU window’s FLEX NETWORK DRIVER selec-

tion.
The FLEX NETWORK DRIVER MENU will appear.

2. Press the FLEX NETWORK DRIVER MENU's ERROR S-NO. DISPLAY.
The ERROR S-NO. DISPLAY window will appear, and the error check will begin.
The currently connected I/O unit's S-Nos. will appear, and the I/O unit S-No. with
the error will be shown in reverse color.



11–5LT Editor Ver. 2.0 Operation Manual – Logic Programming Guide

Chapter 11 – I/O Drivers

TRANSFER SPEED
Set TRANSFER SPEED to either 6 or 12 Mbps. Setting a faster transfer speed
may result in interference caused by noise. Normally, set this speed to 6Mbps.

S-No. (Station no.)
Select S-No. from 1 to 63.

MODEL CODE
Select one of the following models: X16TS, Y08RL, Y16SK, Y16SC, XY08TS,
AD04AH, and DA04AH.
The FN-X32TS, FN-XY16SK, FN-XY16SC, FN-XY32SK, and FN-
XY32SC models are not included in the selection. Therefore, select a substitute
model, from the table below, that can check the I/O monitor’s connection.

Monitoring the FN-X32TS
Use X16TS as a substitute.
Lower 16 bits (0-15 bits) can be monitored by  assigning the station number
set in the I/O unit to the S-No.
Upper 16 bits (16-31 bits) can be monitored by assigning values created by
adding 1 to the station number set in the I/O unit to the S-No.

Monitoring the FN-XY16SK or the FN-XY16SC
Use X16TS as a substitute for input, and Y16SK or Y16SC as a substitute
for output.
Input and Output cannot be monitored simultaneously.

FN-X32TS FN-XY32SKS*1

FN-XY32SCS*1

X16TS X16TS
Y16SK or 

Y16SC XY08TS

Input 0-15 0-15 – 0-7
Output – – 0-15 0-7
Input 16-31 – – 8-15

Output – – – 8-15
Input – – – 16-23

Output – – – 16-23
Input – – – 24-31

Output – – – 24-31

Models Performing I/O 
Monitoring

FN-XY16SK
FN-XY16SC

S-No. 

Substitute Models Performing 
I/O Monitoring

+0

+1

+2

+3
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Monitoring the FN-XY32SK, FN-XY32SC
Use XY08TS as a substitute.
Input and output of bits 0–7 can be monitored by assigning the station number
set in the I/O unit to the S-No.
Input and output of bits 8–15 can be monitored by assigning the values by
adding 1 to the station number set in the I/O unit to the S-No.
Input and output of bits 16–23 can be monitored by assigning to the S-No. the
values created by adding 2 to the station number set in the I/O unit.
Input and output of bits 24–31 can be monitored by assigning to the S-No. the
values created by adding 3 to the station number set in the I/O unit.

VARIABLE TYPE
Select either DISCRETE or WORD.
* Only the Word setting can be used for FN-AD04AH and FN-DA04AH.

3. Press the NEXT button, and the following I/O MONITOR window will appear.
This window’s items will vary depending on the VARIABLE TYPE selected.

Refer to the information for the corresponding I/O unit model(s).

This I/O monitor cannot be used with the high-speed counter and
single-axis positioning unit.

The above windows  display the maximum input/output points of an I/O unit in
the Flex Network system. The number of input/output points depends on each
I/O unit model. Use the range of  I/O points within each unit, beginning with “0.”
When using an input-only I/O unit, use only the input area of the window, and
when using an output-only I/O unit, use only the output area. When using a unit
with inputs and outputs, use both the input and output areas.

FN-X16TS/FN-XY08TS/FN-Y08RL/FN-Y16SK/FN-Y16SC/FN-
XY16SK/FN-XY16SC/FN-X32TS/FN-XY32SK/FN-XY32SC

I/O MONITOR (when VARIABLE TYPE is set to DISCRETE)
The INPUT area terminal numbers where data has been entered will appear in
reverse color. Touching an Output area terminal number will output the data
and reverse that number’s color.
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For FN-AD04AH/FN-DA04AH

I/O MONITOR (Channel Setting)
The system switches successively through the selectable settings when the
channel area is pressed.

When the NEXT button is pressed, the system switches to the next I/O
MONITOR screen. The screen is different for FN-AD04AH and FN-
DA04AH.

• Enter data within the output range, according to the number of the I/O
points in each I/O unit.

• Data will be output to the I/O unit for the number of I/O points accord-
ing to the MODEL selected on the I/O MONITOR SETUP window.

• If data that cannot be expressed in the 8-bit system is entered in an
8-point output I/O unit, excess data will be ignored.

I/O Points I/O Range
8 0 to 255
16 0 to 65535

15 0
I/O Monitor 0 0 0 0 0 0 1 1 0 0 0 0 0 1 0 Entering "386"

1 0 0 0 0 0 1 0 Outputs "130"
8-point 

Output Unit

I/O MONITOR (when the VARIABLE TYPE is set to WORD)
The input data, if any, will be displayed in the input field. Enter the necessary
data in the output section via the ten-key keypad. After entering data, touch
the OUT key to output the data. Data will be displayed in the decimal format.
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For FN-AD04AH

I/O MONITOR
This displays input data.

Pressing the [RET(URN)] button returns control to the [I/O MONITOR] screen.

A/D Conversion Table

• The filter type, A/D conversion sampling counts and maximum/mini-
mum elimination settings will operate under the settings saved in the
I/O unit. To change the settings saved in the I/O unit, change the set-
tings via the LT Editor first, then download the ladder logic program to
the LT. The changed settings will become effective when the ladder
logic program is set to "RUN" mode.

• The setting for the Range Selector switch is loaded into the unit only
upon power-up of the I/O unit. When changing the setting for the Range
Selector switch, make sure to turn off the power to the I/O unit and
then turn on the power again.

• The settings of the range changeover switch in the I/O unit side are
read in when the logic program is switched to RUN mode. To change
the settings of the range changeover switch, switch the logic program
to STOP mode and then to RUN mode. If the ranges do not match, the
data cannot be read correctly.

Input Range Setting Input Range
0 ~ 5V 0 ~ 4095
1 ~ 5V 0 ~ 4095
0 ~ 10V 0 ~ 4095
-5 ~ 5V -2048 ~ 2047
-10 ~ 10V -2048 ~ 2047
0 ~ 20mA 0 ~ 4095
4 ~ 20mA 0 ~ 4095
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For FN-DA04AH

I/O MONITOR
Enter data with the keypad. With the LT unit, touching the screen’s data display will call
up the keypad. After entering all data, push the [OUT] button to output the data. All
data is displayed in decimal format.

• Touch the up and down arrow to increase/decrease the range value.
Each time the value is changed, the new value is output to the I/O unit.

• Pressing the [RET(URN)] button will clear the current data, even if the
output hold setting in the I/O unit is ON.

D/A Conversion Table

• The setting for the Range Selector switch is loaded into the unit only
when the I/O unit’s power is turned on. When changing the Range
Selector switch’s setting, make sure to turn the I/O unit’s power off
and then on.

• The I/O unit’s range changeover switch settings are read in when the
logic program is switched to RUN mode. To change these settings,
switch the logic program to STOP mode and then to RUN mode. If the
ranges do not match, the data cannot be read correctly.

Input Range Setting Input Range
0 ~ 5V 0 ~ 4095
1 ~ 5V 0 ~ 4095
0 ~ 10V 0 ~ 4095
-5 ~ 5V -2048 ~ 2047
-10 ~ 10V -2048 ~ 2047
0 ~ 20mA 0 ~ 4095
4 ~ 20mA 0 ~ 4095
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Error Code Problem Solution

501 Internal variable error mapped to I/O 
terminal.

502 External variable error mapped to I/O 
terminal.

503 Output variable error mapped to I/O 
terminal.

504 Discrete variable error mapped to 
analog terminal.

505 Integer variable error mapped to 
discrete terminal.

506 Variable type not supported by driver. Correct the variable type.
507 Variable is not mapped to terminal. Map the variable to all terminals.

801 Terminal numbers are duplicated.
The LTE file may be damaged or a 
malfunction has occured during downloading 
of the lte file.

802 Multiple S-No. exist.
Two or more areas are using the same area 
number, possibly causing transfer failure. 
Download the project file again.

803 S-No. is outside of accepted range.
The LTE file may be damaged or a 
malfunction has occured during downloading 
of the lte file.

804 S-No. range overlap at the analog unit.
Two or more I/O units are using the same S-
No. The analog unit uses S-Nos. for four 
stations. Reset so there is no S-No. overlap.

805 S-No. range overlap with high-speed 
counter unit.

Two or more I/O units are using the same S-
No. The high-speed counter unit has S-Nos. 
for eight stations. Reset so there is no S-No. 
overlap.

806 S-No. range overlap with single-axis 
positioning unit.

Two or more I/O units are using the same S-
No. The positioning unit usesS-Nos. for four 
stations. Reset so there is no S-No. overlap.

Reset the variable used.

The following is a description of possible problems that may occur when using the Flex
Network I/F unit, and their solutions.

Flex Network I/F unit I/O Errors
For a detailed explanation of Flex Network I/F unit I/O errors, refer
to the appropriate Flex Network Unit Users Manual.

Error Codes
I/O errors include those occurring during writing and reading. When one of these errors
occurs, the controller writes an error code to #IOStatus.

Setting Errors

11.2.5 Flex Network I/F Unit Troubleshooting
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Error Code Contents Solution

859

Driver Error.
A major system error has occurred.

Reset the LT. If an error code still appears, try to 
identify if the error is due to the LT itself, or to a 
related/connected device.
                                 Write down the error code 
and refer to the LT User Manual.
Contact your local Pro-face distributor.

850

…

Error Code Problem Solution

821 There is no Flex Network I/F unit 
attached.

The ID Number loaded from the LT unit's 
built-in Flex Network I/F is invalid. The Flex 
Network I/F unit may be broken. Write 
down the error code and contact your local 
Pro-face distributor.

822
Initialization Error. Initialization failed to 
synchronize the Flex Network I/F unit 
and the Flex Network driver. 

The Flex Network I/F unit may be broken. 
Write down the error code and contact your 
local Pro-face distributor.

823 Analog unit setting error
There may be a break in the 
communication cable, the I/O unit is not 
turned on, or the I/O unit may be broken. 

Error Code Problem Solution

841 There is an I/O unit error (loose 
connector, malfunction, etc.)

Check all related wiring.
                                 Refer to the Flex 
Network User Manual  (sold separately).

842
Disconnected output signal line of 
analog unit input sensor (A/D 
conversion unit)

This is likely due to disconnection in the 
output signal line. Check the sensor's output 
signal line.

843 Error in the high-speed counter unit

The High-Speed Counter unit detected an 
error. 
                                 Refer to the Flex 
Network High-Speed Counter User 
Manual (sold separately).

844 Initialization error in the high-speed 
counter unit

Check to see if the communication line is 
disconnected, power is not supplied to the 
I/O unit, or the I/O unit is malfunctioning.

845 Communication error with the high-
speed counter unit

Check to see if the communication line is 
disconnected, power is not supplied to the 
I/O unit, or the I/O unit is malfunctioning.

846 Error in the single-axis positioning unit

The positioning unit detected an error. 
                                 Refer to the Flex 
Network Single-Axis Positioning Unit 
User Manual (sold separately).

847 Communication error with the single-
axis positioning unit.

Check to see if communication line is 
disconnected, power is not supplied to the 
I/O unit, or the I/O unit is malfunctioning.

Initialization Errors

Runtime Errors

Internal Errors
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Touch either the [Set] or [Start] key to start the self-diagnosis.
This check sends an output signal from the output unit to the input unit. Therefore, prior
to performing this check, be sure to attach the DIN/DOUT loopback cable.

When switching to the OFFLINE mode or when resetting from
the logic program’s RUN state, the I/O signal may turn OFF. Be
aware of the possibility that the I/O signal will turn OFF.

Touch the DIN/DOUT key to open the following screen.

This section explains how to use the DIO unit’s Self-Diagnosis feature.
For detailed information, refer to the LT Series User Manual (sold
separately).

Touch the OFFLINE screen’s Controller Menu to open the DIO Menu area.

<When DIO Driver has been Selected>

11.3 DIO Driver
This section explains the LT OFFLINE mode’s DIO menu. The DIO driver should be
downloaded from the LT Editor, before executing the DIO menu. The DIO driver is
used with the LT Type A.

For instructions on how to move to the OFFLINE mode screen, refer
to the LT Series User Manual (sold separately).

11.3.1 DIO Unit Self-Diagnosis
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LT Condition RUN OFFLINE RUN

I/O Signal
ON

OFF

Output from Logic 
Program

OFF Output from Logic 
Program

��
��
��
��

��
��
��
��

The RESET mode's I/O signal OFF timing is NOT fixed.

COM
24V

COM
24V
NC
NC
NC
NC

DOUT15
DIN15

DOUT14
DIN14

DOUT1
DIN1

DOUT0
DIN0

+   
DC24V

toto to

Use the following diagram when creating the DIN/DOUT loopback cable.

A1
B1
A2
B2
A3
B3
A4
B4
A5
B5
A6
B6

A19
B19
A20
B20

Recommended Products
Connection Type Manufacturer Model Number

Soldered Type Fujitsu FCN-361J040-AU (Connector)
FCN-360C040-B (Cover)

Crimped Type Fujitsu
FCN-363J040
FCN-363J-AU/S
FCN-360C0404-B

Terminal Block Unit Type Mitsubishi
A6TBX36 (Terminal Block)
AC**TB (Cable)
(** = cable length)

Yokogawa TA40-ON
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Select the [INPUT TERMINALS], either [DISCRETE] or [WORD].
Select the [OUTPUT TERMINALS], either [Discrete] or [Word].
For example, if you entered an [INPUT TERMINALS] of [DISCRETE] and an
[OUTPUT TERMINALS] of  [Word], and touched the screen’s upper right corner
“RUN” button, the [I/O MONITOR] screen would appear.

When the [INPUT TERMINALS] is [DISCRETE], the input terminal (S-No.) will
appear in reverse color. When the [OUTPUT TERMINALS] is [WORD], use the ten-
key keypad to enter the data. When using a LT unit, touch the data entry field and the
ten-key keypad will appear. After entering data, touch the [OUT] key to output the
data. Data will be displayed in the decimal format.

11.3.2 I/O Monitor (I/O Connection Check)

On the DIO driver menu touch [I/O MONITOR] to call up the following screen:

<When I/O Monitor has been Selected>
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Error Type Possible Cause Solution
DIO Unit is defective. Contact your local Pro-face distributor.
[Enable I/O] box is not selected. Set the [Enable I/O].

Program is incorrect. Correct program

DIO Unit is defective Contact your local Pro-face distributor.

Input common line is incorrectly wired.
Common line wiring check.
Common line breakage check.
Common terminal looseness check.

External imput power is incorrect. Provide the correct voltage.
Connector is not securely attached. Attach the connector securely.

All input lines do 
not turn OFF DIO Unit is defective. Contact your local Pro-face distributor.

DIO Unit is defective. Contact your local Pro-face distributor.
Program is incorrect Correct the program.

Input wiring is incorrect.
Check common line wiring.
Check common line breakage.
Check common terminal  for looseness.

External unit is defective. Replace the unit.
Input ON period is too short. Lengthen the Input ON time.
DIO Unit is defective. Contact your local Pro-face distributor.

Program is incorrect. Correct the program.

External Input voltage is incorrect. Provide the correct voltage.
Input terminal screws are loose. Tighten the terminal screws.
Program is incorrect. Correct the program.
Connector is not securely attached. Attach the connector securely.

Noise is causing unit mis-operation.
Reduce the noise level.
Attach a surge killer.
Use a shielded cable.

Input area 
randomly turns 
ON or OFF.

Input monitor 
lamp is ON, but 
no input can be 
performed.

Input monitor 
lamp is OFF and 
no input can be 
performed.

Designated Input 
lines do not turn 
ON.

Designated Input 
lines do not turn 
OFF.

11.3.3 DIO Unit Troubleshooting

This area explains how to solve possible DIO unit problems.

DIO Unit Input Errors
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DIO Unit Output Errors
Error Type Possible Cause Solution

DIO unit is defective. Contact your local Pro-face distributor.

Output common line is incorrectly wired.
Output line wiring check.
Output line breakage check.
Output terminal looseness check.

Load current is incorrect. Provide the correct current.
Connector is not securely attached. Attach the connector securely.
DIO unit is defective. Contact your local Pro-face distributor.
Program is incorrect.
Output area is completely OFF. Correct program.

[Enable I/O] box is not selected. Set the [Enable I/O].

Output lines do 
not turn OFF DIO unit is defective. Contact your local Pro-face distributor.

DIO unit is defective. Contact your local Pro-face distributor.

Ouput wiring is incorrect.
Check output line wiring.
Check output line breakage.
Check output terminal  for looseness.

External unit is defective. Replace unit.
DIO unit is defective. Contact your local Pro-face distributor.
Current leakage, residual voltage 
causes causes incorrect recurrence.

Change design of external device.  I.e. 
Attach dummy resistor, etc.

Load voltage is incorrect. Correct voltage load.
Output terminal screws are loose. Tighten the terminal screws.
Program is incorrect. Output commands 
are overlapping. Correct the program.

Connector is not securely attached. Attach the connector securely.

Noise is causing unit operation error.
Reduce the noise level.
Attach a surge killer.
Use a shielded cable.

Output area 
randomly turns 
ON/OFF

Ouput monitor 
lamp is ON, but 
no ouput can be 
performed

Ouput monitor 
lamp is OFF and 
no ouput can be 
performed

Designated output 
lines do not turn 
ON

Designated output 
lines do not go 
OFF
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Error Codes
I/O errors are Read/Write errors. When I/O errors occur, the controller writes an error
code to the #IOStatus variable. The logic program continues to operate. The following
explanation of possible error causes and solutions for when the DIO unit is attached to
the LT.

Setting Errors

Error Code Contents Solution

501 Internal variable error allocated to I/O terminal.

502 External variable error allocated to I/O 
terminal.

503 Output variable error allocated to I/O terminal.

504 Discrete variable error allocated to analog 
terminal.

505 Integer variable error allocated to discrete 
terminal.

506 Variable type not supported by driver. Correct the variable type.

801 Terminal numbers are duplicated.
Two or more terminals are using the same 
terminal number, possibly causing data 
transfer failure. Download the LTE file again.

802 Multiple modules are used.
Two DIO units are using the same module 
number. Reset these numbers so they do not 
overlap.

803 Module number has exceeded 1. Set a module number from 0 to 1.

804 Unit number starts from 1. Set the DIO unit nearest the rear face of the LT  
to "0".

805 Driver configuration error More than one DIO driver has been added to 
the I/O tree.

821 No DIO hardware unit exists. LTE file contains more modules than the 
actual number of connected LTs

822 DIO-: No hardware unit exists, or the type is 
invalid.

The ID Number loaded from the built-in DIO 
unit is invalid. The DIO unit may be broken.

Reset the variable used.
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Runtime Errors

Internal Errors

Error Code Contents Solution
850
…
864

Record the Error Number and contact your local 
Pro-face distributor.

Driver Error
A major system error has occurred.

Error Code Contents Solution

840

Read-out data is incorrect. After two 
successive read attempts, the LT has 
detected that the value read out from the DIO is 
incorrect.

Increase the time of the Input signal's ON 
period.

841
Output data is incorrect. Incorrect output data 
was detected from the built-in DIO unit by an 
internal loopback check. 

Check to see if there is noise interference.

842 DIO output data is incorrect Incorrect output data was detected by an 
internal loopback check.
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12.1 Error Message List
This chapter explains the error messages that can appear on the LT unit. The error
messages explained here are those related to the LT Editor program only.
For further information concerning LT error messages, refer to

LT Series User Manual (Sold separately)
Error Message Cause Solution
"Invalid ladder file" The LT 's logic program file

is not downloaded, or the
file is damaged.

Download another copy of
the project file from the LT
Editor.

"Fatal Error:
    Drive check Failed"

The LT 's current I/O driver
is incorrect.

Check that the I/O driver set
in the logic program file
and the driver installed in
the LT are the same.

"Global Data Area
             Too Small"

The dowloaded file's data
may be damaged.

Download the project file
again. If this does not fix the
problem, contact your local
Pro-face dealer.

"Can't Set Priority" The LT 's system file is
incorrect. The file may
have been damaged
during downloading.

Download the project file
again.

"Exception
nnn:[mmm:ooo]"

A fatal error has occurred
in the lader logic program.

Write down the error
message details and
consult your local Proface
dealer.

"Watchdog Error" The Constant Scan T ime
is longer than the
Watchdog time.

Reset the Watchdog time
so that it is longer than the
Constant Scan T ime. If
doing so exceeds the
Watchdog T imer's limit,
then the Constant Scan
Time (program) should be
changed.
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Error Message Cause Solution
"Bad Var: xxx" Unable to find variable "XXX".     

Either the logic program file 
has not been downloaded, or a 
variable that does not exist in 
the logic program file on the 
screen, is used.

Download the project file 
again.

"Bad Array: xxx" The number of elements used 
in the screen file's array 
variables and those used in the 
logic program file's array 
variables are different.

Download the project file 
again.

"Bad Type xxx" The Logic program variable 
"XXX"'s type is different from the 

Download the project file 
again.

"Unknown register type" This variable type does not 
"Register is missing" Cannot find variable used for 
"S100 file index is
                        out of range"

Cannot find variable used for 
Reading.

"Too many entries
                in the S100 file"

Too many variables are being 
used. Limit is 2048.

"S100 file is missing" Cannot find S100 (variable 
"Over Compile count MAX" Too many Parts are being 

used. 
Reduce the number of Parts 
and then download the project 
to the LT again.

"Exception 65532 [xxxx : xxx] "
"Exception 65533 [xxxx : xxx] "
"Exception 65534 [xxxx : xxx] "
"Exception 65535 [xxxx : xxx] "

LT heap memory is insufficient. 
Memory for storing programs 
and variables is sufficient, 
however logic program 
memory is insufficient.

Setup the LT unit again with 
the LT Editor after reducing the 
logic program size, or the 
number of variables and labels. 
Also reduce the number of 
array variable elements, or 
shorten the name of variables 
and labels.

Download the project file 
again.
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12.2 Error Codes
The following table describes #FaultCode errors.

Major Faults and Minor Faults

• When a major error occurs, the controller immediately stops ex-
ecuting the logic program.

• When a minor error occurs, the controller is able to continue
executing the logic program.

Error Code Level Cause
0 Normal No error
1 Minor The calculation result, or the result of the conversion

of a Real variable to an Integer variable has resulted in
2 Major A reference was used for an area outside the array's
3 Major A reference was used for a bit outside the Integer's (32

bit) range
4 Major The stack has overflowed.
5 Major Incorrect command code is being used.
6 - Reserved for System.
7 Major The Scan time is now longer than the Watchdog time.
8 - Reserved for System.
9 Major Software Error.

Depending on type of problem, system may need to be
restarted.

10 - Reserved for System.
11 - Reserved for System.
12 Minor BCD/BIN Conversion Error
13 Minor BCD/BIN Conversion Error
14 - Reserved for System.
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The following table explains the LT Editor’s logic program operation errors.

12.3 Program Errors

1. Enable I/O is used to input and output data between the LT and I/O units. After
downloading the logic program to the LT unit, the external I/O devices cannot
operate in RUN mode. (As a safety precaution, the I/O is not enabled in the
default setting.) Be sure to set the Enable I/O before trying to read/write data to
I/O.

For setup details, refer to the Programming Guide.

Error Type Possible Problem Solution

Battery Alarm Change Battery
Memory Alarm Exchange Unit

Program Malfunction Program transfer mistake. Download the project file 
again with LT Editor.

Data is output from I/O even in 
STOP mode.

When output data performs 
RUN/STOP switchover, I/O 
output hold is enabled.

Disable this feature.

Soon after entering RUN mode 
unit changes to STOP mode

A Command Execution Alarm 
has occurred. Or, a major fault 
has occurred.

Modify the program.
Check the contents of the 
#FaultCode data.
Also check if the System 
variable #Command has been 
written to.

LT Editor cannot enter 
Monitoring mode
The logic program files cannot 
be downloaded from LT Editor
The project (.prw) file cannot 
be downloaded from theLT 
Editor.
Data cannot be read from or 
written to the I/O.

Enable I/O*1 is not selected. Set the Enable I/O.

The data transfer cable used 
to send data from the screen 
creation software to the LT  unit 
may be loose or disconnected.
Also, the PC or LT 's power 
may have dropped, causing 
excessive noise.

Check whether the data 
transfer cable is unplugged or 
if there is noise interference. If 
the problem continues, please 
contact your local Pro-face 
distributor for assistance.

Control Memory power is cut 
and Hold Area data is not 
preserved
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